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I’m very excited about this issue. It feels likes all of my birthdays
have come at once, which actually isn’t far off the mark. In fact,
it’s Nikon’s birthdays that have all come at once; 100 of them, to
be precise. Yes, in case you hadn’t guessed it from the enormous
‘100’ on the cover, Nikon is celebrating its centenary this month,
which provides us with a pretty good excuse to look back over a
century of Nikon innovation, and celebrate the cameras, lenses,
people and photographs that together make up the Nikon story:
its remarkable journey from microscope manufacturer to iconic
photography brand. You can read the whole story, and enjoy
dipping in and out of Nikon’s many milestones, in this issue’s
special feature (p. 8) and accompanying collector’s supplement.
We hope you enjoy reading them both as much as we’ve enjoyed
putting them together.
Staying in celebratory mode (and with rose-tinted spectacles
well and truly set to ‘nostalgia’), this issue also features a head
to head between the D5 and the venerated F5 film SLR (p. 90),
a centenary-inspired Big Project (p. 50) and an in-depth review
of the classic F501 (p. 91), the first ever Nikon SLR to feature
autofocus (a fully working example of which will today set
you back the princely sum of £25/$30!).
Plus, we have our usual brilliant mix of regulars, including
an inspirational interview with leading adventure pro Corey
Rich (p. 96), a masterclass on landscape photography (p. 60),
and a group test on the best superzooms for travel, so that you
can start adding your own journeys to the Nikon story. Enjoy!

Twitter
Follow our tweets and
keep up to date with
all things #Nikon
www.twitter.com/nphotomag

Paul Grogan, Editor
paul.grogan@futurenet.com
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100 YeArs of NikoN

NikoN’s First ceNtury

100 years
of the camera
system that
changed
everything
S
ince beginning as Nippon Kogaku K.K. on
25 July, 1917, Nikon has been influential in
shaping how people have viewed the world,
whether that’s through a pair of binoculars,
a microscope or a Nikkor lens. From awe-inspiring
images of our planet taken from space, to
breathtaking pictures returned from the its deepest

www.digitalcameraworld.com

oceans, Nikon cameras have been the choice of
pioneers who have pushed the boundaries of
photography. Nikon has been equally pioneering in
its evolution of camera and lens technology, and over
the following 15 pages we celebrate the innovation
and events that have kept Nikon at the cutting edge
for the past ten decades.
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1957
The Nikon SP is
the world’s first
rangefinder to
incorporate a universal
finder covering
28mm-135mm.

Years of NikoN
1959
Released in April, the
Nikon F is not only
Nikon’s first SLR, it is
the first 35mm SLR to
offer a viewfinder that
shows 100% of the
image area.

1963
The aptly named
Nikkorex Zoom 35 is
the first SLR to include
a fixed zoom lens – a
Zoom Nikkor Auto
43-86mm f/3.5.

1967
Nikon launches the
first SLR to include
a centre-weighted
exposure metering
system, the Nikon F
Photomic Tn.

1972
After developing a new
type of optical glass in
December 1971, Nikon
uses it in the 300mm
f/2.8 ED telephoto,
released in 1972. It is the
world’s first ED (Extralow Dispersion) lens.

1980
The ’80s might be
a decade that has
questionable taste
and style, but not
when it comes to
Nikon camera design.
The iconic red strip
debuts in the Nikon F3
– the world’s first SLR
to offer TTL (through
the lens) exposure
metering.

1957 Nikon SP

1959 Nikon F
1967 Nikon F Photomic Tn
1963 Nikkorex Zoom 35

A brief history of
Nikon innovation
N

Free!

36-page coll
special celeberactor’s
Nikon’s milesto ting
with this issuenes
1980 Nikon F3

The ideas and inventions that have kept Nikon at the cutting edge
ikon has been at the forefront of camera tech for
the past century, and by sticking with its
interchangeable lens F-mount for nearly 60 years,
it has ensured compatibility across its range of
cameras and lenses – past, present and future. But there
are numerous other ways, both revolutionary and
evolutionary, in which Nikon has led the way. Take ED

or Extra-low Dispersion glass: it might now be a familiar
feature used in the optical design of lenses from every
manufacturer to reduce chromatic aberration and
produce clearer, sharper images, but it was Nikon that
invented the stuff. Here’s a selection of the well known
and less well known things Nikon has given to the
world…

1994 Nikon Zoom 700VR

1989 Nikon TW20

1988
Another shining
example of Nikon
know-how, the
Speedlight SB-24
is the world’s first
flashgun to offer
TTL-BL flash control to
balance background
exposure with flash.

10

1989
The Nikon TW20/
TW20 QD (Tele-Touch
300) dual-lens
compact is the first
camera to offer
red-eye reduction.
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1994
Steady as she goes:
the Nikon Zoom
700VR/700VR QD
(Zoom-Touch 105 VR
QD) is the world’s first
camera to feature
optical vibration
reduction.

2003
Despite its paltry
4.1Mp resolution, the
D2H is the first SLR to
offer wireless LAN
connectivity (with
the WT-1 wireless
transmitter) and
support the Creative
Lighting System.

2003 Nikon D2H

2005
Nikon introduces
the world’s first
face-priority
autofocus in the
Nikon Coolpix 7900.

www.digitalcameraworld.com

NikoN iNNovAtioN
1983
Enter the Matrix: the
Nikon FA is the first
camera to include a
multi-pattern (Matrix)
metering option.

1983
Nikon becomes
the first camera
manufacturer to offer
a flash sync speed of
1/250 sec, in the
Nikon FE2.

1984
Hold the front page!
Nikon introduces the
NT-1000, the world’s
first 35mm film direct
telephoto transmitter,
co-developed with
Kyodo News Service.
It’s able to scan 35mm
slides and negatives
and transfer them via
a telephone line to a
receiver elsewhere in
the world.

1987
The Nikon F-401 is
the first autofocus
SLR to feature a
pop-up TTL flash.

1988
Need for speed?
Try the Nikon F-801
(N8008): it was the
first SLR to offer a
maximum shutter
speed of 1/8000 sec.

1988
Pioneering the use
of autofocus in a
professional SLR,
the Nikon F4 is also
the first to feature a
built-in motor-drive.
It’s fair to say that
it takes the world
by storm.

1983 Nikon FA
1988 Nikon F4

1983 Nikon FE2

1987 Nikon F-401

2009 Nikon Coolpix S1000pj
1988 Nikon F-801

2005 Nikkor ED 300mm f/2.8G

2008 Speedlight SB-900
2008 Nikon D90

2005
Cables? So 2004.
As the first compact
digital camera with
built-in Wi-Fi, the Nikon
Coolpix P1 brings a
taste of the future.

2005
A big year for Nikon
world firsts, including
the AF-S VR Nikkor ED
300mm f/2.8G IF-ED
– the first lens to use
Nano Crystal Coat, an
anti-reflective coating
to effectively reduce
ghosting and flare.
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2008
Nikon starts the
‘HD-SLR’ revolution
with the release of the
D90, the first digital
SLR to record video
as well as stills.

2012 Nikon D4

2008
We’re familiar with
updating a camera’s
firmware, but Nikon
goes and releases the
Speedlight SB-900,
the first flashgun
to offer support
for user-applied
firmware upgrades.

2009
Innovation or novelty?
The Nikon Coolpix
S1000pj’s USP – the
world’s first digital
camera with a built-in
projector – makes it
stand out from the
point-and-shoot pack.

2012
The Nikon D4 is the
first DSLR to support
the new superfast XQD
memory card format,
with first-generation
cards being capable
of read/write
speeds of up
to 125MB/sec.
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Years of NikoN

2003 Into the light

Nikon 100th
Anniversary Edition
Crystal Creation Nikon
camera model

the begiNNiNg

Making a name
How did the world’s favourite
black-and-yellow brand start life?

N

ikon hasn’t always been Nikon. In
fact, Nikon Corporation as we know
it is has only been around for about
the past 30 years. When two of
Japan’s leading optical manufacturers
– the Optical Instruments Department of
Tokyo Keiki Seisakusho and Reflecting
Mirror Department of Iwaki Glass
Manufacturing – merged on 25 July,
1917, with investment support from the
President of Mitsubishi, Koyata Iwasaki,
the company was known as Nippon
Kogaku, K.K. (or ‘Japanese Optical Co.’).
WHAT’s in A nAME?

The Nikon brand name was established in

1946 – not as the name for the company,
but for a camera. Nippon Kogaku K.K. execs
were looking for a title for a new compact
35mm camera that they were planning to
develop. It is said that, in a bid to capture
the camera’s compactness while building

The Nikon brand name
was established in 1946
– not for the company,
but for a camera

For years, Nikon had stuck with the high-vis
combination of black logotype on yellow, but
14 years ago it upgraded this to include the
’sequential rays’ motif.
So, what feelings does the ray-based
graphic treatment stir in you? If they’re
along the lines of ’infinite possibility’ and
an ’unleashing of the power of imagination
turned into actual products and services’,
then Nikon’s brand marketing team has
done its job.
Nikon’s ‘At the heart of the image’ tag line
was introduced to express three promises
to the world: to deliver the essence of the
image (‘Be true to the heart’); to inspire a
new passion for life with the image (‘Ignite
the heart’); to make the world’s dreams for
the image come true (‘Invent for the heart’).

on the ‘Nikko’ abbreviation of Nippon
Kogaku, they considered the title
‘Nikorette’, which sounds perilously
close to nicotine gum to us.
Concerned that Nikorette was too
weak for a product for which it had major
ambitions, the company instead decided
to retain the ‘Nikko’ base but add an
additional ‘N’ to give, as Nikon puts it,
‘a more masculine impression in the
Japanese language’. The first camera to
carry the Nikon name – the Nikon Model I
– was launched in 1948, and is
commemorated by a limited edition crystal
version (above), which is available as part
of Nikon’s 100th Anniversary collection.
A REPUTATiOn FOR RELiABiLiTY

Fast forward to 1988, and on 1 April
Nippon Kogaku rebranded as the Nikon
Corporation. Products bearing the Nikon
name across various markets had built up
a reputation for reliability and the company
wanted to take advantage of this as it
continued to develop as an international
brand. The Nikon logo was redesigned to
reflect the new branding.
The 100th Anniversary Pin Collection (far left)
includes the original Nippon Kogaku logo. You can
also buy Nikon 100th Anniversary Premium Camera
Straps (left), as well as 100th Anniversary Editions
of the D5, D500, Nikkor 70-200E and model Nikon F

12
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Since its pan-European launch
in 2010, the I AM campaign has
gone global, most recently with
‘I AM on a Mission’ for Nikon’s
KeyMission action cameras

2010 I AM new
Nikon launched its ‘I AM Nikon’ advertising
campaign throughout Europe seven years
ago – and it’s still going strong. Created by
the Jung von Matt/Spree creative agency in
Berlin, the campaign was designed to build
on Nikon’s ‘At the heart of the image’ concept.
“By reminding our customers that they too
are at the heart of the image, we hope to ignite
a new understanding of photography – one
where anyone can express themselves,
regardless of their photography experience,”
said Nikon Europe’s Birgitta Olson at the time.
The concept was a neat and simple one:
express ‘who are you with your Nikon?’.
Used to encapsulate a moment and prick the
emotions – ‘I AM Neil Armstrong’, to capture
a baby’s first steps – ‘I AM Alive’, for a shot of
Robbie Williams turning his camera on the
crowd – through to the more literal ‘I AM
a Super Zoomer’, it’s the myriad ways
that ‘I AM’ can be applied that’s given
this campaign its longevity.

Did you k now ?
The use of yellow in the logo is said to express
‘breadth and passion’ and ‘an open attitude
and innovative approach’, while the black
evokes ‘trust, reliability and quality’. While
a blend of yellow and black often serves as
a warning to keep away – bees, wasps, hazard
tape – in Nikon’s case the combination is
designed to attract with promises of ‘high
quality’ and ‘trustworthiness’…
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YeArs of NikoN

iN the Nik kor time
Nikon has been producing
lenses for almost 90 years.
Here’s a small selection of
the pioneering ways it’s
used glass since the
Swinging ’60s

1975
With its minimum
focal length of 28mm,
the Zoom-Nikkor
28-45mm f/4.5 is said to
be the world’s first bona
fide wide-angle
zoom

1986
While Top Gun rides
high in the movie charts,
Nikon rolls out its own top gun
in the shape of the Nikkor
50mm f/1.8s, the world’s first
lens with a built-in CPU
(Central Processing
Unit)

1980s

1960s
1967
Nikon releases the
Nikkor Auto 24mm f/2.8;
it’s the first lens to use the
Close-range Correction (CRC)
system for improved close
focus image quality, achieved
through a floating
element design

Did you k now ?
Nikon filed a trademark application for the Nikkor brand
name in July 1931 and it became a registered trademark in
December 1932. ‘Nikko’ is an abbreviation of the ‘Nippon
Kougaku’ company name, with the ‘R’ added simply
because it was a suffix for photographic lens names
at that point in time.
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1990s

1970s

1997
The AF Zoom
Micro-Nikkor
70-180mm f/4.5-5.6D
ED is the world’s first
zoom micro
lens

14

2000s

2007
Nikon expands its
lens range with the
world’s first 14mm f/2.8
wide-angle zoom, the
AF-S NIKKOR
14-24mm
f/2.8G ED

1976
Showing its flair for
lens design (well, it is the
’70s), Nikon delivers the
Nikkor 13mm f/5.6 – a lens
that offers the world’s widest
angle of view among
wide-angle lenses
(as of 1976)

2006
Shake free: VR II
Vibration Reduction
is introduced in the
AF-S VR Micro-Nikkor
105mm f/2.8G
IF-ED

1968
The OP FisheyeNikkor 10mm f/5.6 is
one of the first examples
of aspherical lens
elements being used
in SLR lenses

1994
Size matters: Nikon
unveils the world’s first
1700mm zoom lens, the
Zoom-Nikkor 1200-1700mm
f/5.6-8P IF-ED. It weighs
more than 16kg and is
almost a metre long

2005
Nikon claims another
world first, employing
Vibration Reduction
equivalent to a four-step
increase in shutter speed in
the AF-S DX VR Zoom-Nikkor
18-200mm f/3.55.6G IF-ED

the f-MouNt

t he F -mouN t

Mounting up

Above The Nikon Df
has retro styling – and
the original F-mount

One hole, over half a decade – why Nikon’s
F-mount has stood the test of time

t

he F-mount celebrated its 50th
anniversary in 2009, making it the
longest-running lens mount for 35mm
SLR interchangeable lens cameras in
the world. The F-mount was introduced on
the Nikon F in 1959 and it’s been a constant
throughout Nikon’s history, providing a
substantial amount of backwards and
forwards compatibility between lenses
and cameras over the past five decades.
Nikon decided that it needed to provide a
degree of future-proofing and enable the
use of larger aperture lenses. The result?
The F-mount diameter of 44mm.
But the F-mount hasn’t stayed frozen in
time, and there have been some notable
evolutions. For instance, 1977 saw the
introduction of auto aperture indexing
(Ai). Ai-type lenses enable the automatic
setting of maximum aperture. In 1983,
the F-mount had to accommodate both
autofocus and the exchange of aperture
information between the lens and camera
using central processing units.
is iT cOMPATiBLE?

Although you can physically attach
F-mount lenses from the ’60s to the latest
Nikon digital SLRs
– and vice

versa – it’s not quite interchangeable lens
nirvana, as there are a number of caveats
and limitations to take into account. For a
kick-off, Nikon’s non-Ai lenses may need to
be modified to prevent mechanical damage
when they’re attached to later bodies.
Although DSLRs can accept Ai lenses, only
high-end bodies will meter through the
lens. In addition, some digital SLRs don’t
have a built-in focusing motor, so can only
autofocus when a lens with a built-in motor
– AF-S or AF-P – is attached. And then
there’s Nikon’s range of G lenses, which
lack an aperture ring and are intended to
work with digital SLRs where the aperture
is adjusted using the camera’s command
dial. This is not an exhaustive list!
Most F-mount lenses are designed
to project an image that covers a frame
of 35mm film, or an FX imaging sensor,
which has the same 36x24mm proportions.
Nikon’s DX cameras have sensors that are
1.5x smaller – approximately 24x16mm –
but they retain the same F-mount. This
means you can happily use ‘full-frame’
lenses on DX bodies, albeit it with the
image cropped. Nikon’s smaller DX lenses
can also be fitted on FX bodies, with
the camera automatically cropping
the image frame to DX size.

It’s not quite lens nirvana –
there are some limitations
to take into account

5

things Nikon
has given to the
world of… SPORT
Nikon at the top of its game
NIKoN ProFESSIoNAl SErvICES (NPS)
NPS provides field support at major events
around the world, including the Olympic
Games, FIFA World Cup, Wimbledon and F1
Grand Prix. NPS members can get their gear
serviced and pick up loan equipment so that
they don’t miss a moment.
NIKoN D5
While the D3 was the digital SLR that
redefined expectations of what a sports
camera could be, the D5 has pushed the
boundaries still further. The stats are
impressive: a new 153-point AF system, 12
fps continuous shooting and an image buffer
good for 200 NEF files in one 16.7 second
burst. Game, set and match, Nikon.
SPoNSorShIP
For many years Nikon has been supporting
sporting competitions, including the Asian
Football Confederation (AFC) and the FINA
World Championships (for aquatics sports).
In the UK, Nikon has been the official patron
of golf’s Open Championship since 1993.
SPorT vr
Introduced in the 400mm f/2.8E FL ED VR,
Sport VR mode is a less intense version of
Vibration Reduction designed to produce
a smooth viewfinder image when panning,
and to make it easier to track movement.
lIghTEr SuPEr-TElES
In 2015, lighter replacements for its sports
lenses arrived. The 500mm f/4E and
600mm f/4E are 790g and 1250g lighter
than their predecessors through the use
of magnesium alloy and fluorite elements.
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NikoN D3

16

NikoN D5

Setting the standard

A shot in the dark

On 23 August 2007, Nikon announced the
D3, its first full-frame digital camera. The
world knew what to expect in terms of build
quality – it was a flagship Nikon full-frame
SLR after all – but no one was really prepared
for the step-change its 12.1Mp FX-format
CMOS sensor was about to bring to high-ISO
photography. Up to this point, pushing the
sensitivity beyond ISO1600 was, well,
pushing it in terms of quality. But the D3 could
take ISO3200 and ISO6400 in its stride.
It could produce colourful and surprisingly
clean images in light so low that you could
barely see anything with your eyes. It could,
if you really needed it, be cranked up to the
equivalent of ISO25,600. Some might say
(and whisper it) that the D3 is the best SLR
Nikon has ever produced, such was its impact
when it was released.

And now we have the D5, a camera that
not so much pushes the ISO envelope as
attaches it to a weather balloon and sends
it to the stratosphere. If the D5’s native
ISO range, which already stretches to
ISO102,400, isn’t enough for your needs,
then you can run to the highest expanded
sensitivity in Nikon’s history: a Hi 5 setting
equivalent to ISO3.28 million. Naturally you
might be expecting to carry out some noise
reduction at that setting, but if you feel the
need to photograph a black cat down a well
on a moonless night at all costs, then at least
you can satisfy the urge.
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eNgiNeeriNg

Nikon’s use of futuristic
materials makes its
cameras tough and light

branding the build
Getting across the hidden strengths of Nikon gear

h

ow do you distinguish a new camera
from the rest of the pack when the
raw specs may be similar, in the race
for digital SLR one-upmanship?
Twenty-something million pixels? Of
course! Multiple cross-type AF points?
Check. ISO north of one million?
You’d better believe it.
So Nikon’s marketing team must have
been high-fiving all the way to their
whiteboards when the engineering
department came up with the idea of using
‘Sereebo’ in the construction of the D750.
Instead of an all-magnesium alloy body,
the front body and front cover are made
from a carbon-fibre reinforced
thermoplastic used in a ‘monocoque
structure’ (another high five). Monocoque
is a method of construction that relies
on a structural skin, rather than a chassis,
for its strength, with the camera’s exterior
panels serving as a frame that protects the
internal structure, in addition to shaving
a little off the weight.
Sereebo was actually first used in the
structural parts of the D5300, released
in 2013 – in fact, it was the first time the
plastic had been adopted in a commercial
product. Since then, it’s become a familiar
selling point for updated Nikon bodies,
with ‘a monocoque carbon-reinforced
shell’ (high five!) being used in the likes of

Nikon’s marketing team must
have been high-fiving all the
way to their whiteboards

the D5400, D5600 and D7500. In fact, even
the D500 flagship DX body uses a blend of
magnesium alloy at the top and rear and
carbon fibre at the front (see above).
sHUTTER nUTTERs

Aside from the camera body, the biggest
stresses in a DSLR occur within the mirror
assembly and shutter. Nikon has again led
the way here, with the shutter foil in the
original Nikon F SLR being made of
titanium (0.02mm in thickness) for the first
time in the world. The shutter and quick
return of the mirror were reportedly put
through a 100,000-cycle stress test to
ensure reliability.
These days, the shutter blades of
high-end Nikon DSLRs are made from
Kevlar/carbon-fibre composite and tested
to ensure they have the durability to cope
with the increased load that comes from
the machine-gun frame rates and
prodigious buffers that professionals
demand. According to Nikon, the D5 has
been tested to 400,000 cycles, with the
shutter unit loaded into a fully assembled
camera. The flagship FX body also includes
a self-diagnostic shutter monitor that
detects any difference between the
shutter speed and the actual speed
of the blades, and minimizes
this accordingly.

5

things Nikon has
given to the world
of… PHOTOJOURNALISM
Stories through a Nikkor
NIKKor AT wAr
David Douglas Duncan is a photojournalist
who became a household name with his
photographs taken during the Korean War.
He bought a Nikkor-S.C 5cm f/1.5 and a
Nikkor-Q.C 13.5cm f/4 before heading to the
front line. Nikon subsequently presented
Duncan with the 200,000th Nikon F.
DoN MCCullIN’S NIKoN F
While documenting the rise of the Khmer
Rouge in Cambodia in 1970, McCullin came
under fire while crossing a waterlogged rice
field. On returning to camp, he noticed a hole
in his camera – the perfect imprint of an
AK-47 round. The camera may well have
saved his life. McCullin still has that F.
NIKoN FM2
While the Nikkor 35mm f/1.4 was the
quintessential photojournalist lens of the
’70s and ’80s, it was a Nikkor 105mm f/2.5
mounted to an FM2 that helped Steve
McCurry capture one of the most
recognizable portraits – 1984’s Afghan
Girl – of the last four decades.
NIKoN-Noor ACADEMY
NOOR is a collective of documentary
photographers and photojournalists
dedicated to raising awareness of
contemporary global issues. Nikon-NOOR
Academy masterclasses are held regularly
throughout Europe to help inspire the next
generation of photojournalists.
NIKoN-wAlKlEY AwArDS
The annual Nikon-Walkley Awards have been
called the Australian equivalent to the
Pulitzer Prize. Designed to recognize
excellence in photojournalism, they were
formed by the merger of the Walkley Awards
for journalism and the Nikon Australian
Press Photographer of the Year awards.
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to the ends of the earth…
and beyond!
N
ikon has earned a reputation for
constructing cameras that
possess robust, tank-like build
quality. Tough as nails – and
tough enough to hammer nails in some
cases – it’s no wonder that
photographers have relied on Nikon
bodies and lenses to deliver day in, day
out in some of the most punishing
environments known to man. Ocean
depths? Sub-zero temperatures?
Zero gravity? Bring ’em on…
1963 wATEr rElIEF
Nikon’s first allweather camera is
launched. Based on
the Calypso, a camera
orginally conceived
by renowned marine
explorer Jacques
Cousteau, the 35mm
Nikonos is designated
an ‘amphibious’
camera; not only is
water-resistant down
to 50m, it can also take
pictures on land.

1992 wET ’N’ wIlD
The world’s first
underwater SLR, the
Nikonos RS, handles
like a normal Nikon,
complete with
autofocus, TTL
metering and
motor-drive, but is
waterproof to 100m.
Nikon also launches
a series of underwater
lenses, including
a 50mm f/2.8 macro,
a 13mm f/2.8 fisheye
and a 20-35 zoom.

Did you k now ?
The Nikonos V outlasted the Nikonos RS; the V was on sale
for 17 years (1984-2001) whereas the RS was discontinued
after just four years (1992-1996).

Sealing the deal
18
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1999 rEEF
ENCouNTEr
Jim Hellemn lays claim
to creating the first
gigapixel photo,
Portrait of a Coral
Reef. Using a Nikonos
V with 20mm lens and
Ikelite 400 strobes
fitted to a camera
platform, Hellemn
shoots over 300
frames of Bloody Bay
Wall, a vertical coral
reef in the Cayman
Islands, stitching them
together to create a
1.77 gigapixel, 20x70ft
photocomposite.

2006 oNwArDS
FrEEzE FrAMES
Nikon becomes
the official camera
sponsor of James
Balog’s Extreme Ice
Survey (EIS) initiative.
The EIS has 43 Nikon
cameras trained on 24
glaciers in locations
around the world,
including Antarctica,
Austria and the Rocky
Mountains, and these
record changes in the
glaciers every hour of
daylight. The result?
Around 8000 frames
per camera per year.

2013 DIgITAl
SPlASh
Nikon’s dominance of
sub-aqua photography
continues with the
debut of the world’s
first digital camera
with interchangeable
lenses that can be
used underwater.
The Nikon 1 AW1 is
waterproof up to 15m
and is dripping with
smart features,
including a flash.

One of the factors that contributes to the
confidence-inspiring, go-anywhere build of
higher-end Nikon DSLRs is the extent of their
weather sealing. The seals around joints, buttons
and dials reduce the chances of water drops and

2016 MISSIoN You
Nikon announces its
first action cameras:
KeyMission 360,
KeyMission 170 and
KeyMission 80. As the
name suggests, the
flagship waterproof,
shockproof and
freeze-proof
KeyMission 360
records 360º movies
in 4K Ultra HD.

2005 NEw
To SCIENCE
For the first time in 20
years, a new species of
monkey is discovered,
deep in the Southern
Highlands of Tanzania.
Proof of its scientific
validity comes from a
series of photos taken
on a Nikon D100 by
Dr Tim Davenport.

dust entering the camera body and causing
damage. They don’t make the cameras
waterproof, though, and you also need to use
them in conjunction with a weather-sealed lens to
ensure the lens mount is protected.

www.digitalcameraworld.com

1971 ThE worlD
IS NoT ENough
Nikon starts its long
association with
NASA, by delivering
nine Nikon Photomic
FTN cameras
(modified versions
of the Nikon F) and
55mm f/1.2 lenses
plus accessories to be
used on board Apollo
15 – the fourth mission
to land on the moon.

2013 globE
TroTTINg
The first Nikon DSLR
with built-in GPS (and
Wi-Fi), the D5300 can
save your location
information as Exif
data on images.

1978 To INFINITY…
NASA asks Nikon to
supply a modified
version of the F3 for
the first space shuttle
(Space Transport
System: STS) to be
launched in 1981.

2015 goINg
uNDErgrouND
National Geographic
photographer Martin
Edström uses a Nikon
D810 to capture an
immersive 360º image
of Vietnam’s Son
Doong – the world’s
largest cave.

www.digitalcameraworld.com

1977 PolE PoSITIoN
Nikon supplies a
special titaniumexterior F2 to Naomi
Uemura, who would
become the first
person to reach the
North Pole on a solo
trek (with dog sled)
across Arctic ice. He
shot 180 rolls of film
during his six-month
adventure.

1978 ‘ThE SAvAgE
MouNTAIN’
Jim Wickwire and
Louis Reichardt took
Nikon SLRs on the first
US ascent of K2, the
world’s second-tallest
mountain. Nikon took
out an advert to mark
the achievement:
‘When you’re out to
make history, you
don’t take chances
on your camera. You
go with Nikon.’

1963 hIgh PoINT
Jim Whittaker
becomes the first
American to reach
the summit of Mount
Everest; he uses
a Nikon F to take
pictures at the
top of the world.

Did you k now ?
A prototype of the original Calypso/Nikkor
camera appears as one of James Bond’s
gadgets in the 1965 movie Thunderball.
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Did you k now ?
Some of the NASA F3 Small Cameras were reportedly lost
in space – and are presumably still circling the Earth at
several thousand kilometres per hour…

NikoN iN spAce

Nikon in space

Above This image,
taken on a Nikon, is
truly out of this world…

How Nikon cameras have helped
to shape our view of the world

N

ikon’s journey into space began in
1971, when the Nikon Photomic FTN
was used on the Apollo 15 mission.
Up to this point, NASA had stuck with
Hasselblads and 70mm film, but required
a more portable solution. Nikon has been
NASA’s go-to 35mm system since then.
In the late ’70s, Nikon worked on two
NASA-modified versions of the F3 for use in
the Space Shuttle program. Production was
carried out alongside the development of
the consumer F3, which had yet to be
released. The ‘Small Camera’ was equipped
with a motor-drive and was capable of
holding up to 72 frames per film. There
was also a ‘Big Camera’ that had a large
250-exposure film back that could be
loaded with thinner long film. It had a dark
slide that allowed astronauts to remove the
film back in the middle of a roll and switch
to a back loaded with different film.

OUT OF THis WORLd

On September 1991, a modified version of
the Nikon F4 was taken into space on Space
Shuttle Discovery. The Nikon NASA F4
Electronic Still Camera was one of the first
digital cameras in the world – and out of it.

The Nikon F4 had already established itself
as the next-generation professional SLR,
with its cutting-edge autofocus, built-in
motor-drive, Matrix metering and a host
of electronics, but the NASA F4 added a
digital camera back with a one megapixel
monochrome CCD sensor at the film plane.
Nikon’s relationship with NASA has
continued into the digital age, with NASA
requesting D2Xs DSLRs in 2008, followed
by D3s bodies in 2009 for use in recording
activities aboard the Space Shuttle and
International Space Station.
By 2010, the ISS was starting to resemble
a zero-gravity Grays of Westminster, with
an unmodified D3s, eight D2Xs bodies
modified for EVA (Extravehicular Activity),
four D2Xs eyepieces for framing through a
space helmet, seven SB-800 Speedlights
and 36 Nikkor lenses (including three
teleconverters) floating around. At that
point, NASA had captured more than
700,000 images with Nikon equipment
that had been carried into space.
These days, you’re more likely to see the
D4 in the hands of ISS astronauts, perhaps
fitted with a Nikkor 800mm f/5.6E FL ED
VR twinned with the Nikon AF-S FX
TC-14E III 1.4x teleconverter, to give
the equivalent view of 1120mm.

NASA has captured more
than 700,000 images with
Nikon equipment

5

things Nikon
has given to the
world of… SCIENCE
Up close and up in space
MICroSCoPE DEvEloPMENT
Nikon designed its first microscope, the
JOICO, in 1925 with a staggering 765x
magnification. Nikon also released Japan’s
first stereoscopic microscope (1954), the
Fieldmicroscope (1996) pictured above, plus
the BioStation CT cell culture observation
system (2007) – used in an incubator so
that the growth of live cells can be observed.
TEST-TubE bAbIES
The world’s first test-tube baby, Britain’s
Louise Brown, was conceived with the
assistance of a Nikon microscope – as was
the US’s first test-tube baby, Elizabeth Carr.
In the ’90s a Nikon Diaphot microscope
assisted in cloning Dolly the sheep, the
first mammal cloned from an adult cell.
ASTroNoMY IN JAPAN
Nikon’s first 20cm equatorial refracting
telescope was positioned in the roof
observatory dome of the Tokyo Science
Museum in 1931. It remained in service
for more than 70 years.
SPACE TElESCoPE
On 14 September 2013, the Japan
Aerospace Exploration Agency (JAXA)
launched Hisaki, the world’s first space
telescope dedicated for remote observation
of planets, including Venus and Mars. Nikon
provided the primary 20cm silicon carbide
mirror for the telescope.
ThE SMAll worlD CoMPETITIoN
Since 1975, Nikon has organized the
International Small World Competition –
a celebration of microscope photography.
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Quo t e t he pros

the choice of discerning pros!
Photographers at the top of their game explain why they ‘went Nikon’…

W

hile it has been famously said that owning
a Nikon camera doesn’t make you a
photographer, there’s a good reason why
professional photographers the world over
choose to own a Nikon. We’ve had the good fortune

The Nikon cameras are design classics.
They’re made of the right material and
they work and operate in a way that is
so superior to anything else. The F3 is probably
my favourite.
Andy Hooper, chief sports photographer at the
Daily Mail and Mail Online
The Nikon D3 was the camera that made me think
‘Digital is here and it’s better than film.’ I like film
cameras. The F3 was a great camera. But the D3
was the game-changer, the first real press digital
camera that made you realize that film was a
thing of the past.
Bob Martin, sports photographer
The FE2 and F4 were the only Nikons I used before
the D810. I had both of these cameras for a very
long time. My FE2 I had from when I was 20. All of
my early stuff was shot with a Rolleiflex or a Nikon
FE2, which is not really a top camera, but I always
use really good, expensive lenses. Lenses for me

to speak to many leading pros for our major monthly
interview, and have chewed the fat with them about
the equipment choices they have made in their careers.
Here we take a walk down memory lane and revisit
the choicest quotes from our past interviews…

are really important. I always spend a lot of
money on Nikon lenses. You can’t cut corners
with lenses, because it shows.
Britta Jaschinski, photojournalist
I did the whole spectrum of Nikon. The evolution
of Nikon was amazing, because I went from the
Nikon F to the Nikkormat, which was a great
camera. The Nikon F was always the workhorse
camera, though. You could drop it, bounce it.
I remember being in Belfast with mine, diving
to the ground to avoid a sniper’s bullet –
smashed the head, made a big indentation in
the pentaprism. I looked through it and it’d gone
all crazy paving, but it still took great pictures.
Mike Maloney, press photographer
The Nikon D3 opened up a whole new world
to me in terms of low-light imagery. At the time
I was photographing leopards extensively, and
suddenly I could photograph these leopards at
night, just using a torch and no flash. When Nikon

launched the D3 I realized I had a tool that could
do something that no previous camera had been
able to do, which meant no other photographer
had been able to do it. So that really motivated me
to work on an extensive leopard portfolio, which
I managed to get published in BBC Wildlife
magazine, and Geo magazine in Germany.
Greg du Toit, wildlife photographer

NikoN pros

The lens I used to always, always use was a Nikon
20mm f/3.5. I used that for portraits, because
I could sit close enough to subjects to touch them
and I could just move them a bit and still shoot;
I could actually hold them a bit and still shoot.
I like working that close. Then I bought a 35mm
f/2 lens. The last massive project I did when I was
still shooting film was the year I spent with Man
City for the last season at Maine Road (2002-03).
I shot all of that on film, all on Nikon, and the lens
I used the most was the 35mm f/2. I love it. It’s a
great lens, pin-sharp from corner to corner. I’m
not massively into hardware, but I absolutely love
my Nikon F3 and that lens.
Kevin Cummins, music and
portrait photographer
My first Nikon camera was an F2A at college.
It was awesome and I regret selling it. After that
I got an F4s, which was quite a jump. It was
Nikon’s flagship, and had autofocus and built-in
motor-drive, which made life so much easier.
With that camera and the SB24 flashgun and
35-70mm f/2.8 lens, I thought I had everything
I ever needed to shoot all my commercial work.
I had an FM2 to run alongside it as my mechanical

Nikon D3: the digital
camera that changed the
game for many pros

back-up. The D2X was my first digital camera.
With the switch to digital I actually toyed with the
idea of changing from Nikon to Canon, but I stuck
by Nikon because all the kit felt right. Even though
the D2X wasn’t full frame, the quality was still
damned good. I absolutely loved it.
Jeremy Walker, landscape photographer
The first Nikon I owned was an F3, which was
quite a nice body to use. I stuck with film for
quite a while and used loads of different film
cameras, including medium format. When
I moved to digital I used Hasselblads and Phase
One backs, but it wasn’t until the D3 came out
that I gave up everything else, and I have been
with Nikon ever since.
Jason Hawkes, aerial photographer
In the 1980s I had an Olympus, but I moved
over to Nikon when it became obvious that
autofocus was the next big thing, because
Olympus’s attempts at autofocus then were
hopeless. The Nikon F-801 came along and
I tried it. By modern standards the AF wasn’t
great, but the button and dial handling were
superb. That said, it was the viewfinder that
swung it for me – it was absolutely fantastic
and one of the best I’ve ever used. You can trace
the lineage of the F-801 through all the Nikons
I’ve owned, so I can pick up a new Nikon and
use it without reading the instructions.
Seb Rogers, cycling photographer
The FM2 was one of the best film cameras ever
made! It had no autofocus or auto-winding and
it had a mechanical shutter. It was tough and
unforgiving, but really taught me the art of
photography. Right now I’m working with the
Nikon D5 and D500, Nikon 24-70mm f/2.8 and
70-200mm f/2.8 zoom lenses, and the 24mm
perspective lens. It’s important to know your
equipment so that you can focus on relating
to your subjects. Your confidence in
yourself will instil confidence in them.
Ami Vitale, travel photographer

5

things Nikon has
given to the world
of… NATURE & WILDLIFE
Get the great outdoors closer
NIKoN D500
Like a mini D5, complete with the flagship
FX camera’s 153-point Multi-CAM 20K
autofocus sensor module. The D500’s
advantage it that it has a smaller DX sensor,
so the area covered by the autofocus sensor
stretches right to the edge of the frame.
AF-S NIKKor 800MM F/5.6E Fl ED vr
Launched in 2013, this VR-enabled 800mm
came supplied with a dedicated 1.25x
teleconverter, bringing it up to an effective
focal length of 1000mm. It includes fluorite
elements adopted for ‘superior’ chromatic
aberration compensation.
DX CroP MoDE
With a Nikon FX DSLR you can switch to DX
crop mode and give yourself extra reach
thanks to the 1.5x crop factor, all without
affecting the maximum aperture – so a
300mm f/4 gives you the angle of view
equivalent to a 450mm f/4. Yes, you lose
resolution, but you gain frame-filling impact.
bINoCulArS AND SCoPES
Nikon has been involved in the manufacture
of binoculars since 1921, with the Mikron 4x
and 6x ultra-small-prism binoculars. Its
latest WX Series (above) might be aimed
more at stargazers than starling spotters,
but the optical quality continues to shine.
CrEATIvE lIghTINg SYSTEM
Whether shooting close-ups of critters, a
hummingbird in flight or setting up a camera
trap in your back garden, Nikon’s Creative
Lighting System makes off-camera flash
work clutter-free and painless.
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Did you k now ?

Super zoom

Tokyo’s Nikon Museum opened on 17
October 2015, and holds approximately
600 exhibits dedicated to the history of
Nikon. Coincidentally, 600 also happens
to be the museum’s floor area,
measured in square metres…

Nikon’s Coolpix P900 bridge camera
packs a world-beating 83x optical zoom
lens that offers equivalent coverage from
24mm to 2000mm – more than any other
Coolpix made so far. This is increased to
166x when Dynamic Fine Zoom is used.
Luckily, it also features Dual Detect
Optical VR to help reduce camera
shake at such whopping
focal lengths.
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In 2016, Nikon achieved a total
production of 100 million Nikkor lenses
for interchangeable lens cameras. So,
despite offering unrivalled compatibility
with a range of legacy lenses, Nikon has
more than doubled its total production
of Nikkors in the past decade alone.
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fter being in the optical game
for 100 years, you’d probably
expect Nikon to have racked
up some impressive numbers
during that time. And you’d be
right to do so. Here’s our
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In this issue’s Lightbox
gallery we present
a selection of our
favourite winning and
commended images
from the GDT Nature
Photographer of the
Year competition,
all shot by Nikon
photographers…
6th Place, MaMMals

Reindeer

In this wonderfully
atmospheric image,
dramatic backlighting creates an
almost perfect rimlight around
the stag’s antlers and body.
Nikon D500, 500mm f/4,
1/8000 sec, f/4.5, ISO800
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© GNPY 2017, Florian Smit, GDT

Florian smit
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© GNPY 2017, Stefan Imig, GDT

2nd Place, Birds

3rd Place, MaMMals

stefan imig

Florian smit

Red Crossbill

The lone crossbill
perched atop a treetop
is wonderfully echoed by the
evergreen behind.
Nikon D5500, 300mm f/4,
1/640 sec, f/5.6, ISO100
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Struggle

This extreme close-up
of two bison is a
wonderfully intimate study
of shape, pattern and
contrasting textures.
Nikon D810, 400mm f/2.8,
1/200 sec, f/4, ISO1600

www.digitalcameraworld.com

© GNPY 2017, Florian Smit, GDT

Lightbox

7th Place, Plants & FUnGi

Pennywort
© GNPY 2017, Sandra Bartocha, GDT

sandra Bartocha
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This macro shot of a pair
of pennywort and their
shadows takes advantage of an
extremely shallow depth of field
for an appealingly abstract shot.
Nikon D810, 105mm f/2.8,
1/250 sec, f/4, ISO200

August 2017

Lightbox
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Lightbox

© GNPY 2017, Dominik Janoschka, GDT

Overall winner

2nd Place, Other aniMals

dominik Janoschka

stefan imig

Birdies

Dominik had set out to photograph butterflies
at a nearby gravel pit when, all of a sudden, a
flock of starlings descended. “There were birds all
around me, bickering and calling,” he says. “As I
looked around, taking in the spectacle, I noticed
three power lines decorated by the starlings. As
soon as there was a bit of movement, I hit the
shutter release.”

Butterfly and Fern

We love the contrast of the white butterfly
against the dark ferns that it’s resting on, and
the composition – with the creature placed close to
the bottom-left third intersection – is pixel-perfect.
Nikon D800E, 70-200mm f/4, 1/40 sec, f/5, ISO640

Nikon D7100, 150mm f/2.8, 1/1250 sec, f/4.5, ISO500
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© GNPY 2017, Stefan Imig, GDT

© GNPY 2017, Robin Uwe Hasubek, GDT

Lightbox

2nd Place, Birds

Morning Walk

robin Uwe hasubek
Two symmetrically arranged
waddles of penguins are beautifully
reflected in the wet sand as they return
from their early morning swim.
Nikon D810, 14-24mm f/2.8, 1/80 sec, f/6.3, ISO640

10th Place, BlacK & white
© GNPY 2017, Antje Kreienbrink, GDT

Stormy Times

antje Kreienbrink
A long exposure of wind-lashed
plants gives them an abstract form
as they’re buffeted by the gusts, while
the mono conversion adds to the drama.
Nikon D810, 200-500mm f/5.6, 0.3 sec, f/32, ISO30

The members’ contest “GDT Nature Photographer of the Year (GNPY)” is
owned by GDT / Gesellschaft Deutscher Tierfotografen – The Society of
German Nature Photographers. It aims to illustrate the high quality and
specific style of European wildlife photography through excellent pictures
from Europe and all over the world. It also seeks to promote awareness
of nature conservation through the means of photography. For further
information visit www.gdtfoto.de
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IngenIous recIpes for stunnIng shots
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thIs month’s projects…
PROJECT OnE / Core skills

40

Shoot a bug’s eye view

Get down low to capture
wide-angle images of flowers

PROJECT TwO / Creative teChniques

PROJECT FOuR / liGhtrooM essentials

46 Get to grips with colour space
Understand colour space options
to ensure perfect prints every time

PROJECT FivE / Creative PhotoshoP

42 Make your own lightbox

48 Create a holiday memento

PROJECT ThREE / essential Gear skills

PROJECT Six / the biG ProjeCt

Use a cereal box and fairy lights
to create backlit nature images

44 Master edgy lighting

Give your portraits the edge
with the help of coloured gels

www.digitalcameraworld.com

Get to grips with the text tool to
create a picture postcard in minutes

50 Personalise a portrait

Shoot a lasting memento of a
special occasion with bespoke lighting

WatCh

the video
Whenever you see this logo, it means there’s a video
to accompany the tutorial, taking you through things
step-by-step. You can watch all of our photography
tutorial videos online – just go to bit.ly/nPhoto74
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ProJecT one / CORE SKILLS

The mission

●Shootplantsfrom

downlowforan
insect-likeviewpoint

Shoot a bug’s eye view
Jason Parnell-Brookes gets down low with this quick botanical
photography project that gives you a unique view of nature

Time

●10minutes

Skill level

T

●Beginner
●Intermediate
●Advanced

his issue we freshened up
our botanical photography
with this handy little project
to give our shots a
completely new perspective. We
nestled our Nikon in amongst the
ferns in a shaded woodland, and
used a wide-angle lens to
accentuate the feeling of
crawling amongst the leaves.

Kit needed
●Wide-anglelens
●Mini-tripod
●Polarizer(optional)

The trick is to get the Nikon as
low down as possible and aim it
skyward, preferably with the sky
shaded by the canopy above.
Head out on a sunny day, but aim
for a shaded spot away from
direct sunlight. Trees provide
good cover, but opt for the edge
of a forest where it’s brighter as
the light falls off the further into a

The trick is to get as low as possible and aim
skyward, preferably shaded by the canopy
40
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forest you go. In the shade the
shadows are soft and flattering;
gone are the bright highlights
and dark shadows of the
contrasty direct light.
We looked for trees and ferns
that would frame our shot, and
short bluebells added a muchneeded splash of cool blues to
the lower-third of our frame.
There are many varieties of plant
life around in the spring and
summer months, and it doesn’t
take that long to get your shot,
so it makes the perfect project
to take on when you have
half-an-hour or so spare.

Watch the video online at www.bit.ly/NPhoto74
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STeP BY STeP / Get the low down

S

Polarizer

1 Go wide

A wide-angle lens fits in more of the scene and therefore
more flowers. They naturally have some pincushion
distortion, and that distortion can evoke a sense of being
a small amongst the undergrowth, looking up at the
flowers. Anything wider than 35mm will be perfect.

2 Stay steady

A great bit of kit to keep your Nikon steady while low
to the ground is to use a mini-tripod. The Joby DSLR
Gorillapod can hold a Nikon along with a small lens with
ease, and the legs can be bent into any kind of shape,
making it easy to get a low angle shooting upwards.

If you’re out on a
bright sunny day and
the sky is blue, try
adding a polarizing
filter to your setup.
Turn the indicator on
your polarizer in the
direction of the sun
and watch as the sky
darkens down; this
will improve contrast
between the flowers
and the sky above.

lens hood

3 Get a better view

Engage Live View to see better without having to peer
awkwardly through the viewfinder. A Nikon with an
articulated screen (such as the D750, D7500 or D5600)
makes things much easier. Don’t have an articulated
screen? We’re afraid it’s lying in the mud for you!

4 Blur the background

A wide aperture, such as f/4, decreases your depth
of field, which means when you focus on that closest
flower, more of the flowers behind it will be blurred out.
It was bright on the day we shot, so we kept our ISO at
100 and set Manual exposure mode.

A lens hood will
reduce flare cast
across your
wide-angle lens. Most
come with a screw-on
lens hood in the box,
but some (such as
the Nikon 14-24mm
f/2.8) are built in. If
you don’t have a lens
hood available, just
use your hand or a
hat to shade the front
element of the lens.

Quick tip

5 Meter to zero

To correctly balance the light in your image, engage
Matrix metering; this takes an average reading across
the whole frame, from bright highlights to dark shadows.
You don’t want to blow out the sky so aim to hit 0 on the
light meter; our resultant shutter speed was 1/25 sec.

Watch the video online at www.bit.ly/NPhoto74

6 Set the AF point

Choose single AF point or group mode autofocus in the
custom setting menu, then move the AF point on the
LCD screen until you’re focused on your nearest flower.
If it’s windy, take the shot immediately after focusing
or your flower may move and become out of focus.

Hold back any
extraneous
leaves that pop
into frame,
as a clearer
foreground
will make your
composition look
more deliberate.
But take care
not to damage
the plants.
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Project two / Creative teChniques

Make your own lightbox
jason Parnell-Brookes shows you a quick-and-easy way to build your own
light-table to take backlit images of translucent subjects like leaves

the mission

● Photograph leaves

on a DIY light table

time

● 30 minutes

Skill level

● Beginner
● Intermediate
● Advanced

Kit needed

● Close-up filter

or macro lens
● Cereal box
● Greaseproof paper
● Fairy lights
● Tape

L

ight tables are designed
to illuminate a subject from
behind and are used for a
variety of purposes, from
arts and crafts to tattooists
tracing designs – or photographers
shooting close-ups.
You can buy ready-made light
tables and they vary in price, with
some reaching hundreds of
pounds. However, it doesn’t take
a fancy setup to get fancy backlit
photographs, and you can build
your own for next to nothing. Take
an old cereal box, for instance; this
can be our base for a light table. Cut
a hole in the front of it, stick some
translucent material over said hole,
(we used greaseproof paper) and
then feed fairy lights in behind.
It required a bit of jiggling to get
the light to spread evenly, but once
it was set up we put the Nikon up
above on a tripod. Then it was a
case of finding something beautiful
to photograph, like this lime tree
leaf. Anything semi-translucent
that allows some light to shine
through makes a good subject;
thin slices of fruit work well too.
So let’s see what you’ll need
to take your own backlit photos…
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Watch the video online at www.bit.ly/NPhoto74
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SteP BY SteP / think outside the box

bo
x

have a play
Get lots of leaves for
a variety of textures
and shapes. Try
shooting both sides
of the leaves as well.
We found that the
top layer of the leaf
was actually more
detailed than the
underside.

1 Dress the table

2 Light it up

3 Shoot from above

4 Get in close

Get an empty cereal box and cut a hole out of the front
and back, leaving a frame round the edge to tidy cables
behind later. Tape some greaseproof paper (or a sheet
of tracing paper) to one side of the box. The hole on the
other side is to put your fairy lights in.

Mount your Nikon on a tripod; a model that holds the
camera upside-down is best to get really close in for a
top-down view. Some tripods have centre-columns that
fold out sideways, which will do a good job too. Level off
the tripod head until the Nikon is parallel with the table.

Feed your fairy lights in through the back hole and press
them around the edge of the box. Use some tape to keep
them in place and make a uniform glow across the paper.
We kept the power switch on the outside of the box to
turn them off when not in use.

For smaller subjects you could use a macro lens to fill
the frame with your leaf, but we’re using an inexpensive
close-up filter instead. These either screw or clip on the
lens and allow the lens to focus closer. Here we’re using
the Raynox DCR-250 (around £55/$60).

Quick tip
5 Stop the wobble

In close-up shooting our depth of field is shallow, so opt
for f/11 to maximize this. Choose ISO100 and increase
your shutter speed to get a good exposure; ours was 1.3
sec. That’s quite slow, so to avoid camera shake when
pressing the shutter button we engaged the self-timer.

Watch the video online at www.bit.ly/NPhoto74

6 Use manual focus

Turn off autofocus on the lens and engage Live View
mode so that the image appears on the rear LCD. Zoom
in with the magnify button and manually adjust the
focus ring on the lens until the leaf looks crisp. When
you’re happy that it’s pin sharp, take your photo!

Experiment
with white
balance while
you have Live
View engaged
to see the effect
each setting has
on the finished
image.
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Project three / ESSENTIAL GEAR SKILLS

Master edgy lighting

Create a portrait that looks processed without the processing. jason Parnell-Brookes
ditches the computer in favour of using coloured lights to capture the effect in-camera

the mission

● Creating a processed look

without the processing

time

● One hour

Skill level

● Beginner
● Intermediate
● Advanced

Kit needed
●
●
●
●

Two flashguns
Different-coloured gels
Reflective umbrella
Shoot-through umbrella

W

ith the advent of
popular smartphone
apps like Instagram
and Hipstamatic,
image processing is now
commonplace. Whether it’s
clicking a single filter on your
phone, or adjusting curves and
levels sliders in Photoshop,
fiddling with the colours can
have a dramatic effect on the
feel of an image.
Limiting the tonal range and
colour palette of an image in this
way is great, but we reckon it’s
more satisfying to create similar
effects straight out of the
camera. All we need are two
flashguns placed either side of a
model, with some coloured gels
placed in front of the lights. With
a bit of clever placement we can
separate the light that falls on
our model’s face to mimic the
processed effect.
We used Speedlights for this,
but studio lights or continuous
lights would work just as well.
This is a project you can get
really creative with, by adding as
many lights and colours as you
want. But to keep things simple
we’ll start with two lights, and
add a little diffusion.
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Watch the video online at www.bit.ly/NPhoto74
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SteP BY SteP / Get creative with colour

colour gels

1. Go long

2. Position the lights

3. soften things up

4. add the gels

5. take a test

6. Catch the light

For this shot we’re getting in close for the portrait by
using a lens with a long focal length. The 70-200mm
f/2.8 we have here is perfect and zooming up to 200mm
compresses the portrait even more, creating an intimate
effect between viewer and subject.

Have your model face camera-right. Pop a reflective
umbrella on the left light and shoot-through umbrella
on the right. The reflected light is more directional, with
a harder edge on the left of the face, but the front of the
face (lit by the shoot-through umbrella) will remain soft.

Take a test shot in Manual mode at 1/160 sec, f/8,
ISO100. Our image was 1-stop underexposed after
diffusion and gels were applied to the lights, so we then
widened the aperture to f/5.6; remember that any type
of modifier will have an effect on the light output.

Watch the video online at www.bit.ly/NPhoto74

With the flashguns set to 1/2 power, place one cameraleft with a 3/4 turn towards your model, and the other
camera-right firing across the model’s face; positioning
the flash like this forms a distinct shadow along their
nose, which adds depth to the image.

Photography gels are
just coloured sheets
of acetate that you
can cut up and place
over flash and studio
lights. They’re often
calibrated to provide
light of a set colour or
colour temperature,
but you can get a
similar effect with the
coloured wrappers
from Quality Street
chocolates, or any
translucent film.

We then placed a red gel over the flashgun on the left and
a green gel over the one on the right. We found that the
red colour was overpowering the green too much, so we
turned the red light down to 1/4 power, keeping the green
at 1/2 power to balance them out evenly.

We had our model Erin play with some jewellery near
her mouth and nose. When turned just so it sparkled
and gave a shine similar to that of her eyes. This gave us
bright highlights from top-left to bottom-right through
the image, for an edgy, moodily lit portrait shot.

With thanks to:
Erin Leighton (model)
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ProjecT four / teach yourself lightroom

Get to grips with colour space
George cairns explains how to identify and correct unprintable colours
so that the printed version looks similar to what you see on screen

The mission

● Create a soft proof to see

how an image will print

Time

● 10 minutes

Skill level

● Beginner
● Intermediate
● Advanced

Kit needed

● Lightroom 5

W

e processed the
colours and tones in the
landscape photograph
shown below to reveal
more detail in the image and
create more attractive vibrantlooking colours. However, after
processing a photo to look good
on screen, it can then be
frustrating to end up with a
print that looks less bright and
vibrant than the digital version
of the photo.
Your printer may struggle
to reproduce the processed
picture’s colour accurately. This
is because computer displays

produce millions of colours by
mixing reds, greens and blues
(RGB) together, while most
domestic printers combine
cyan, magenta, yellow and black
(CMYK) to create a narrower
range of colours. Colours that
can’t be printed are referred to
as ‘out of gamut’ colours. The
image on your monitor is also
brightly illuminated, leading to
vibrant colours that can look
comparatively drab on paper.
Lightroom’s Develop module
has a handy Soft Proofing mode
that’s designed to help you
identify the out-of-gamut

colours that a printer can’t
reproduce, so that you can
adjust them to fall within the
printable range. To demonstrate
soft proofing, we’ll use the bright
and colourful processed version
of our image as a starting point.
Lightroom uses the sRGB
(standard RGB) colour space
that’s designed to display
colours on screen. After
selectively adjusting
problematic colours in an sRGB
colour space, we’ll demonstrate
how to force Lightroom to use a
narrower, more printer-friendly
colour space – Adobe RGB.
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STeP BY STeP / Don’t get spaced out

E

1 Examine the colour mix

2 See a Proof Preview

3 Activate the gamut warning

4 Create a Proof Copy

5 Adjust the saturation selectively

6 Change the colour profile

Load our processed image into the Develop module. Move the
cursor around the image; you’ll see that the RGB values below the
histogram change. The sampled dark blue sky in our grab is created
by a mix of 28.2% Red, 34.7% Green and 50.4% Blue, for example.

To discover which colours won’t print correctly, click the Destination
Gamut Warning icon at the top-right of the histogram window. Any
unprintable colours will turn red. Here you can see that the darker
blue pixels and some of the greens and yellows are out of gamut.

Click the Saturation section of the HSL panel, select the Targeted
Adjustment tool icon, click the sky’s red patch and drag downwards
to desaturate the colour. The Blue slider will slide left and the patches
will vanish. Sample and desaturate the patches in the grass.

You can download the start image(s) to your Mac or Pc at bit.ly/start-74

To get a better idea of how the photo will look when printed, click the
Soft Proofing button. The white backdrop represents the paper border
around the print. The area below the histogram shows numerical values
for each colour RGB colour channel, rather than a percentage.

You may want a version of the image to be seen online, as well as
one suitable for print. Click Create Proof Copy. You’ll now have two
versions of the photo in the Filmstrip. To desaturate the unprintable
blues without changing the other colours, go to the HSL tab.

Alternatively, you can change the photo’s Colour Profile menu from
the default sRGB (standard RGB) to the print-friendly colour space of
Adobe RGB (1998) to force the Proof Preview’s colours to conform to
a printable range without the need to make selective adjustments.
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Project Five / creative PhotoshoP
the mission

● Create and customize

type in Photoshop

time

● 5 minutes

Skill level

● Beginner
● Intermediate
● Advanced

Kit needed

Create a fun
holiday memento

Add customizable text to enrich your creative projects using
Photoshop’s powerful typography tools, with George cairns

● Photoshop CC

T

he Horizontal Type tool and
its Tool panel compartment
cousins enable you to enrich
your creative projects in
many ways, such as providing
posters or book covers with
eye-catching typography,
or turning text into a key
component of an illustration by
inserting a photo into the fonts.
At first glance, the Type tool
works in a similar way to wordprocessing packages. As you
move the mouse onto a
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Photoshop document a text
cursor will appear. Click to place
the cursor on a particular spot
and start typing on your
keyboard to add text to the
document as a new layer. You can
treat this text layer like any other
Photoshop layer, and use the
Move tool to fine-tune the
position of the text in the design.
As with word-processing
packages, you can change text
in Photoshop in a variety of ways.
Double-click to select a word, or

drag to select a few letters. Like
shapes produced by the Pen or
Custom Shape tools, text is
created mathematically as
vector shapes, so you can
increase the size without making
the edges fuzzy.
You can distort text too, using
the Create Warped Text option,
and edit the size, font or spelling
of the warped text if need be.
However, to apply other filters
and commands you’ll need to
convert it to a raster layer.

You can download the start image(s) to your Mac or Pc at bit.ly/start-74
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SteP BY SteP / Say it with type
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1 Type some text

2 Warp the text

3 Add a texture

4 Add 3D edges

5 Create a reflection

6 Add some blur

Open TYCC84.jpg. Go to Window>Workspace>Typography. Choose
the Horizontal Type mask tool from the Tools panel. In the Options
bar, choose Gill Sans from the Font Family menu. Set style to Bold
and a Size value of 200 points. Hold Shift and type ‘ITALIA’.

Choose Layer>New>Layer. Label the layer ‘Italia’. Click OK. Open
TYCC83.jpg. Choose Select>All and then Edit>Copy. On the main
document choose Edit>Paste Special>Paste Into. Drag inside the
text with the Move tool to reveal the ripples from the copied image.

Set Blending Mode to Screen and Opacity to 64%. Click the ‘Italia’
layer. Press Cmd/Ctrl+J. Click between the duplicated layer and its
mask to link them. Choose Edit>Transform>Flip Vertical. Hold Shift
and use the Move tool to drag the text to the bottom of the frame.

watch the video online at bit.ly/nPhoto74

Move the cursor away from the text until it changes to an arrow. Drag
the text near to the skyline. Right-click and choose Warp Text. Set the
Style menu to Wave. Tick the Horizontal button. Drag the Bend slider
left to -34 so that the text warps to flow above the buildings. Click OK.

Choose Layer>Layer Style>Bevel & Emboss. Set Style to Inner Bevel
and Technique to Chisel Hard. Set Depth 74%, Direction Up and Size
27. In Shading, set Angle 164 and Altitude 11. Click Pattern Overlay,
open the Pattern picker, load Rock Patterns, choose the Dirt pattern.

Click ‘Italia copy’ and choose Layer>Rasterize>Layer Style. Set the
Blending Mode to Overlay and drop Opacity to 75%. Go to Filter>
Blur>Radial Blur. Set Amount to 9, Blur Method to Zoom and Quality
to Best. Drag the Blur Center to make it match the text above.
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BIG PROJECT

Project six / The big projecT

the mission
● Shootafilm

noir-inspired
personalizedportrait

time

jason Parnell-Brookes teamed up with the Nikon School
training manager Neil Freeman for a film noir-inspired Nikon
masterclass with all the latest gear that Nikon has to offer

● Twohours

skill level

● Beginner
● Intermediate
● Advanced

Kit needed

●3flashguns
● 3lightstands
● Cardboardbox
● Softbox
● Wirelessflashtrigger

50

Personalize a portrait
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H

appy 100th birthday Nikon! Welcome
to a very special edition of the big
project this issue as Neil Freeman, from
Nikon School, shows us how to get the
best out of a three-light film-noir photo shoot.
What’s better than shooting on your old
workhorse and getting great results? Playing
with the new stuff, of course! And the Nikon
School was the very place to come for all the
latest Nikon gear: with three SB-5000
Speedlights, a D5 body and a snazzy Joe
McNally-designed custom softbox, Neil
pulled out all the stops to create a portrait
that was both elegant and accessible.

We heard you gasp at that kit list, but don’t
worry – it’s not an essential list, more of a
dream team. In fact, you could easily shoot
this with entry-level Nikon equipment.
As well as playing with all the latest kit,
we’ve gone all creative by making our own
light modifier in the shape of a ‘gobo’ to
project and shape light, then went selective
with our colour processing. Let’s raise our
Nikons and toast to the past 100 years…
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1
3
2

oN locatioN / The big picture
1

2

Lights

Three SB-5000 Speedlights
provide shape and highlights in
the form of a key light, a fill light
and a background light

Nikon D5

Neil is shooting on the flagship
Nikon model, the D5, which
gives outstanding image quality
and a resolution of 20.8Mp

3

Model

4

Courtney knew how to pose
and provided some great
opportunities to get a variety
of images from the same setup

Gobo

Standing for go-between-object
the gobo was an ‘N’ shape cut
into a box, which filtered the
light on the wall behind

light worK / Shaping the light
Quick tip

Make the non-cut
sections wider
than you’d think.
Because the light
diffracts (bends
round the edges)
before it hits the
wall the shape
will become a bit
blurry, especially
with finer cuts.

1 Make your gobo

We drew and cut out the N-Photo logo from a cardboard
box and then placed that over a Speedlight. When
cutting we found it best to make the gaps wider than
we thought because the light diffracts as it leaves the
cutout, making the shape blurry on the wall behind.
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2 Add a softbox

Designed by the master of flash and N-Photo columnist
Joe McNally, this 24in softbox has barn door flaps to
direct light and stop light spill, and its two-baffle system
makes shadows flatteringly soft and diffuse. We used it
to house our key light to illuminate our model Courtney.

Download the start image(s) at www.bit.ly/start-74
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Advanced
Wireless
Lighting

1 Banish background shadows

Neil got Courtney to sit on the right-hand side of the
sofa, but then pulled it out about five feet from the wall
as he knew that the key light, positioned camera-right,
would otherwise cast an unwanted shadow slap-bang
in the middle of the frame.

Neil used the Nikon
WR-R10 to trigger the
Speedlights from his
D5, enabling him to
control the power,
metering mode, group
and channel of all the
flashguns in the studio.

2 Set the aperture

Neil knew that he wanted his aperture to be at f/8
because, at 35mm, it keeps Courtney nice and sharp.
Shutter speed was set at 1/200 sec to sync with the
lights and it was fast enough to occlude the tungsten
lights in the room. ISO200 kept noise to a minimum.

Get it the right
way round
3 Set up the key light

Neil put an SB-5000 in the Joe McNally Ezybox and
placed it camera-right at a 45 degree angle pointing
towards Courtney. This was used as the ‘key’ light (the
main light source and the brightest of all three lights) set
to TTL mode so the camera automatically set its power.

4 Add a fill light

After taking a test shot Neil noticed that Courtney’s legs
were falling into shadow. So he placed another SB-5000
camera-left aiming across her legs and the sofa to give
dimensionality to her shape. He placed this on manual
at 1/16 power from the flash control menu on the D5.

Make sure you cut the
N the right way round
for the flash to
project – we wanted
the box to sit over the
flash, but should’ve
cut it backwards. It
was fixed with a bit
of cutting and
taping, though!

Quick tip

5 Set up your gobo

Jason aimed a third Speedlight (set at 1/16 power) at
the wall and placed the gobo he’d made earlier over the
front. You could just tape it here and walk away, but to
fine tune the shape of the logo Jason tilted it slightly so
the N didn’t spread along the wall too far.

6 Pose your subject

After the lights were positioned and balanced, and
the settings were dialled in to the D5, all Neil had to do
was get Courtney to try a variety of poses. This is the
fun part – you get to play with body shapes and eye
contact. If you have props now’s the time to use them.

The fill light was
spilling on to
the wall a little,
so Jason made
a makeshift
flag out of some
cardboard left
over from the
gobo. He taped it
to the wall-side
of the speedlight
to mask any
spillage.
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NikoN SkillS t h e

big project

toP tiPs / Finishing touches

Learn more at
Nikon School

1 Selective colour and mask

Open your image in Photoshop and duplicate the layer,
(Cmd/Ctrl+J). Then click on Select>Color Range. The
cursor changes into an eyedropper, so click and hold
over the yellow dress, hold Shift simultaneously and
drag your cursor around the yellow. Click OK and the
whole dress should be selected.

2 B&W adjustment layer

Hit Cmd/Ctrl+Shift+I to invert the selection. Click the
Create New Fill or Adjustment Layer icon at the bottom
of the Layers palette. Click on Black & White… and your
image will be transformed to mono and yellow. Select
the Brush (B) tool with white as the foreground colour
and brush over any sections still not monochrome.

get the most from your camera with
Nikon’s comprehensive training programme

N

ikon School photography
workshops cater for every
level of photographic
ability, whether you are
new to taking photographs, a
keen amateur, or a professional.
Nikon School offers a wide
range of workshops suited to
individuals wanting to learn
more about photography or
expand their creative horizons.
Courses will help you improve
your skills, develop your eye
for a photo and learn to take
control of your camera.
Workshops are a mix of
easy-to-understand theory and
practical assignments. They’re
attended by small groups of up
to 12 delegates to ensure that
everyone can benefit from the
expert knowledge of tutors.

From understanding your
Nikon DSLR and lenses
to image editing; from street
shots to inspiring landscapes;
the school’s workshops cover
a variety of skills and subjects.
Workshops take place at
either the Nikon Centre of
Excellence in London, or
on location as stated.
Nikon School can also
provide bespoke training and
consultancy services on the
use of Nikon and other imaging
products to companies and
groups. For details, contact
training.uk@nikon.com or
telephone 0330 123 0934.
■ For more on Nikon School
and all of its courses, just visit
www.nikon.co.uk/training

Forthcoming workshops
Here are just some of the workshops that Nikon
School has got coming up in the next few months

3 Make the logo shine

Make a new layer (Cmd/Ctrl+Shift+N) and click OK.
Now use the eyedropper tool (I) to select a bright yellow
on the dress. Then select the Brush tool (B) and paint
over the logo, being as neat as possible. Then change
the layer’s Blending Mode to Color.
With thANkS to: Neil Freeman, Training
Manager at Nikon School, and Courtney (model)
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20 July, Stoneleigh

29 July, London

1 August, London

Shoot vulnerable
british breeds of dog

The art of urban
dance portraits

getting started with
property photography

3 Aug, Southampton

4 August, Botswana

15 August, London

join the pros shooting
cowes regatta

river safari workshop
in chobe National park

getting started with
macro photography

www.nikon.co.uk/training
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60 The Apprentice

This issue’s Apprentice
shoots landscapes in the Lake
District under the watchful gaze
of Nikon pro Carmen Norman

photos
72 Your

review
74 Portfolio

Hamish ScottBrown showcases
his project on
photographing
the many and
diverse peoples
who inhabit
the Indian
subcontinent

We critique the
portfolio of a
reader who likes
nothing better
than stitching
together focusstacked macro
shots of flowers
on a lightbox
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Taking on the lakes!
Nikon pro Carmen Norman took reader Adam Dawson on a trip to the UK’s stunning
Lake District for a masterclass on landscape photography. Here’s how they got on...
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Name Adam Dawson
Camera D5100

Adam is a session drummer and plays in
pop and jazz bands for a living. Based in
Manchester, his work takes him across
the length and breadth of country, and
it was because of this that he invested in
his Nikon D5100 to shoot the many and
varied landscapes he sees on his trips.
A year-and-a-half later, he’s eager to learn
more. He’s read everything and seen all
the videos, but feels he needs something
else to push him to take his photography
further, and came to N-Photo for help…

Name Carmen Norman
Camera D810
Carmen grew up around photography, and
living and working in the Lake District gives
her instant access to stunning scenery
on her doorstep. She’s happy to be out in
all weathers, up on the fell or down by the
tarn, which made her the perfect pro to
show Adam the ropes on our Lake District
Apprentice. Her landscape work can be
seen in galleries and exhibitions around
the Lakes, and nationally too, as well as in
various print publications and online. See
her work at www.photosbycarmen.co.uk
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AppreNTiCe

Introduction
To make the most of the day,
Carmen met Adam at 4am at Blea
Tarn, near Ambleside, for sunrise.
The plan was to spend the
morning at the tarn (lake), then
work their way across the area
photographing fells (mountains)
and lakes, chasing the light and
shooting past dusk. First, though,
Carmen suggested Adam change
his usual approach to landscapes.

Technique assessment
Shoot Aperture priority
Carmen says... For anyone getting started
with landscape photography, like Adam,
I recommend setting Aperture
Priority exposure mode because
this will give total control over the
aperture while the camera takes
care of the shutter speed. This
way you can initially concentrate
on getting the correct depth of
field, which is largely determined
by the aperture, without feeling
overwhelmed by worrying about
getting all the other settings, like shutter
speed and ISO, correct.
plAybAck diSplAy optionS
Carmen says... I always ensure that the
Highlights and RGB Histogram options are
ticked in my Playback Display Options
menu before I go out shooting, and
made sure that Adam did the same.
This gives a quick visual clue as to
whether highlights are clipped by
flashing them in black and white
during image playback, and the
RGB Histogram alerts you to any
other clipping issues that you may
be unaware of.
bAck-button focuSing
Carmen says... I showed Adam how to enable
back-button focusing under Custom
Setting>Controls>Assign AE-L/
AF-L. He could then focus by
pressing the AE-L/AF-L button,
while preventing the camera
from focusing when halfpressing the shutter release.
That meant he could pre-focus,
then hit the shutter when the
light was right, without waiting for
AF to lock on before taking the shot.
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HOT
SHOT
#1
EXPOSURE 15 secs, f/11, ISO100
LENS 35mm f/1.8

Our Apprentice says… Before setting up my
camera on the tripod, Carmen first suggested that
I put my bag down and walk back and forth to find
a composition I was happy with. After seeing the
reflection of the mountains in the water I decided to
isolate it, so I framed it up to exclude the foreground
and focused solely on the mountains and the water. I initially
started to shoot at f/5.6, but Carmen suggested I stop down to
f/11 to increase my depth of field. That way I could be sure that
the entire scene would be sharp from front to back.

www.digitalcameraworld.com
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Staying solid

Cropping in

A sturdy tripod
is the landscape
photographer’s best friend.
Keeping the camera steady
means exposure times can
lengthen to any duration, even minutes. It also frees the hands to compose
a shot precisely. Carmen explained to Adam that he should always extend
the thickest, topmost legs first, and only use the centre-column as a last
resort. With the centre column extended the camera can be prone to
swaying in the wind, risking blurred shots.

This shot was taken
on a 35mm f/1.8 lens,
but on a crop sensor DX
body, like Adam’s D5100, the
effective focal length became roughly 52mm
(taking into account the 1.5x magnification factor). That meant that Adam
didn’t have to swap to a 50mm lens to get a similar angle of view. However,
this magnification effect only crops out the edges of the frame; it doesn’t
have any effect on the perspective distortion, which means that the image
still bears the distortive characteristics of a 35mm lens.

www.digitalcameraworld.com
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HOT
SHOT
#2

EXPOSURE 0.8 sec, f/14, ISO100
LENS 10-20mm f/3.5

Our Apprentice says… Wandering along the
water’s edge I found a scattering of rocks, which
pitted the otherwise featureless shoreline. I originally
got down very low to the water, but found the rocks
got lost behind one another. Carmen suggested I get
a little height to let the rocks spread out in their own
space, so I adjusted my tripod to waist height and the scene
came to life. There was a little movement on the tarn, though, so
I wanted a longer shutter speed. I set an aperture f/14, which had
the knock-on effect of increasing my exposure time, but the shot
wasn’t bright enough, so I dialled in +1 2/3 stops of exposure
compensation, which extended the exposure still further.
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Expert insight
Summer thermals
Carmen says… Adam noticed ripples on the lake,
disrupting the clear reflection he’d seen just a few
moments before, but there was no wind to whip
up the ripples. Carmen explains: “You have to
become a bit of a meteorologist in the Lake
District. It’s actually thermals on the lake that
create these ripples.” After waiting a few minutes,
the lake became clear and ripple-free again.

www.digitalcameraworld.com
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HERE aRE CaRmEN’S tHREE
FavOURitE LakE DiStRiCt imagES

Going vertical
With landscapes, the foreground is just as
important as the main background subject.
This series of stones leading into the lake produced
a dramatic leading line. The vertical format ensures
the stepping stones have more impact, drawing the
eye to the mountains behind, while removing any
extraneous detail left and right to simplify the scene.
Turning the camera, instead of cropping later, keeps
maximum resolution (and so detail) in the image.

MiSty dAwn At AShneSS
This is an image of the iconic Ashness Jetty
at Derwentwater, taken during one of my
regular early starts. The mist reflecting in
the still lake was both beautiful and delicate.

Live View
Focusing
With
Live View
engaged, Adam
moved the focus
point on the rocks a third of the way into frame,
using the back button focusing technique Carmen
showed him earlier. This enabled him to position
his focus point very precisely.

light over eASedAle tArn
I love to walk and always take my Nikon and
a single lens, even in the high fells. This was
taken during just such a walk. When the
light broke through the clouds, reflected
in the tarn, I was glad I had my camera.

Pro’s Killer Kit
Graduated neutral
density filter
Carmen says… The sky was bleaching
out in Adam’s first attempts, so to avoid
clipping in the highlights I gave Adam a Lee
Filters 0.6 (two-stop) soft graduated neutral
density filter. Placing the dark portion at the
top of the frame reduces the brightness of the
sky, meaning he could reveal detail in the sky
and clouds without darkening the foreground.

www.digitalcameraworld.com

Snow in deepdAle
When we had an unexpected snowfall in
March 2017, I visited the stunning Deepdale
valley, near Ullswater. It has a stream with
small waterfalls and is overlooked by the
spectacular Greenhow End fell, which
had a light mist around the summit.
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HOT
SHOT
#3
EXPOSURE 1/8 sec, f/11, ISO100
LENS 105mm f/2.8
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Our Apprentice says… The forest to the left of
the tarn was home to hundreds of silver birch trees,
whose leaves had just burst open around the lake.
The combination of these fresh leaves and the bright
silvery bark on the trunks were reflecting brightly in
the water. Carmen encouraged me to fill the frame,
so I composed a tight crop with the water’s edge almost central
in the image to enhance the symmetry created by the tarn. I used
similar settings as before, so f/11 and ISO100. Forests are usually
quite dark and my D5100 wanted to go longer with the shutter
speed to achieve that 18% grey midtone, but to get it looking
as close as possible to what I saw in front of me I had to dial in
-2 stops of exposure compensation.

Balancing the colours
Adam had his D5100 set to Auto White
Balance, but Auto White Balance is a
natural disaster when it comes to landscape
shots. It didn’t really matter because he was
shooting in Raw, but to review his images
on his rear screen Carmen suggested Adam
change his white balance to the Flash setting
to provide a neutral tone at around 5000 K.
That meant any warm tones would look
warm, and cool tones would look cool.

Pro’s killer kit
105mm f/2.8 macro
Shooting remotely
When lengthy exposure times are required, camera shake becomes an issue,
even when using a tripod. The small vibration caused by pressing the shutter
release can wobble the camera and cause the image to blur. However, it’s possible to
eliminate this using a shutter release cable so you can take a photo without having to
touch your Nikon. Some are wired, others wireless, but they do the same job. If you
don’t have a shutter release, you can use your Nikon’s self-timer function instead.

Carmen says… A macro lens
is great for landscapes. It seems
counter-intuitive, because a macro lens is
designed for its close-focusing ability, but
the optical quality and long telephoto reach
make it ideal for picking out details in the
environment. It’s renowned as a good portrait
lens too, and I rarely go on a shoot without it.

Expert insight
point it down
Carmen says… I encouraged Adam to point
his D5100 down when changing lenses in the
great outdoors, as I’ve found this helps to
prevent getting dirt on the sensor. It’s not the
perfect solution, but when you’re on your own
taking photos quickly as the light changes
you have to do what you can to stay on the
ball and protect your equipment.

www.digitalcameraworld.com
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HOT
SHOT
#4
EXPOSURE 1/8 sec, f/14, ISO100
LENS 10-20mm f/3.5

Our Apprentice says… I came across a dry
stone wall that encircled a small patch of grass,
and, as I walked past, the wall lined up with an
oak tree. I composed my shot using the wall as
a leading line. In order to get both the wall and
tree in focus I guessed the hyperfocal distance
by placing my AF point roughly one-third into frame and
focusing on the wall. The shot had to be timed to perfection:
the sun was going in and out of the clouds and there were
only a few moments when the light struck the wall and tree
simultaneously.

68

August 2017

Pro’s killer kit
polarizer
Carmen says…
A polarizer is a must
for landscape photography.
Almost every other filter can
be replicated in software
later, but polarizers can’t. A quick twist and you can turn a
bleached out sky into a deep blue, contrasting with punchy
white clouds. Better yet, it can cut through reflections in
water and even enhance the overall colour in a shot.

www.digitalcameraworld.com
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Expert insight
reading the
histogram
Carmen says… There’s
no one perfect histogram
shape; it largely depends on what
you’re photographing. However,
there is a way to position the
histogram perfectly – and that’s to
‘expose to the right’. If there’s a lot
of sky in the shot, expect a steep
curve to the right. The trick is to
ensure that this peak is towards the
right for a nice bright exposure, but
not bunched at the extreme right
as this indicates that tones will be
clipped to pure white and hold no
detail. If the histogram is clipped
to the left too, then shadows have
fallen to pure black, and you’ll need
lengthen the exposure time to rein
shadow detail back in.

Lenspen

Stop the car!
En route to the next
location Carmen
shouted, “Stop the car!” She
pointed out the incredible fog
rolling in from the mountains
in the late afternoon sun,
explaining, “It rarely does
this.” Adam fixed his Nikon to
the tripod to get some moody
shots. Sometimes, you have to
stop what you’re doing when
the opportunity comes along.

www.digitalcameraworld.com

Carmen noticed the sky in Adam’s
shot was a little spotty because
of the dust the lens had gathered during
the shoot. “It’s all par for the course,”
she pointed out, as she swabbed the
front element with a LensPen (£12/$15,
www.lenspen.com). Equipped with a
soft spongy end, it wiped away the few
specks of dust that couldn’t be blown
off with an air puffer (see page 112).
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Our Apprentice says…
In order to capture this last shot I used a
combination of techniques that Carmen
had shown me throughout the day. I filled
the frame with my subject, included a
tree trunk in the foreground, and
stopped my lens right down to f/22 to increase my
exposure time, which would, in turn, make the waterfall
silky and smooth. However, even after doing this, and
adding +1/3 stop of exposure compensation at
ISO100, I still couldn’t get it silky enough, so I used
Carmen’s Lee Little Stopper, a 6-stop neutral density
filter, to achieve a 15-second exposure time that turned
the water beautifully blurry and milky.

Our pro’s verdict…
Our last stop of the day was Stickle Ghyll
in Great Langdale. After a short walk up
the path, we were able to climb down to
get up-close-and-personal with the
waterfall. We tried various viewpoints
from around the location, but this shot had the drama
to really show off the waterfall. Taken from the side of
the fall, the long exposure slows the water to give a
soft, misty appearance, which contrasts beautifully
with the rugged texture of the rock. The knotty fallen
tree trunk in the foreground adds another layer of
depth and interest to the scene. Well done, Adam!

Timing it right
When working with neutral density filters
to extend shutter speeds, it’s important to
calculate the required length of the shutter speed
in order to correctly expose your image. When using
a 10-stop ND this is crucial, as the resulting time
can be several minutes long, and 30 seconds either
way can under- or overexpose an image, meaning
you have to start over. Adam experimented with this
and used the Lee Filters app on his smartphone to
determine the exposure length.

Expert insight
Bulb mode
Carmen says… Adam was taking five-minute
exposures but they were still coming out black.
Then I pointed out he hadn’t selected Bulb
mode. If using Av mode, your exposure time
is limited to 30 secs. Bulb mode keeps the
shutter open for as long as the release button
is depressed, meaning you can take exposures
that are several minutes long.

Be our next Apprentice
If you’d like a chance to be the next N-Photo Apprentice, please email
mail@nphotomag.com with Apprentice as the subject line, or fill in this form.
Return this form to… The Apprentice, N-Photo Magazine, Quay House,
The Ambury, Bath, BA1 1UA, UK
Name
Address
Tel no
Camera
I’d like help shooting

Email

Next month:
it’s a bug’s life
Nature ace Ross Hoddinott gives
a reader a macro masterclass

On sale 3 august 2017
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SHOT
OF THe
DaY
EXPOSURE 15 sec, f./22, ISO100
LENS 20mm f/2.8

1

Searching for reward
Hamish Scott-Brown took a trip across India
in search of colourful, cultural photographs that
illustrate the varied lives of local people

Mission: To capture the

diverse peoples of the Indian
sub-continent going about
their everyday lives

Photographer: Hamish

Scott-Brown

Age: 50
Location : Leamington Spa, UK
Kit: Nikon D750, 28mm f/1.8,

50mm f/1.4, 18-35mm f/3.5-4.5,
70-300mm f/4.5-5.6

Website: www.photographic
journeys.co.uk
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T

he Indian sub-continent
provides the most
amazingly diverse
locations that are
colourful, cultural,
and that offer an
immersive opportunity to
capture ‘real lives’ at work and
leisure. These images are just
some of thousands shot while
researching different parts
of India, including Ladakh,
Kerala, Rajasthan and Sikkim.
My most memorable
photographic experience
on this trip was in Kashmir.

There’s a market on a quiet
corner of Dal lake accessible
by taking a small shikara
(flat-bottomed boat) from
the houseboat before sunrise.
I paddled through the blue light
of predawn where the only
sounds were the splosh of the
shikara paddles. The feint echo
of the adhan (call to prayer)
could be heard amongst the
waking birds, coupled with the
red sun rising slowly over the
Himalayas. This image [1]
captures the colour, the quality
of light and the fierce

competition as floating traders
vie for space to sell fruit and
vegetables. It’s an experience
I’ll never forget.
Photographing people in
different countries and cultures
can be a challenge that many
photographers shy away from.
Some favour the long lens
approach, which allows them
to stay well back from their
subjects, but that’s a technique
I personally dislike. One of my
mantras, while working on
travel and documentary
photography, is this: try to take
pictures about things not of
things. One example of this is
my shot of the Rajasthan farmer
and his family [2]. Life in
this drought-ravaged area of
Western Rajasthan, near the
Thar Desert, is an everyday
struggle for the communities
there, yet I felt in this portrait
the farmer shows both pride
and stoicism.
The Changpa girl with the
goats may have been the

www.digitalcameraworld.com
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1
Dawn Fishing
Nikon D750, 70-300mm f/4.5-5.6,
0.8 sec, f/14, ISO100

2
Rajasthan Farmer and Family

Nikon D750, 50mm f/1.4,
1/1250 sec, f/2.8, ISO100

3
Changpa Girl with Goats
Nikon D750, 28mm f/1.8,
1/1000 sec, f/2, ISO180

trickiest of these three images
to capture, not just because the
nomads were hard to locate,
but the air there is incredibly
thin, at 4500m. These nomadic
tribes live across the remote
corners of Eastern Ladakh.
Our guides assisted us on their
location and suggested the best
times to visit to capture their
simple, humbling lifestyles.
Sleeping can be difficult and
the nine-hour drive east out of
Leh is a killer, but the rewards
for photographers are superb.
It was hard work, but well
worth the trip.

3

Hamish’s top tips

One of my travel
and documentary
photography
mantras is try to
take pictures about
things not of things

• Don’t rely on a telephoto lens; get
in close and engage with your subject
• Pay attention to locals or find yourself a guide;
they’re the gateway to discovering the area
• Prepare to leave early to photograph local
events. If your subject is up, you should be too!

To enTer your oWn phoTo sTory send FIVe oF your besT Images To: mail@nphotomag.com
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1

Delicate
flower

your projects critiqued

Focus-stacking fan Steve Brenman
takes a top-down approach to
photographing flowers on his light table

N

ature-based abstracts, movement and
macro photography fascinate me, and I love
the post-processing phase as I get to express
myself in the finished image.
I am a huge fan of Irving Penn’s Flowers
series, and I have been experimenting with
some gorgeous poppies and peonies lit from above and
below. My wife volunteers with Floral Angels (a charity
that recycles flowers donated from weddings and other
glamorous events to give to the community) and often
brings me amazing stems from the flower market, but
ordinary specimens can work just as well.
This kind of photography is time-consuming and
appeals to the obsessive in me. Just setting up the
lighting for each shot can take an hour or more. Even
then shadows and reflections may not be apparent
until you see them on the big screen.
The flowers are lit from above by inexpensive lamps
and torches (costing £5-10), and with a lightbox and
LED ring light from below. All the images were focus-

Want your portfolio revieWed? email your shots to mail@nphotomag.com
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stacked (10-20 images for each shot)
and then processed in Lightroom.
I’m not drawn to highly manipulated
imagery, so they’ve only been edited
to bring out the best of what’s there.
I use a focus slider to move the camera
(and focal point) to shoot a perfectly
aligned sequence of images, each
with a slightly different focal point.
More than once a less-than-tight
locking nut has collapsed my set-up,
and that means starting all over again!

But thankfully I’m retired and have the
time to indulge my passion.

N-Photo says
Steve, your lightbox images are
wonderful. It’s clear that you have
a strong understanding of macro
photography by using techniques like
focus-stacking and macro rail sliders.
Our favourite image is the tomatillo
[1]. The perfectly white backdrop

This kind of photography is time-consuming and
appeals to the obsessive in me. Just setting up the
lighting for each shot can take an hour or more

www.digitalcameraworld.com

juxtaposes the dark black colour of
the dried leaves, and the stone in the
centre is the much-needed splash of
colour that this image calls out for.
It’s simple, clear and sharp. The
composition works perfectly with
a square crop, and it doesn’t sit too
close to the edge of the frame.
When looking up close we can
clearly see that, in most of your
images, the entire flower is pinsharp, from stamen-tip to the
deepest petal crevice. Shooting
in extreme focus like this is a
challenge, and actually not always
necessary as you have shown in
your poppy shot [2]. The back and
front of the poppy are thrown out
of focus, and it’s actually rather
pleasing. This lack of depth of field
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1
Tomatillo Skin
Nikon D750, 28-300mm
f/3.5-5.6, 1/80 sec, f/7.1,
ISO200

2
Poppy
Nikon D750, 90mm f/2.8
Macro, 1/200 sec, f/4,
ISO280
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3
Peony
Nikon D750, 90mm
f/2.8 Macro, 1/80 sec,
f/14, ISO140

The ridges in the
petals are so
detailed that they
look as if they’re
made from
tissue paper

3

forces us to take a look at the centre of the
poppy where the brilliantly vibrant yellow
stamen reside. The ridges in the petals are
so detailed that it almost looks as though
they’re made from tissue paper. We can
see some stamen to the left and right of the
centre that are out of focus, which appears
to be the result of a missed focus stack
section, or it may be that the stamen

were so short that they were thrown out of
focus, too.
Your peony image [3] again captures the
delicate fibres in the pinkish petals, but this
time something else takes our eye. Looking
to the edges of the petals we can see a
distinct glow from the lights you are using
from above. The folded-back shape of the
petals creates a wonderful shadow in the

centre of the petals encircling the stamen.
That, combined with the shiny edge, gives
the flower a silky texture and makes it
distinctly different to the poppy.
In all, they are a really nice set of images
that made us want to grab some flowers
and give it a go ourselves! Head to page 42
to check out Jason’s DIY light table project
to take your own close-up nature shots.

technique tips

The N-Photo
experts say…

slide on in
Macro involves extremely
shallow depth of field, and
if you’re not careful it’s
easy for vital details to
be blown out of focus.
A macro rail slider allows
you to move the placement
of the camera in small
increments to fine-tune
your focus.

stack ’em up
Focus-stacking involves
focusing on the closest part
of your subject (a flower’s
stamen, for instance), then
moving the camera closer
by tiny increments, taking
another shot and repeating.
The most in-focus parts of
each image are then merged
together on the computer.

fill the frame
Using a long telephoto
lens enables you to zoom
in tight on your subject,
meaning you won’t have
to crop later in editing
software. This is invaluable
as it preserves as much
resolution as possible,
making the image more
detailed and defined.

take it steady
A solid tripod is absolutely
essential for this type of
photography. Models with
centre columns that can be
flipped out at an angle are
the easiest to use as they
allow you to position your
Nikon directly overhead
the subject lying flat on
the table below.

next month: surreal but fun photoshop creations
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Letters

Letters
We’d love to hear your thoughts on the mag and all things
photographic! Email us at mail@nphotomag.com or
write to us at N-Photo, Quay House, The Ambury,
Bath, UK, BA1 1UA. We reserve the right to edit any
queries for clarity or brevity.
letter oF tHe moNtH

Cut down to size
I was just flicking through N-Photo issue
72 and was drawn to the Q&A about a
recommended filter set for the Sigma
10-20mm f/3.5 lens. Having just bought
the lens and having traded in my old
Sigma 10-20mm f/4-5.6 I was a little
dismayed to read that my Cokin P-Series
filters would not work with my new toy!
I didn’t want to throw down lots of
money on a new set, so I decided to
experiment a little. When I first bought
my Cokin P-series starter kit I also
bought a set of ring adaptors to fit my
various lenses. Included in the set is an
82mm adaptor which I duly fitted to my
P-series adaptor and 10-20mm lens.
I found that I could get down to about
13mm before seeing the edge of the filter
adaptor, so not great but acceptable.

Win a Manfrotto
Advanced rear backpack!
Write our Star Letter and you’ll win a versatile
Manfrotto Advanced Rear backpack, which
is brilliant for photographers on the go.
It meets most airline carry-on
baggage limits, and has room
for your DSLR and three
lenses, plus a laptop. It’s
even got space to carry
a travel tripod securely.
For more details visit
www.manfrotto.co.uk

78

August 2017

Filter vignetting with a wide-angle
lens? Try Gary’s DIY solution…

However I read somewhere, years ago,
about cutting down the P-series adaptor
to one slot, which I did in about five
minutes with a junior hacksaw. I then
re-assembled the adaptors and attached
it to the lens and found I could use it at
10mm with only minor vignetting in the
corners, or 11mm with no vignetting at
all. I’d have to live with only being able
to use one filter with this set-up, but it
doesn’t seem out of the question. So
before everyone invests in a new filter
system, try this, it may save you some
money and reduce the amount of kit you
have to carry around.
Gary Holford, via email

Keep your copies of N-Photo neat
and tidy with our bespoke binder.
Each stores up to a year’s worth of
your favourite photo magazine – and
costs from £9.99! Order yours at…
www.myfavouritemagazines.co.uk/
n-photo-binder

A rock and a hard place
In N-Photo issue 72, page 74,
I see you have a photo of Kilt
Rock sent in by Andy Dines as
part of his portfolio. I’m used
to seeing extra info on insects,
birds and plants, but hardly ever
information on the kinds of rocks
in pictures. The top rock in the
Kilt Rock photo looks like it may
have the columnar jointing that
lava or shallow intrusion may
form upon rapid cooling. The
bottom light-coloured layered
rocks look a lot more like
sedimentary rocks, such as
limestone or sandstone. Does
anyone have any comment on
this or are all the photographers
at N-Photo non-geologists?
Thanks for any information!
Bob Cullers, via email
Great question, bob! rock
nuts we are not. Are there any
geologists in the audience?

A diY workaround is always welcome
in N-Photo. Hats off to your innovation,
and we hope it helps you in the search for
more excellent shots!
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sorry to hear that you’ve encountered
such problems, duncan. etiquette is
one of the less-talked-about aspects
of photography, but it’s probably one

shore thing
Firstly I must say how much
I enjoyed Jason’s video tutorial
on slow seascape photography
(N-Photo issue 72) and applaud
him for how much information
he got into the article. I certainly
learned something new – such as
switching the white balance from
Auto to Cloudy to emphasize the
warm glow of sunset.
However, I feel I must request
that N-Photo draw attention to
the dangers of photography at
the seashore, in particular in
windy and stormy conditions.
Jason correctly advises to
ensure tidal and light conditions
coincide to achieve the best
images, but please also ensure

s

I have two assertions to make
regarding N-Photo issue 72. First,
concerning the business of wellknown locations as referenced in your
Road Trip feature. While I agree that
there is often space for all who arrive
for sunrise/sunset, on many
occasions you can set up early with
a tripod only for ‘Johnny-come-lately’
to arrive and stand right in front of
you. You can ask him/her to move, but
what will ensue is a lecture about how
I don’t own the land and he/she can
stand wherever they like. The situation
is, in my opinion, getting worse.
Secondly, the article on replicating
motion blur in shots by postprocessing in Photoshop; what is the
point? Just take the shot correctly in
the first place! I feel your example is
poor, as it just looks like an out-offocus/camera moved photo. I have
been taking such shots for years
and enjoy the process and results,
although I’m well aware that many
don’t. I took this one in a bluebell
wood recently, for example.
Duncan Steward, via Facebook

er

Focus point

show your stripes!

I love it when you display the EXIF
data of your images. However,
I wonder if you could run a smaller
image alongside this to display the
focus point in a photograph, as I feel
this is just as important as aperture,
shutter speed and so on.
Stuart Bishop, via email

of the most important, especially when
shooting at a well-known location.
we’ve found that people are usually
just unaware that they are in the way,
and they will politely move when asked.
in regards to the motion blur
processing technique; getting the
shot right in-camera is, of course,
a valuable step to becoming a better
photographer, but learning new
post-processing techniques is never
a bad thing either. learning a new
skill – whether in photography or
Photoshop – usually pays dividends
further down the road.

that you are able to retreat
rapidly and safely if the
tide is coming in and that
you have at least one eye
is on the sea at all times!
Ian Douglas, via email

Focusing is a very important part of
photography – some would say the
most important part. if you shoot in
raw you can adjust exposure, white
balance and tonal values after the
fact, but if your focus is out, the
whole shot is unrecoverable.
However, the reason we don’t show
this alongside the eXiF data is usually
down to space. that, and the fact that
in most shots it’s quite obvious where
the focus point lies. but in situations
where it’s particularly important, we
endeavour to point out where the
focus was, and why.

Take care when shooting at the
coast in wet and windy conditions
and watch the pattern of the waves

ian, you’re quite right –
being safe is very
important when shooting
at the coast. one lesson
we learned from our
iceland Apprentice
feature, back in issue 57,
was that you should watch
the waves for 15 minutes
or so before venturing
down to the shoreline, in
case a freak wave comes
in. if in doubt, safety first,
photos second.

Follow us At www.FAcebook.com/NPHotomAG ANd www.twitter.com/NPHotomAG
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The only camera manual you’ll ever need

Freeman’s
82 Michael
Creative Paths...

In nIkopedIa thIs month

88 Nikon software

Apply a dash of Capture NX-D
magic to your photos to counteract
a whole host of pesky lens flaws,
including colour fringing, vignetting
and perspectival distortion

www.digitalcameraworld.com

90 Ask Jason

Nikon know-all Jason fields
more of your camera queries, and
recommends a cheap and cheerful
film camera, should you want to
dabble in such things…

Michael explains the art of
seeing shapes that aren’t
actually there to aid the
composition of your shots

92 Head to head

What’s better, digital or film?
We pit Nikon’s current flagship DSLR
– the D5 – against Nikon’s last ever
flagship film camera to see how
they compare
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Our globetrotting Contributor at
Large, renowned photographer and
prolific author Michael Freeman,
presents a month-by-month
masterclass that’s exclusive to
N-Photo, in which he explores his tried-and-tested
paths to more creative photography. Michael has
published dozens of books on photography,
including the bestselling Perfect Exposure.

Two clear and
separated circles,
but no obvious
shape to the
dresses yet…

Freeman’s creative paths

STRUCTURE
Finding shapes in a scene brings a layer of organization

M

If you enjoy this article
and want to learn more,
there are 50 more paths
to be discovered in
Michael’s new book
Fifty Paths to Creative
Photography (NB: all 50
are different from those
that will be featured
here in the magazine).

ost things to do with composition,
if you apply them well and
interestingly, have a boosting
effect on creativity. The reason
is that by making the composition work
harder – which generally means finding
visual, graphic connections between things
in your frame – you’re adding an extra layer
to the image. In this sense, ‘layer’ doesn’t
mean quite the same thing as the physical,
depth layers that we looked at in issue 70.
Here, layered means an extra way of
looking at the same subject. A graphic
structure is one solid way of doing this –
choosing a viewpoint or moment so
that what’s in frame is organized into a
recognizable shape. However, it can’t be
too obvious and due just to the way the
subject was deliberately made. We’re
looking here at virtual shapes that happen
in the viewfinder, not actual physical ones.
To work, they have to be unexpected or
fleeting, and above all because your eye
was smart enough to spot the shape when
other people might not have. There are no
prizes for finding a rectangle in a doorway
or window! The basic principle is that for
this kind of shooting, the more unusual
and coincidental, the better it works.

Getting in shape
It’s a kind of coincidence, and that’s
potentially powerful in photography
because it’s hard to control and therefore
rarer. It means, as in this example of two
young Vietnamese women dressed in
the traditional and graceful ao dai, the
photographer – you – saw a shape and
made it work. In fact, as in so many
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A breeze lifts the left
edge of the dress to
make the triangle

The two elbows add a
locked zigzag pattern

situations, the coincidence here of a
triangle and two circles was not a readymade gift, but began as a possibility. The
conical hats were graphic to begin with,
triangular from the side or circular from
the top; and the flowing white ao dais
were curving and fluid in shape. So,
while there was no reason to predict this
exact coincidence of shape, I was already
looking for some sort of combination,
which made me prepared.
The hats became these two circles
because the girls shielded themselves
from the sun, while the triangle of their
combined dresses was apparent for just a
few seconds as the breeze lifted the lower
corner of fabric. Like the other
photographs in this feature, the
shape comes from the subject,
but is in a way separate and
Vietnamese women
overlaid. It’s a second layer
in Ho Chi Minh City
prepare for a parade
of observation and interest.

www.digitalcameraworld.com
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Shadows and shapes
combine to contain the
action of scooping tea
leaves into an
approximate circle, but
only gradually, over the
course of the scooping,
did a sense of structure
appear — first as an oval
and finally a circle

circLinG in

Virtual circles are uncommon, but among the most satisfying shapes to capture

C

ircular shapes in photography are
powerful and rare – at least, virtual
circles are. They’re strong because
they enclose and pull things together,
wrapping them up into a visual package
that centres the eye. However, they’re not
easy to find because, unlike other shapes
such as triangles and rectangles, they
are continuous and need a sense of
completeness to work effectively. They’re
also a very good demonstration of why
difficult is good in composition. There’s
little point in photographing a clock face
and then admiring it for being round.
Shapes work best in photography when
they’re the least expected and the most
dependent on the individual photographer
finding them or suggesting them.
Overhead shots often have the potential
for shapes of one kind or another, simply

Shapes work best
in photography when
they’re the least expected
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because they offer a flat, plan view. In this
case, the overhead viewpoint was possible
because the two men were scooping up tea
leaves that had been drying all day in the
sun, right below a three-story building.
While shooting from ground level was
also useful, the less common view from
overhead was appealing because it gave
some different graphics, and I was looking
for variety in shooting a story on tea.
Nevertheless, the idea of having an
integrated shape didn’t immediately occur,
as the first frame of the strip of three shots
(above) shows. This was the beginning of
what ended up as a sequence of 43 shots.

and rounder, and as he moved in closer,
his shadow, curved at the top, started to
complete a circle, and was aided by the
eyelines of the two men facing inward
(and of the shadow, which, in effect,
became a third person from up high).
There were many tiny variations because
of the action, and finally I waited until the
shadow made the closest connection with
the now almost-round pile of leaves.
Cropping often does more harm than good
to a picture, but in this case I planned it for
square so as to heighten the sense of the
circle, and also to crop out the distracting
upper curve of the white plastic sheet.

completing the circle
Pulling back with the zoom included the
entire pile of leaves, and as the activity
continued I realized, by the time of the
second frame here, that the leaning
forward by the man with the shovel,
together with his shadow, was making
a sort of oval, which made me pay more
attention to the possibility of a shape.
I was, by this point, timing my shots
for when the wooden shovel was fully
extended. As the pile of leaves got smaller

Left: The sheet above
and the shadow below
creates a weak oval…
Right: However, the
four semicircular
shapes overwhelm the
oval to create a virtual
circle, and the inwardpointing eyelines act
like spokes to reinforce
the sense of the circle
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GO FOr GeOmetrY
Sometimes it pays to get abstract into pattern and colour

C
Women from the
Yi ethnic minority
gather at a funeral

artier-Bresson called composition
geometry, as in “if the shutter was
released at the decisive moment, you
have instinctively fixed a geometric
pattern”. He believed that, for a scene in
the viewfinder to have “the makings of
a picture”, it had to have some visual
coordination and “coincidence of line”.
His was a personal view, not a gospel for
everyone, but it was quite fundamental.
Turning a scene into a picture does
mean searching and finding some sort

of structure so that it hangs together
visually, and everyone understands basic
geometry. Nevertheless, exactly how you
coordinate and what you choose to make
coincide is entirely up to your own likes
and dislikes. And, just to show that it’s
not all about finding a triangle or a circle,
here’s a picture that attempts to play with
a number of separated small but distinct
shapes. What holds them together and
relates them is that they are all set against
a common background of black.

Working the angles
This picture was a deliberate decision to
look for angular geometry, and it was quite
different from what I’d originally set out to
do – and what I went back to doing once I’d
made this shot. The occasion was a funeral
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in the Yi ethnic minority in southwest
China, and because of good relations
between them and The Bivou, a small
hotel owned by friends of mine, my photo
workshop clients and I were invited
to attend. Rites of passage like this are
occasions for tradition, and my focus
for the day was to record – in other words,
to shoot very much in a reportage manner,
with the subject coming first.
Of course, that still meant making every
picture work in the Cartier-Bresson sense,
but for a short while I diverted my attention
to another kind of image. The large black
velvet-covered headdresses and vivid
fabrics with geometric patterns made me
want to try out an almost-abstract image
with shapes emerging from a black
background. That meant finding a

viewpoint from which several black
headdresses merged into one. As much
as possible, I wanted to fill my frame with
black and have wedges and fragments
of bright colour emerging from it.
As the sequence of shots below shows,
the style shifted from reportage to graphic,
with the composition dominating in the
end. That doesn’t make one style better
than the other, by the way. Just different.

The idea for the
composition was to
have fragments of bright
patterns emerging from
an all-black background

While the shoot started
reportage style, I started
to explore the graphic
possibilities of black
fragments and colour
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CAPTURE NX-D

WaTch

The video

Camera and lens
corrections
George Cairns demonstrates how to counteract
artefacts produced by your Nikon’s lens

T

Add A GRId
Browse to lens_start.NEF image in the Folders
window. Go to Image>Show Grid; this helps you
spot converging verticals caused by perspectival
distortion and curved lines caused by geometric
distortion. Go to Window>Birds Eye. Click the Edit
panel’s Camera and Lens Corrections icon.
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Reduce lens-induced artefacts

fo

become vignetted and appear
darker than the rest of the image.
While geometric distortion and
vignetting can be subtle, lensinduced artefacts, such as chromatic
aberration (colour fringing),
may prove to be more unsightly.
Fortunately, Capture NX-D can read
a photo’s metadata, discover what
lens and settings were used and then
counteract distortions and colour
fringing to create a more accurate
representation of the subject.
When shooting a tall subject from
a low angle, like our church, you’ll
notice the walls appear to converge
towards the top of the frame.
Capture NX-D can also counteract
this perspectival distortion.

Be

here are a range of artefacts
that your Nikon’s lens can add
to a photograph. Even the most
expensive lenses can produce
some geometric distortion. As light
is focused through the lens onto your
Nikon’s sensor it can cause horizontal
and vertical lines to bulge (or barrel)
outwards in the captured image,
or bulge inwards as pincushion
distortion. In general, this geometric
distortion is subtle and you’ll only
notice it when toggling the correction
on and off (as you’ll see in our
accompanying video lesson).
Different amounts of light can
enter the lens at the edge of the
frame, too. This uneven exposure
can cause the edges of the photo to

Fix lens flaws fast

bAnIsh bARRellInG
In the Camera and Lens Control panel, set the
Auto Distortion Control drop-down menu to On.
Toggle Auto Distortion Control box on and off to
compare the original photo with the corrected
one. Capture NX-D uses lens profile data to
evaluate and counteract geometric distortion.

ClobbeR fRInGInG
Type a value of 300% into the Bird’s-Eye View to
magnify the image. Drag inside the Bird’s-Eye
View’s rectangle to display the area shown above.
Toggle the Lateral Color Aberration box off and
on. This hides the purple and green colour fringes
that are clinging to the edges of the church.

You can download the start image(s) to your Mac or PC at bit.ly/start-74
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ToP TiPs

dust bustInG
The Camera and Lens
Corrections panel boasts
an Image Dust Off section
tool. This enables you to
browse to a ‘Dust Off’
reference image taken on
your Nikon. Capture NX-D
can then analyse sensor
spots in the reference
image and reduce their
presence in your photo.

af
te
r

Perspectival Distortion
Capture NX-D can also counteract perspectival
distortion. However, this can cause the subject to
become stretched both horizontally and vertically,
so you may need to compromise between making
your building’s walls truly vertical while avoiding
an over-stretched look. To make our converging
walls look more vertical using the Straighten and
Perspective Control panel, drag the Horizontal
slider right to a maximum value of 20. However,
note that this makes the church look much taller
and wider than the uncorrected version.

ReduCe vIGnettInG
Double-click on the image to zoom out and reveal
the full shot. Your photo’s edges may not be
evenly lit due to vignetting. Tick the Camera and
Lens Control panel’s Vignette Control box. Drag
the slider right to lighten the edges and create a
more even exposure; a level of 160 suits this shot.

Watch the video online at bit.ly/NPhoto74

WheRe To GeT
caPTURe NX-d

It’s made for
Nikons, and it’s
completely free!

As new Nikons are
introduced, Capture NX-D
should be the first software
to support them. Another
advantage is that it
replicates Picture Controls
and other settings. Capture
NX-D is available as a free
download from the
Nikon website at http://
nikonimglib.com/ncnxd
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Ask Jason...
Our resident Nikon expert Jason Parnell-Brookes answers your
questions and solves your problems. If you’d like Jason to come
to the rescue regarding your Nikon-related question, email it to
mail@nphotomag.com. Please note that we reserve the right
to edit queries for clarity or brevity.

Most shots from my D750 and
Tamron 24-70 f/2.8 lens seem to be
overexposed. How can I cure this?
Simon Lambert, via email

Jason says...Some lenses do tend to
over/underexpose a little, and it can vary
from one sample of any given lens to
another. If you’re finding it a consistent
problem, it’s worth dialling in exposure
compensation when using the lens and
leaving the setting in place unless you
need to change it for specific shots.
If you’re finding that your D750 is
consistently over/underexposing
oVerexposure
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regardless of the lens, you can alter the
‘b6’ option in the custom settings menu,
to fine-tune the exposure values for each
metering method (Matrix, Spot, Centreweighted). You can apply compensation
in 1/6 EV steps between +1 and -1 EV.
Nikon’s Active D-Lighting is also worth
using to maintain exposures with good
highlight and lowlight detail. In PASM
modes, Active D-Lighting is available
from the Shooting menu, with various
strengths from Low to Extra High. There’s
also an ‘Auto’ setting that works well,
reacting to different scenes as you shoot.
A little exposure compensation and Active D-Lighting can
deliver a much better balance of brightness and contrast
Good exposure

Using optical stabilization
and boosting ISO can enable
sharp handheld shots indoors

How can I get
sharp shots inside a
cathedral when flash
photography and
tripods are prohibited?
Eric Taylor, via email

Jason says… Optical
image stabilization is an
enormous help in capturing
consistently sharp handheld
images indoors. Recent
Nikon DSLRs also perform
well at high ISO settings,
maintaining remarkably
low-noise image quality up
to around ISO6400 and even
higher. If you don’t have time
to adjust the ISO setting on a
shot-by-shot basis, use the
Auto ISO function instead,
and set your preferred
maximum value.
For shooting cathedrals
and other building interiors
with wide-angle lenses,
another bonus is that you
can expect to get sharp shots
at slow shutter speeds. For
example, using a 10mm focal
length on a DX format body
(or 15mm with an FX camera)
you can still get sharp shots
with shutter speeds as slow
as 1/15 sec, even without
stabilization, which often
isn’t available in wide-angle
lenses anyway. Check your
images for sharpness after
each shot on the camera’s
LCD screen, and reshoot
if necessary.
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I missed out on the 35mm film era altogether
and would like to try my hand at it. What’s a good
but inexpensive Nikon film SLR?

Jim Handcock, via email

Jason says… You can go all the way back to Nikon FE and
FM models, but these retro chic models are often expensive
to buy and lack autofocus. The classic F501 (N2020 for the
American market) was Nikon’s first SLR to feature autofocus,
and is a bargain secondhand buy.

Nikon F501
The AF-S VR version of Nikon’s
70-300mm lens outperforms
the new ‘AF-P’ editions and is our
budget telephoto zoom of choice
for shooting wildlife

too pricey for your budget, the
Tamron SP AF 70-300 f/4-5.6
Di VC USD (£300/$450). Both
of these lenses are sharper
than the Sigma, have relatively
fast ring-type ultrasonic
autofocus systems, and
feature optical stabilization.

I have a D5300 and would like a macro lens for
shooting extreme close-ups, but can’t afford one
yet. Is there a good alternative?
Gary Gudgin, via email

Jason says… You can’t beat having the right tool for the job
and, if you can’t currently afford a new macro lens, consider
buying one secondhand. I’d go for the Tamron SP AF 90mm
f/2.8, good used examples of which cost around £170/$200.
Ensure you buy the updated ‘A272NII’ version, which adds a
built-in autofocus motor, launched in February 2008. The older
edition won’t autofocus on your D5300. That said, manual
focusing is often preferred for macro photography anyway.
If a secondhand lens is too expensive, the next best solution
is to buy a set of extension tubes, which physically extend the
distance between the camera body and a
regular lens, to give a shorter minimum
focus distance. You’d need Nikondedicated extension tubes that
enable autofocus and exposure
info to be communicated
between camera and lens.
A set of Kenko extension
tubes will set you back
around £120/$125

er

Jason says...
It’s hard to say without seeing
your images, but the Sigma 70300mm lens isn’t exactly a top
performer. Compared with
wide-angle shooting described
in the previous Q&A, optical
image stabilization can be
even more vital in avoiding
blurred images from camerashake when using a telephoto
lens. It’s therefore surprising
that Sigma stopped making
its stabilized 70-300mm
telephoto zoom a few years
ago, but still markets its even
older editions of the lens.
As well as lacking
stabilization, older Sigma
70-300mm lenses have
sluggish autofocus systems
that can struggle to track
moving subjects in wildlife
photography. I’d suggest
upgrading to the Nikon AF-S
VR 70-300mm f/4.5-5.6G
IF-ED (£450/$500) or, if that’s

SW

Kelly Belcher, via email

Secondhand Superstar

AN

I’ve got a D3300, but am struggling to get good
wildlife photos with my Sigma 70-300mm lens. Do I
need a different lens or am I just not doing it right?

a feature-rich
camera from the
1980s, with autofocus!
released (year): 1986
price new: £250/$365
price used: £30/$50
The Nikon F501 was launched
back in 1986 and ushered in a
new age of Nikon autofocus
SLRs. Other mod-cons
include automatic film
loading, a built-in motor-drive
with advance speeds of up
to 2.5fps, automatic ISO
sensing for different film
speeds, and triple-mode
‘program’ shooting.
The camera is a good
match for Nikon AF lenses
that are still in production
today, although autofocus is
unavailable with newer AF-S
(Silent wave) lenses. One
advantage of the older-style
D-type AF lenses is that they
include physical aperture
rings on the lens barrel, which
you’ll need to set the aperture
when you’re not shooting in
automatic program shooting
modes. VR (Vibration
Reduction) is also unavailable
with the F501, and you’ll
naturally need FX (full-frame)
lenses rather than DX
(APS-C) format lenses.
Ultimately, good working
examples of the F501 can be
found very cheaply if you look
around, for some serious fun
with film photography.

Key points

Triple program modes
Three program modes include
high-speed and ‘dual’. The latter
automatically sets faster shutter
speeds with longer lenses, to
reduce the risk of blurring
from camera-shake.
Mode dial
The mode dial enables easy
switching between program
and aperture-priority, as well as
manual shutter speeds between
1 sec and 1/2000 sec, plus Bulb.
Battery compartment
At the base of the camera is
a compartment for four AAA
batteries, for the F501’s metering
and AF systems, as well as its
motor-drive for film transport.

specs
Format: 35mm film
Autofocus: Phase-detection
Metering: Centre-weighted
Shooting modes: P, P Hi,
P Dual, A, S, M
Lens mount: Nikon F (AF)
Motor-drive: 2.5fps
Batteries: 4x AAA
Dimensions: 148x97x54mm
Weight: 610g

Got a question? email us at mail@nphotomag.com
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Fabulous film or digital delight? We pitch the famous F5 against the delectable D5

Nikon

F5

d5

Nikon

Autofocus

The Multi-CAM1300 AF system developed for the F5 delivered a
then-impressive five focus points, adding two outlying points in
the horizontal and vertical axes to the central AF point. Dynamic
AF mode utilized all five points for tracking moving subjects.

With pinpoint precision and the ability to track just about anything,
the D5 has an astonishing 153 AF points, 99 of which are crosstype. Autofocus continues to work in near-darkness, down to -4EV,
and 15 AF points remain active when the widest aperture is f/8.

Metering

With a 1,005-pixel RGB array in its CCD metering sensor, the F5
boasted a metering system that could literally see in colour. This
3D Colour Matrix system soon became legendary, while additional
modes included centre-weighted and spot metering options.

The high-tech metering sensor has nearly 200 times the resolution
of the F5’s, based on a new 180k-pixel RGB module. The 3D Colour
Matrix III system gives unparalleled accuracy with advanced
automatic scene recognition, and the bonus of Active D-Lighting.

Sensitivity

The ISO range of any film camera is limited by the film itself. High
flyers include Fuji Superia, at ISO1600, and Kodak T-Max for black
and white, at ISO3200. Suffice it to say that neither holds a candle
to digital sensors in terms of speed or image quality.

A clear win for the D5, the sensitivity range is simply monstrous,
stretching from ISO100 to ISO102,400 in standard trim, and
reaching ISO3,280,000 in expanded mode. It blows film out of
the water for both range and image quality at ramped-up settings.

Speed

Year launched: 2016
autofocus: 153-point
Metering: 180k-pixel
3D Colour Matrix III
shutter speed: 30 to
1/8000 sec, Bulb
continuous drive:
12fps (14fps mirror up)
power source:
Li-ion battery pack
diMensions (wxdxh):
160x159x92mm
weight: 1235g
(without battery)

Something of a speed demon back in the day, the F5 could shoot
up to 1/8000 sec and a film advance rate of 7.4fps on eight AA
batteries – rising to 8fps on an optional Ni-MH battery pack. As
such it could devour a 36-exposure roll of film in just 4.5 seconds.

It’s a dead heat for fastest shutter speed, but the D5 eases ahead
for drive speed, at 10fps – or 12fps when the mirror is locked up.
With no need to change film, you can shoot continuously for up to
153 (12 secs) or 200 (16 secs) shots, in Raw or JPEG respectively.

Image quality

Year launched: 1996
autofocus: 5-point
Metering: 1,005-pixel
3D Colour Matrix
shutter speed: 30 to
1/8000 sec, Bulb
continuous drive: 7.4fps
(8fps with Ni-MH pack)
power source:
8xAA or Ni-MH pack
diMensions (wxdxh):
158x149x79mm
weight: 1210g
(without batteries)

vs

There’s been a long-running debate on the merits of film vs digital.
With good lighting, film cameras are capable of delivering
spectacular image quality. Even so, processed film is much like
a raw material, with darkroom endeavours playing a crucial role.

The D5 is typical of Nikon DSLRs in that it’s practically a digital
darkroom as well, enabling images to be optimized at the point of
capture. With multiple picture controls and other enhancements,
stunning image quality is assured, even without Photoshop.
Next moNth: ULtRA-WIDe Zoom vs ULtRA-WIDe PRIme
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With outstanding toughness,
reliability and performance, it’s no
surprise the F5 was the camera of
choice for NASA’s space shuttle

August 2017

missions. Among many of the
world’s most discerning pros, it
earned the reputation of being the
world’s best ever film camera.

However, digital SLRs really have
been a game-changer, literally
revolutionizing photography at
every level. The D5 is the new king.
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IntervIew

96 Corey Rich

The mountaineerturned action sports
photographer shares his
amazing – if vertigo-inducing
– portfolio of shots taken
from way up high

On assIgnment

Dewhurst
106 Oscar

Biology student
Oscar recalls a twomonth stint in the
Amazon during his
gap year, where he
got to photograph
the diverse species
of the rainforest
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Corey
riCh
Legendary climbing and adventure
sports photographer Corey Rich tells
Keith Wilson about switching from stills
to video, hitting curve balls and sticking
VR cameras on carrots...

96
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Corey riCh

All images: © Corey Rich

Profile
● Corey Rich is a
photographer, director, and
Nikon Ambassador, based in
South Lake Tahoe, California.
● His photographs have been
published in the pages of the
New York Times Magazine,
Sports Illustrated, National
Geographic and hundreds
of adventure sports titles
around the world.
● Commercial clients include
Apple, Columbia Sportswear,
Discovery, Energizer, Ford,
Mazda, NBC, Nike, The North
Face and Patagonia.
● In 2016, Corey helped
Nikon to launch the Nikon
KeyMission camera line,
including the KeyMission 360,
a 4K Ultra-HD virtual realitycapturing action camera.
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orey Rich is leaning
back in a chair, having
just returned home
after six weeks
shooting in Slovenia,
Switzerland and Italy.
“One of my skill sets is powering
through the jet lag.” In less than a
week he’ll be flying to Austria, and
then back to his California home
for a day, before jetting off again
to Tahiti. It sounds exhausting,
but I’d love to have his Air Miles…
Are you much of an action man?
If you go back to the beginning, I first
fell in love with rock climbing and then
I picked up a camera to document
those adventures. Deep in my soul
I still love being outside and being a
participant in the adventure sports
that I photograph. I live in Lake Tahoe,
California, which is arguably the
adventure capital of the world.
My entire life is designed around the
ability to get outside and rock climb
and mountain climb and swim in the
lake and go on ski trips, so I guess the
answer is: adventure is really at the
centre of who I am and what I love to
do. It was such a natural extension to
bring a camera along to document
those weekend adventures.
So when did you first pick up a
camera to shoot rock climbing?
It’s a pretty funny story. When I was 13
years old, I won the pole-up contest
at my junior school summer camp
because I was a gymnast. One of my
teachers took note of this short, strong
kid and said, ‘Hey, you want to go rock

climbing?’ He was an old Yosemite
rock climber. That weekend he and
another teacher and my brother, we
had our first rock climbing experience
and it completely blew my mind, the
mental and physical challenge. It
became a routine to go rock climbing
every weekend, then I’d come back to
this schoolyard and weave yarns of my
weekend adventures. Then I kind of
had this epiphany that, to tell a really
great story, you need visual proof, so
I borrowed my dad’s SLR and realized,
after the first weekend, that it wasn’t
just about having a nice camera, but
it’s knowing how to use it, and that
was it – the parallel pursuits were born.
From that point forward I continued to
go climbing every weekend, but along
came my father’s camera.

Previous page
US ROCK CLIMBER
TOMMY CALDWELL
SPORT CLIMBIng In
MALTA, SARDInIA,
2012
nikon D800,
200mm, 1/1600
sec, f/4, ISO200

TOMMY CALDWELL
fREE CLIMBIng EL
CAPITAn’S DAWn
WALL, YOSEMITE
nATIOnAL PARK,
CALIfORnIA, 2015
Exif not available

What was your first
published photograph?
You know, that also happened early
on. I was just so hungry to improve my
photography skills, I pursued every
avenue possible. I went to the library
and I read every book on photography,
I signed up for the community
yearbook program in high school
where I could take pictures. My English
teacher also happened to run the
newspaper program at the high school
and it turned out his wife was one of
the managing editors of the real
newspaper in town. They kind of
slipped me into the newspaper to start
shooting the crappiest stuff you could
possibly shoot – I shot the real estate
section, which meant you drove round
and shot photos of houses, but when
you’re a kid in high school that’s big

A QUeStion oF PrioritieS…
WhIle STudyIng phOTOjOuRnAlISM, CORey WORked AS An InTeRn AT hIS
lOCAl pApeR, buT The luRe Of The OuTdOORS SOOn pulled hIM AWAy…
I was at the Modesto Bee,
and I had this epiphany: ‘Wait
a second, I didn’t start taking
pictures to shoot Fourth of
July parades and portraits
of the mayor, I did it because
I loved outdoor adventure.’
So, I took six months off from
college, bought a 100 rolls of
film and drove around the US
documenting rock climbing.
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how did it turn out?
It was hard to convince my
mum and dad that I was
going to take time off from
college, but I submitted my
images to a few clients and
there was this immediate
response. I landed a bunch of
photographs in a Patagonia
catalogue and the cover of a
climbing magazine. Several

thousand dollars showed
up in the mail, and that was it.
All of a sudden I had become
an adventure photographer.
The more I got published,
the lower my grade point
average in college dropped!
did you complete college?
No, I’m still three classes shy
of a degree!

time! So, by the time I was 16 or 17
years old I was shooting for the
newspaper, the Antelope Valley Press,
and it was a legitimate 60,000 daily
circulation newspaper with a photo
staff of five or six folks who really took
me under their wing. I think they loved
having this kid around who was so
passionate about what he was doing. I
just couldn’t believe that I had free film
and an entire pool of cameras to work
with. That was really the beginning of
it, I was getting paid for taking pictures.
What’s the most significant
development that has made a real
difference to your photography?
My answer is perhaps a little
unexpected to what the average
photographer might say. It wasn’t the
switch from film to digital. That was
nice, I mean resolution got better and
workflows got simpler and I didn’t
have to travel with a hundred rolls
of film, but fundamentally nothing
changed – we were still shooting
images in a rectangle. There were two
huge shifts for me. The first was
video-enabled DSLR cameras that
allowed a guy like me, a classically
trained stills photojournalist, to press a
record button but have control of that
visual in the same way that I could
control a still photograph. That was
one of those giant junctions in the road
for me where I went from being a stills
photographer to being a filmmaker.
And just in the past two years there
has been another of these big shifts,
which was the launch of virtual reality
cameras. The Nikon KeyMission has
yet again totally transformed where
my time has gone and what I’m doing
with my focus and passion. I think if
I were to block out my career so far, it’s
photography, filmmaking and virtual
reality. I was really fortunate to help
Nikon launch its KeyMission camera,
which meant, by default, I was
immersed in the world of virtual reality
early. On my trip to Europe I was
directing a project for NBC’s Big
Channel in virtual reality, profiling
Olympic athletes. There have been
these incredible shifts, from being the
photographer to shooting video, to
then directing video projects, to now
shooting and directing virtual reality
projects, and Nikon is the catalyst for
these changes in my career because
of the technology in the products the
company has launched.

www.digitalcameraworld.com

Adventure is really at the centre
of who i am and what i love to do.
it was such a natural extension to
bring a camera along

Corey riCh

US SnOWBOARDER
MIKEY WIER
AT HEAvEnLY
MOUnTAIn
RESORT,
CALIfORnIA, 2008
nikon D3X,
200mm, 1/2000
sec, f/5, ISO200

US CLIMBER ALEX
HOnnOLD SOLOS EL
CAPITAn, YOSEMITE
nATIOnAL PARK,
CALIfORnIA, 2010
nikon D3X,
120mm, 1/200 sec,
f /3.2, ISO200

following page
US CLIMBER
BETH RODDEn,
ROCKLAnDS,
SOUTH AfRICA,
2008
nikon D3,
120mm, 1/200 sec,
f /3.2, ISO200

do stills, video and virtual reality
seem like three different strands?
Well, fundamentally they all come
back to that central critical theme,
which is: what are you trying to say?
Say something compelling, make
those visuals compelling.
Photography is very much an
individual activity, it’s like running
a marathon: you go out there alone,
it’s you running, you make the
pictures. Video is no longer a solo
game: now, you’re on a football team,
you’re relying on the guys to your right
and to your left, and there’s someone
throwing the ball to you and it’s an
orchestrated effort. Virtual reality is
very similar: it’s just 360-degree video
and so, again, it requires a team. It’s no
longer a solo sport, so the workflows
have completely changed.
What has been the main challenge
of shooting virtual reality?
Wrapping my head around virtual
reality has been much more of a
stretch because it truly is a new way
of thinking, for everyone. I think, as a
society, we’re still trying to figure out
what is virtual reality? How do we

www.digitalcameraworld.com

deliver it? What is the platform? What
is the most compelling use of virtual
reality? As a photographer, my entire
career, up until pressing record on the
KeyMission 360, was to look through
a viewfinder and control what
I eventually wanted my viewer to see.
Virtual reality is such the opposite, it’s
you press the button and you have to
accept this reality. You can’t control
what your viewer will see; your viewer,
in the end, is going to have the ability to
navigate through that sphere and look
at any part of that sphere they deem
interesting. So, you’re responsible
not just for a 16x9 rectangle, you’re
now responsible for the entire sphere,
and that consciousness of what do
you want your viewer to see, or
what could they possibly see?
Is choosing the location therefore
the most important decision to
make before hitting the record
button of a virtual reality camera?
I think it’s a big part. It’s choosing the
location, it’s fundamentally making a
decision: are you willing to allow your
viewer to understand how the camera
got into that location? Meaning, are

they going to see the pole that the
camera is mounted to? It’s easier to
hide a tripod when you’re shooting a
rectangle. If you are going to put that
virtual reality camera on a drone, are
you going to allow the viewer to see the
drone because it’s hanging below it?
Are you going to be in the shot, or are
you somehow going to get out of the
shot as the camera operator? That
means either you accept that you’re
there or you’re hiding behind a bush
every time you press record! So,
there’s a lot of those decisions in
virtual reality. Is the camera going to
be stationary, or is the camera going
to be moving? Is the car driving by the
virtual reality camera, or is the virtual
reality camera mounted on the car?
So, what do you favour?
I’m not trying to draw attention to
how I made the shot. I want the viewer
focused on the subject, so in a perfect
world for me I want the viewer to be
focused on the content first, the
subject, and then, maybe if they’re a
camera geek: ‘Wow, I wonder how he
did this shot?’ But I don’t want them to
see the tripod, I don’t want them to see
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Corey riCh
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me, I don’t want the drone present in
the shot, but that’s hard! Hiding those
things creates a lot of work, and it’s
almost impossible to hide certain
aspects of how the camera is
moving, or how it’s mounted.
have you stuck it on the
helmet of a rock climber?
Sure. You know, I’m trying to think of
where we haven’t put a virtual reality
camera! One of the images that really
stands out is we’re shooting with a
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MOUnTAInEERS
DAvID LAMA AnD
PETER ORTnER
CLIMBIng
TRAngO TOWERS,
BALTISTAn,
PAKISTAn, 2012
nikon D600,
17mm, 1/15 sec,
f/2.8, ISO800

young rock climber, one of best female
rock climbers in the world; her name is
Ashima Shiraishi, she was 14 or 15
years old and we went to Thailand with
her. She was climbing over the water
with no ropes. It’s called deep water
soloing, it’s spectacular stuff and we
were shooting virtual reality and there
was a stalagmite, a tufa, hanging down
from these limestone formations.
We mounted a KeyMission to that
stalagmite 40 feet above the water,
and then Ashima climbs past.

Another great one, I was recently
in Nigeria shooting on this Olympic
project and we were shooting in a
market and we got this great shot of
a woman walking by with a bunch of
carrots on her head. I thought, ‘Wait,
now let’s put the camera on the
carrots!’ So we mounted the virtual
reality camera on her head, on a
carrot, as she walked through the
market. That’s the beauty of a small
camera like the KeyMission, the only
limiter is your imagination.

www.digitalcameraworld.com
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Cover Story
CORey MOSTly ShOOTS vIdeO TheSe dAyS, buT he’S AlSO
ShOT AROund 100 MAgAzIne COveRS In hIS CAReeR…
So, what makes a great magazine cover?
Of course, it has to be a great picture, a great moment that encapsulates
a story, but a cover also, let’s be honest, is the sales tool, it’s the ad. Those
ads are designed to stop you and convince you to pick the magazine up.
The difference between a good frame and a great frame is subjective. I like
to talk about the ‘collective subjective’; I can show a picture to my mother
and she’s happy with everything that I shoot, but when you show it to
everybody and everybody agrees it’s a great photograph, that’s the
collective subjective, and that’s the stamp of approval on a great
photograph, or on a great video.

love is when I get caught off guard by
a new experience. I think we’re ready
to go and a curve ball gets thrown at
me, and I love hitting curve balls!
We did a shoot in Pakistan, in the
Karakoram Mountains, a couple of
years ago. Part of it was the logistics:
we brought some of the first camera
drones into Pakistan and getting the
drones through customs and figuring
out, ‘Can we actually fly a drone at
21,000 feet? Are we going to make
visuals?’ was part of the challenge.
I love being on the edge and asking
myself, ‘Is this going to work?’ I cross
my fingers, preparing for the worst
and hoping for the best.

My advice is focus on the fun
part. Worrying about running
a business is not the fun part.
The fun part is getting out
there and making the best
pictures and the best videos
Of all your assignments, does one
stand out as the biggest challenge?
The joy in this career is that every
project is different. Never do I do the
same shoot twice. You know that old
saying, you never step in the same
river twice because it’s always
changing and moving, and I feel that
about my career. What I love most
about this job is that half of it is making
amazing pictures and the other half is
just problem solving. It’s not letting
any obstacle get in the way. What I still

What’s in your kit bag these days?
It’s a very different bag, that’s for sure!
The KeyMission bag is tiny. I carry six
in a padded brick the size of a laptop.
Then I have 20 batteries and a bunch
of micro SD cards. I have a 10x4x6in
bag block that carries all the
KeyMission cameras, and then I have
a gigantic Pelican case and another
rolling bag with all the gear we’re using
to mount them! Not to mention a
drone and suction cups, adhesive
mounts, metal rods, grip tape, bands,
magic arms. The fun part of shooting
on KeyMission is that we are all
together innovating and thinking
about what are the best tools for
mounting these devices. So that is
the joke: here’s this little camera that
weighs virtually nothing and I have
a hundred pounds of mounting
equipment. We do a lot of innovative
and unique mounting because we’re
trying to surprise our audience with
where that shot is being made.

What about your still cameras?
I have three cameras. The D5 for when
I’m shooting sports action and I need
speed; and a D810, of course, if I need
resolution and incredible sharpness.
But my favourite camera is the D750,
because it’s so lightweight and I love
the vari-angle screen. I’m a small guy
and when I’m in the mountains every
ounce counts when I’m carrying my
own equipment, so the D750 is
remarkable. It’s video enabled, it’s
enough frames per second, it’s the
right resolution. No matter where I am,
whatever I’m doing, the D750 is always
in my backpack, always ready to go.
What is your go-to lens?
I go through phases. For six months
it’s the 50mm f/1.4, and right now
– it’s in my bag here – I have a 24mm
f/1.4 prime. I grew up as a zoom guy
in the photojournalism world, but
now I’m a prime guy and that probably
comes from my time spent in video.
What’s the best advice you would
give to someone starting out?
My advice is don’t write a business
plan, don’t get distracted by how
you’re going to make money. Focus
100 per cent on making amazing
pictures or videos and the money
will find you. Focus on the fun part.
Worrying about running a business is
not the fun part. The fun part is getting
out there and making the best pictures
and the best videos. If you do that, the
rest of it falls into place. If you’ve got
something that people want it’s much
easier to figure out the business
component. You’re guaranteed
to win if you have great content.

NEXT moNTh: NATIoNAL
NEXTGEoGRAphIC
moNTh: INToANd
ThENEW
WILdYoRK
WIThTImES
NEW NIKoN
AmBASSAdoRLYNSEY
RIChARd
pETERS
phoTojouRNALIST
AddARIo
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Amazon
adventure

Wildlife photographer Oscar Dewhurst shares his favourite
images from a two-month trip to the Amazon rainforest

T

hese images are from my
time spent staying at a
remote biological research
station in the Peruvian
Amazon rainforest. I had
taken a gap year between finishing
school and going to Durham
University to study Biology, and
wanted to photograph somewhere
I had never been before. After some
research, I came across a set of three
research stations run by the Amazon
Conservation Association, where
I could stay and photograph the
wildlife in the surrounding forest,
as well as the work being carried
out at the station.
I was there for two months,
and I took pictures every day.
Wildlife activity peaks at dawn
in the rainforest, so after an early
breakfast at 6am, I would set out
on the network of trails through
the forest. During the day I also
photographed invertebrates and
amphibians in a portable studio
that allowed me to capture clean
images with white backgrounds.
I would then head into the forest
again in the afternoon, until sunset,
at around 6pm.
I had to work hard to find the
wildlife, particularly mammals and
birds. If they moved away from the
trail into the forest I had little-to-no
chance of following them, so it was
important to move slowly and quietly.
Fortunately, many of the primates
were curious and relatively tolerant of
me photographing them. The birds
were a different story, however.

The tree canopy is very thick and
light levels are low, so I generally had
to use high ISOs. Even then, shutter
speeds were frequently below 1/100
sec. It was hard to get sharp images
with a 600mm lens at these speeds.
I had a selection of kit with me, but
the set-up that got the most use was
my Nikon D800 and 600mm f/4
AF-S II lens, mounted on a Wimberley
gimbal head. With the low light levels
I sometimes used an SB700 flash.
The detail in images from the D800
was superb, and the high megapixel
count meant that I could crop images

Images: Oscar Dewhurst

Fortunately, many of the
primates were curious
and relatively tolerant of
me photographing them.
The birds were a different
story, however
more than I was used to doing
with my previous camera [the
12-megapixel D300s]. The 600mm
f/4 boasts lightning-fast autofocus,
and is one of the sharpest lenses
I’ve used, while the wide maximum
aperture was vital for ensuring fast
shutter speeds.

monkeying around
A group of Peruvian spider monkeys
in a tree is my favourite image, as it is

the one that brings back the most
memories. I spent several evenings
up on the research station’s canopy
tower, as the light was superb if the
sky was clear. One evening I spotted
a couple of black blobs in the top of
this tree, which was some distance
from where I was. After a while,
I noticed that there were several
more monkeys in the tree, so I
switched my attention to them.
It was my first time in a proper
rainforest and I was just completely
stunned by the incredible biodiversity
that could be found in such a small
area. One morning I could
be watching a troop of spider
monkeys feeding no more than
40 metres from me, and the
same evening I could be
watching spectacular blueand-yellow macaws flying
past me to roost.
Many of these images were
donated to the Amazon
Conservation Association to
use in their work protecting the
rainforest. It has been three
years since I was there, but
I am very keen to get back after I have
finished university. On future trips
I will have more experience that
should help me obtain strong images.
There are a couple of projects that I’d
like to do in forests, but I am starting
a master’s degree in October, so they
will have to wait until after that is
finished. Watch this space!

1
Sky high
it had been a dream
of Oscar’s to go to
the Amazon. he
was based for two
months at the Los
Amigos Research
Station. A canopy
tower stretched
60m into the sky
above the forest,
giving panoramic
views in every
direction.

2
BRANChiNg OUT
Oscar’s shot of
Peruvian spider
monkeys is his
favourite because
of the light and the
inclusion of some
habitat, but mainly
because it reminds
him of his time
there: “i have it
printed very large
on my wall at home.”

See more of Oscar’s portfolio at
www.oscardewhurst.com

Next MoNth: theAWeSoMe WAVe PhotoGRAPhY oF CLARK LIttLe
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Gear Zone
Our awards
Five scores,
Five meanings in a nutshell

IN-DEP TH REVIEWS / GROUP TESTS / bU y ER’S GUIDES

The best
performance,
design and value

Forget about it!
Below average
Good for the money
Excellent product
Best-in-class

A product that
gives you more
for your money
The very best kit
that really sets
the standard

Big test

114 Superzooms

Whether you want to travel light
or are scared stiff of changing glass in
dusty climes, these do-it-all lenses go
from wide-angle to super-telephoto

new gear

110

The latest accessories

Another brand-new batch
of shiny camera gear to feast
your beady little eyes on…

www.digitalcameraworld.com

Mini test

BUYER’S GUIDE

Is your sensor a revolting
mess of dust spots? Give it a good
ol’ polish with these cleaning kits…

124 Nikon cameras and lenses

112

Sensor cleaners

Every currently available
Nikon DSLR (plus Compact System
Cameras) and loadsa lenses…
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New gear

Here’swhat’scaughtoureyethismonth…

Nikon AF-P DX NIKKOR
10–20mm f/4.5-5.6G VR
£330/$310 www.nikon.com

Nikon has just announced three new wide-angle lenses
aimed at three very different kinds of photography.
The most exciting, from our point of view, is the new AF-P
10-20mm f/4.5-5.6G VR. This is an ultra-wide-angle zoom for
Nikon’s DX-format cameras and it brings three key features –
it uses Nikon’s latest AF-P autofocus system, it has Nikon’s VR
(Vibration Reduction) system built in, and it offers extremely
good value for money.
The AF-P autofocus system uses stepping motors to drive the
lens’s focusing mechanism, and we’ve already seen it used to great
effect in Nikon’s latest AF-P 18-55mm kit lens. It offers fast, nearsilent autofocus, which is good for stills photography, and even
better for video.
Nikon’s VR mechanism is a common feature in the company’s
longer focal length lenses, but it’s the first time it’s been used in a
super-wide-angle Nikkor zoom. The existing Nikkor 10-24mm DX
lens does not have it, and neither does the much older 12-24mm,
and both lenses are much more expensive than the new AF-P lens.
This is perhaps the best news of all: Nikon’s new DX format
super-wide-angle costs no more than third-party rivals. It’s
also designed to be lightweight and is ‘built for travel’.

Nikon AF-S NIKKOR
28mm f/1.4E ED
£2080/$2000 www.nikon.com

in their kit bag; this new Nikkor ticks all the boxes, and at the right price.

Nikon AF-S FISHEYE
NIKKOR 8–15mm
f/3.5–4.5E ED
£1300/$1250 www.nikon.com

This dust- and drip-resistant 28mm lens
is the latest addition to Nikon’s range of
premium-quality, full-frame f/1.4 prime
lenses. It’s designed for landscape, travel,
wedding photography and any other
situation where you need to combine a wide angle of view with a fast maximum
aperture and a high level of optical performance. The f/1.4 maximum aperture
doesn’t just allow faster shutter speeds in low light, it will also make attractive
shallow depth of field effects easier to achieve.

Fisheye lenses are common enough, but this is Nikon’s
first ever fisheye zoom. Its unique feature is its ability to
swap from a circular fisheye at 8mm (which produces a circular image with
black corners) to a full-frame fisheye at 15mm. As Nikon says, it’s like having two
fisheye effects in one lens.
Designed to fit Nikon’s full-frame FX cameras, the lens has an astonishingly
close minimum focus distance of just 0.16m and is also dust and drip-resistant .

Firstimpressions_There’s no denying it’s an expensive lens, but it could

Firstimpressions_Fisheye lenses can produce striking interior, landscape

prove very popular with professional photographers who need to capture
people, places and interiors in low light.
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Firstimpressions_Any photographer needs a super-wide-angle zoom
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and sports shots, and this circular/full-frame fisheye combination is very
clever design that really is like having two lenses for the price of one.

WhiteWall
Acrylic Minis

£13/$20 www.whitewall.com

we buy any
camera
.com

Forget the idea that acrylic prints need to be big; WhiteWall’s
new Acrylic Minis are a mere 18x13cm, or 13cm-square. They’re
designed to be wall-hung from an integrated hook, placed on a
table or shelf using the included plexiglass stand, or stuck to
your fridge with a built-in magnet. Great as gifts, or for
displaying multiple themed images in a small space, Acrylic
Minis are ideal for displaying your shots without worrying about
framing or mounting, and they’re backed by WhiteWall’s
award-winning print quality.

Firstimpressions_Proving that prints don’t have to dominate the
entire living room to capture attention, these acrylic mounts lend
any photograph a stunning sheen.

Lastolite Joe McNally
Ezybox Speed-Lite 2 Plus

£60/$79 www.manfrotto.com

This development of Lastolite’s Ezybox Speed-Lite 2 has been
designed in conjunction with Nikon ace and N-Photo columnist
Joe McNally, and features his preferred white interior for soft,
even illumination. The 22x22cm outer diffuser has also been
tweaked: it’s now recessed by 45mm to help control light
spill. Thankfully the original pop-up design remains, with its
ingenious mechanism that enables the softbox to fold flat in
seconds. It’s just as easy to attach to your flashgun, with a
silicone strap and twist-lock clamp combo ensuring a secure fit.

Firstimpressions_The price may seem steep for a compact

softbox, but it’s justified by a carefully considered design that
should make the Ezybox a pleasure to use.

Manfrotto
Manhattan Collection

From £80/$100 www.manfrotto.com

Designed for city slickers and
commuters, Manhattan bags put
flexibility centre stage. A Flexy Camera
Shell divider system will wrap snugly around your gear, and the
camera insert is easily removable for when you need a regular
bag. The range includes the Mover 50 backpack designed for a
D810 with attached 70-200mm f/2.8, plus five extra lenses and
a 15in laptop. The Speedy 10 messenger bag is best suited to a
small APS-C DSLR set-up, while the Changer 20 shoulder bag
can convert between a shoulder bag, tote bag or backpack.

Firstimpressions_Manfrotto’s rapidly-expanding bag range

contains some real gems. These latest additions are as stylish
as they are versatile.

transform your un-used
or un-wanted
photographic gear in
to hard cash.it’s quick,
easy and safe.
Subject to terms and conditions and item evaluation.

webuyanycamera.com

Wilkinson

Cameras
www.wilkinson.co.uk

FREE COLLECTION SERVICE
for equipment worth £500.00 or more
ASK FOR DETAILS.

www.digitalcameraworld.com
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Sensor
cleaners
Images littered with black spots?
It’s time to call in the cleaners...

Y

ou’d be forgiven for thinking that modern
cameras can keep dust at bay using their
integrated sensor cleaning systems. But
shoot in dusty environments or change lenses
frequently and it’s only a matter of time before
your sensor will need to be cleaned manually.
You’ll know when to break out the cleaning products
as images of clear blue skies or plain backdrops will
begin to feature unwelcome dark spots. But don’t
despair, as with a steady hand and the right cleaning
kit you can restore your sensor to its former glory.
DSLRs are slightly trickier to clean than mirrorless
cameras, as you’ll first need to lock the mirror up to
access the sensor. Then it’s just a matter of using a
blower, brush, or a sticky pad to remove loose dust,
while stubborn dirt can be dislodged using swabs.
Here are six cleaning options that are worth a look...

Five things to look out for
With these tips you’ll be able to banish
dust quickly, effectively and safely

Wet or dry?
Carefully using specially
designed swabs and solution
will remove most gunk from
your sensor, whilst a simple
air blower puffs dust away
for a quick clean.

The perfect view
A kit with a loupe and light
will really help you see where
exactly needs cleaning. Some
ingenious designs also allow
you to clean while the loupe
rests on the lens mount.

Planning ahead
A basic blower will never run
out of puff, but if you plump
for a wet cleaning kit, the

112

included swabs and solution
will only go so far. Make sure
that replacement supplies are
readily available and don’t
cost a fortune.

Fit for purpose
Camera sensors are delicate
devices, so only use swabs
and solution specifically
designed for cleaning
imaging sensors.

Less is more
Squeezy blowers may be safe
for a sensor, but don’t be
tempted to up the ante with
a compressed air canister.
Their high pressure and
freezing propellant can
cause serious damage.
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LensPen
SensorKlear
Loupe Kit

VisibleDust
Arctic Butterfly
724 Super Bright

www.lenspen.com

www.visibledust.com

LensPen proudly asserts that its
cleaning equipment is used by
NASA on the International
Space Station. This kit
includes a range of gadgets for
performing a dry sensor clean.
Identifying any dust is a cinch
thank to the SensorKlear Loupe
with LED illumination. Its focus is
adjustable to cover different
sensor sizes and it rests
securely on the lens mount.
There’s also a very useful
opening on the side so you can
clean with the loupe in place.
But while you get a great view,
cleaning performance is hardly
out of this world. The included
Hurricane Blower will dislodge
loose particles, but simply
blasting air like this can result
in dust being blown onto the
sensor. A better tactic is to use
the SensorKlear II cleaning pen.
Its hinged tip ensures a good
contact with the sensor, though
it doesn’t attract debris quite as
effectively as the SpeckGrabber
or Dust-Aid Platinum tools.

Here’s an electric brush
designed to attract dust
away from your sensor via
the wonders of static charge.
The brush’s ultra-fine bristles
are attached to a rotating shaft
driven by a pair of AAA batteries
in the handle. Ten seconds of
spinning prior to cleaning
ejects dust from the brush,
and, with the help of the fibres’
nano-coating, gives the bristles
a static charge. Then, with the
brush stationary again, you
lightly drag it across your sensor
to pick up any loose particles.
A pair of LEDs light the way.
This is important because
you don’t want the bristles to
come into contact with areas
surrounding the sensor, due
to the risk of debris or mirror
lubricant getting dragged
onto the sensor.
Loose dust is picked up pretty
well, but the brush doesn’t hold
on to particles as reliably as the
SpeckGrabber, making the high
price hard to justify.

Pros Decent loupe provides

Pros Easy and fun to use; fairly

Cons Blower isn’t that effective;

Cons Premium price, yet will

We say A reasonable kit for the
money, but you can do better

We say A novel concept, but

Overall score

Overall score

£50/ $60

a good view for cleaning

won’t remove oil or stains

£100/$100

effective for removing dust

only clean dry debris; no loupe

the high price is hard to justify

www.digitalcameraworld.com
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Dust-Aid
Platinum & DustWand Combo

Delkin
SensorScope
Travel Kit

Kinetronics
SpeckGrabber
Pro

VisibleDust
SwabLight
Kit

www.cameraclean.co.uk

www.delkindevices.com

www.cameraclean.co.uk

www.visibledust.com

£47.50/$70

£80/ $90

£7.50/ $7

£38/$40

The Dust-Aid Platinum slips
easily into a kit bag and has its
own compact travel case. It’s
a simple device consisting of
a wand with a silicone pad on
the end measuring roughly
10x15mm, plus six adhesive
cleaning strips. Press the pad
onto one of the cleaning strips to
remove any contaminants, then
dab your sensor to pick up loose
dirt. No residue is left, but you
can get a sticky outline if you
rock or twist the pad while it’s
in contact with the sensor.
For stickier stains, there’s the
Dust-Wand kit. This is a liquid
and swab combo, but unlike with
most kits, you make your own
swabs by wrapping a small cloth
around a plastic handle. This can
be a faff, but you do get 50 cloths,
and replacement packs don’t
cost a fortune. What’s more, the
bundled cleaning liquid doesn’t
leave streaks. But with no loupe
and all that folded cloth creating
a relatively bulky swab, it’s not
the easiest cleaning experience.

Delkin’s kit is equipped to
remove loose particles and
more stubborn contaminants.
The SensorBulb blower puffs
dust away, albeit in the same
uncontrolled manner as any
blower, meaning dust can just
be blown around the sensor,
not necessarily off it.
Should this happen, you can
always switch to the included
cleaning swabs and solution.
You get 15 double-ended wands
and a decent supply of streakfree fluid, but the results are
mixed. The wands have a
tendency to simply move some
particles across the sensor,
rather than picking them up.
An LED loupe is included and
shines brightly into the chamber,
but we found the sensor surface
to be slightly out of focus, and
there’s no focus adjustment. It
doesn’t have a cut-out, either,
so you can’t clean the sensor
with the loupe in place. A lens
cloth and compact travel bag
complete the kit.

Often the only dirt that ever
reaches your sensor are a few
specks of dust, making a full-on
wet clean overkill. For a quick
touch-up, the SpeckGrabber
is ideal. This is simply a plastic
stick with a small 2mm-square
soft pad on the end. It works like
the Dust-Aid Platinum, but
instead of pressing the pad
against a large portion of the
sensor, you dab precisely on
each particle to remove it. Two
cleaning wipes are included, so
you can ensure the grabber is
spotless before use, although
Kinetronics maintains it can be
cleaned with soap and water.
We weren’t expecting much
for a device so basic and cheap,
but the SpeckGrabber works
well. Particles stick effectively to
the cleaning tip, and it doesn’t
leave any residue on the sensor.
The SpeckGrabber provides
much better dust removal than
a similarly-priced blower, just
don’t expect it to deal with more
stubborn grime and stains.

There isn’t much to this kit; just
four swabs, a tiny 1.15ml phial
of cleaning liquid, and the
SwabLight. This tiny torch slots
onto a swab and shines down,
so wherever you clean, the light
follows. The SwabLight’s grippy
casing is much easier to hold
than a spindly swab handle. A
proper magnifying loupe would
give a better view, and though
VisibleDust sells a Quasar Plus
Sensor Loupe, this isn’t cheap.
You can spec the kit with one
of three formulations of cleaning
solution, designed to shift water
or oil-based stains, or a
combination. We went for the
multi-purpose fluid – VDust Plus
– applied to super-soft Orange
Vswabs that are available to suit
full-frame or APS-C sensors.
The result? A flawless clean with
no streaks, no stains, and no
dust left behind.
It’s a pity there are only
enough swabs and fluid for four
cleans, and a dozen extra swabs
will set you back about £35/$35.

Pros Compact, cost-effective

Pros Contains wet and dry

Pros Small and cheap; Great

Pros Unrivalled performance;

Cons Dust-Wands are a bit fiddly Cons None work particularly
to make and use; no loupe

well, and the kit isn’t cheap

Cons Not suitable for heavy-

duty cleaning; you’ll need a loupe

Cons High price per clean;
extras aren’t cheap; no loupe

We say Gives a comprehensive
clean at a fair price

We say Stacks up well on paper,
but misses the mark in practice

We say This handy tool performs
better than its price suggests

We say It’s not perfect, but a
stellar clean gives this kit the edge

Overall score

Overall score

Overall score

Overall score

and removes all types of dirt

www.digitalcameraworld.com

cleaning tools, plus a loupe

at removing individual particles

useful SwabLight illumination
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Super
Zooms

Supersize your zoom range
with a lens that’s geared up for
holidays and travel. Matthew
Richards reveals the best buys

H

aving a big DSLR kit with
plenty of lenses is great:
you can choose the right
tool to suit every photo
opportunity. Or is it? Nobody
really enjoys being weighed
down by a heavy camera bag
when they’re out and about.
Whether you’re exploring
city streets and landmarks,
trekking into the hills, or
journeying to the other side
of the world, there’s a lot to be
said for travelling light.
You can’t travel much lighter
than with a single lens fixed to
your camera, and that’s where

‘superzooms’ come in. They’re
designed to take you all the
way from wide-angle viewing
to long telephoto reach, as
well as covering everything
in between, with just a quick
twist of the zoom ring. The
advantages are three-fold:
firstly, you can cut down on the
size and weight of the kit you’re
carrying with you; secondly,
you can react instantly to
different shooting scenarios,
without the fear of missing
shots because you’re too busy
rummaging around in
your kit bag and swapping

The contenders
Tamron 18-200mm f/3.5-6.3 Di II VC

£190/$200

Sigma 18-200mm f/3.5-6.3 DC Macro OS HSM | C £290/$400
Tamron 18-270mm f/3.5-6.3 Di II VC PZD

£300/$450

Sigma 18-300mm f/3.5-6.3 DC Macro OS HSM | C £370/$500
Tamron 16-300mm f/3.5-6.3 Di II VC PZD Macro £430/$500
nikon AF-S DX 18-300mm f/3.5-6.3G ED VR

£630/$700

nikon AF-S DX 18-200mm f/3.5-5.6G ED VR II

£650/$650

nikon AF-S DX 18-300mm f/3.5-5.6G ED VR

£880/$995

Su

pe

rZ

oo

m

le

nS

eS

115

GeAr Zone T h e

big TesT

the lens on your camera; and
thirdly, you can avoid dust and
dirt drifting into your camera
body by not having to swap
lenses in dusty environments.
The downside, at least
historically, is that superzooms
have been somewhat notorious
for sacrificing image quality in
the pursuit of giving you greater
zoom range. Some examples
of the breed have also tended to
be quite big and heavy, so it can
actually be a pain to use them
all the time, instead of shooting
with a smaller standard zoom
and just switching to a telephoto
lens as and when you need to.
Over the past few years,
manufacturers have been
on a mission to improve the
performance and quality of
superzooms, while also reducing
their size and weight. Complex
aspherical elements are now

commonplace in competing
designs. FX (full-frame)
superzoom lenses still tend to
be fairly large and weighty, but
some of the latest DX (APS-C)
format superzooms are barely
any bigger or heftier than most
standard zoom lenses. It’s not
always the case though, as
demonstrated by the larger
of Nikon’s two 18-300mm
superzoom lenses.
One thing that always suffers
when trying to squeeze a
superzoom lens into a compact
build is the aperture rating.
It’s common, nowadays, for

the widest available aperture
to shrink to as little as f/6.3
towards the long end of the
zoom range. The upshot is that,
under anything other than
bright sunny lighting, you may
struggle to maintain fast shutter
speeds without bumping up
your camera’s ISO setting. It’s
no surprise, then, to discover
that all current superzooms
for Nikon DSLRs have built-in
optical image stabilization. This
enables you to get consistently
sharp images that are free from
the effects of camera-shake, at
shutter speeds of up to around

You can’t travel much lighter than with
a single lens fixed to your camera, and
that’s where ‘superzooms’ come in

four times slower than you
would otherwise need.
There’s more of a mix when
it comes to autofocus systems.
All of Nikon’s superzoom lenses
have ring-type ultrasonic
autofocus, which tends to offer
rapid performance. Handling is
also more refined, because the
focus ring remains stationery
during autofocus, so you can
concentrate on holding the
camera and lens in a natural,
comfortable position, rather
than having to keep your fingers
clear of the focus ring. Another
bonus is that full-time manual
focus override is also available.
These luxuries are unavailable
in the Sigma and Tamron lenses
on test, which use electric or
ultrasonic motor-driven systems,
although the Tamron 16300mm bucks the trend, as
you’ll see from our review.

What to look for...
Jargon buster

HeRe aRe a few tHings to
beaR in Mind wHen cHoosing
a supeRzooM

ring-Type
ulTrasonic
This type of autofocus
system relies on two large
electromagnetic rings built
into the barrel of the lens.

Wide-angle vieWing
All of the lenses on test offer an
18mm minimum focal length, which
is equivalent to 27mm, apart from
the Tamron 16-300mm lens,
which is equivalent to 24mm.

ulTrasonic moTor
Quiet, but not as near-silent as
ring-type ultrasonic systems,
these small motors require
drive shafts and gearwheels
to drive autofocus.

focus disTance scale
Most lenses on test have a focus
distance scale printed on the focus
ring or beneath a viewing panel, but
the Tamron 18-200mm and the
newer edition of the Nikon
18-300mm have none at all.
TelephoTo reach
The usual choice of maximum
telephoto focal length is either
200mm or 300mm – equivalent to
300mm or 450mm respectively, in
full-frame terms. The Tamron
18-270mm lens is the exception.
auTofocus sysTem
Ring-type ultrasonic autofocus is
the most refined option, although
electric or ultrasonic motor-driven
systems can help reduce the
size and weight of the lens.
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mounTing plaTe
Apart from the Tamron 18-200mm,
which has a plastic mounting plate,
all of the other lenses on test have
a metal mount.

WeaTher-seal ring
A weather-seal ring is fitted
to the mounting plates of all
three Nikon lenses, and to
the Tamron 18-200mm
and 16-300mm lenses.

www.digitalcameraworld.com
www.digitalcameraworld.com

Su
pe
rZ
oo
m
le
nS
eS

Tamron 18-200mm
f/3.5-6.3 Di ii VC £190/$200

Sigma 18-200mm f/3.5-6.3
DC Macro Os hsM | C £290/$400

This newest addition to
Tamron’s lineup is compact and
remarkably lightweight, at just
400g. Not only is it the lightest
lens in the group, but it’s also the
least expensive, by a big margin.
Part of the weight-saving
is due to the Tamron being
the only lens on test to feature
a plastic mounting plate, but it
nevertheless includes a weatherseal ring and construction feels
solid and durable. Compared
with the original Tamron
18-200mm, this new edition
is completely redesigned, and
adds the company’s proprietary
VC (Vibration Compensation)
optical stabilization and a new
‘DC motor-gear train integration’
autofocus system. The focus ring
still rotates during autofocus
and there’s no full-time manual
override, but it’s very much
quieter during operation.

This 18-200mm lens is the
smallest superzoom on test,
measuring a mere 71x86mm.
It’s also just 30g heavier than the
unfeasibly lightweight Tamron
18-200mm, despite featuring
a metal, rather than plastic,
mounting plate. However,
as with the larger Sigma
18-300mm C-class lens, the
mount has no weather-seal ring.
Multiple aspherical elements
help in downsizing the design,
while SLD (Special Low
Dispersion) elements boost
sharpness and contrast, and help
reduce fringing. Both Sigma
lenses use an ultrasonic motor
for autofocus. This helps keep
size and weight to a minimum,
but the focus ring rotates during
autofocus and there’s no manual
focus override. AF also isn’t quite
as whisper-quiet as with Nikon’s
ring-type systems.

sMall build, and a sMall pRice to pay

Performance
Throughout the albeit shorter
zoom range, sharpness is better
than from the older Tamron
18-270mm lens on test. The only
caveat is that corner-sharpness
was a little lacklustre when
shooting at 100mm using the
widest available aperture.

www.digitalcameraworld.com

Sharpness

Maintains consistent centre-sharpness
through its zoom range at wider apertures.

Fringing
Not too much fringing at ends of the zoom
range, and negligible in the mid sector.

Distortion

One of the better lenses for controlling
both barrel and pincushion distortions.

Verdict
Features
Build/handling
Performance
Valueformoney

Overall
For casual holiday shooting, it’s
unbeatable value at the price.

tHe Most tRavel-fRiendly sigMa supeRzooM

Performance
The optical stabilizer works well
and comes complete with auto
panning detection. Wideaperture sharpness isn’t quite
as good as from the less
expensive Tamron 18-200mm at
short to mid zoom settings, but
about equal at the long end.

Sharpness

At most zoom settings, you need to stop
down to f/8 for good levels of sharpness.

Fringing
Similar to the Tamron 18-200mm at long
and short zoom, but worse in the middle.

Distortion

Barrel distortion well controlled at 18mm,
but long-end pincushion is noticeable.

Verdict
Features
Build/handling
Performance
Valueformoney

Overall
It’s a neat little lens, but the Tamron
18-200mm offers better value.

August 2017
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Tamron 18-270mm f/3.5-6.3
Di ii VC PZD £300/$450

Sigma 18-300mm f/3.5-6.3
DC Macro Os hsM | C £370/$500

Representing an upgrade over
the original Tamron 18-270mm,
this revamped edition
nevertheless harks back to 2010,
making it one of the oldest
lenses on test. Even so, it sports
an impressive 15x zoom range
with an ‘effective’ focal length
of 405mm at the long end.
Improvements over the
previous incarnation include the
fitment of a PZD (Piezo Drive)
autofocus system. It’s essentially
an ultrasonic motor-based
system, similar to that used
in both Sigma lenses on test.
Despite its upsized zoom
range, this lens is actually
physically smaller than the
Tamron 18-200mm, although
it’s 50g heavier – mostly down
to it having a metal, rather than
plastic, mounting plate. It’s the
only Tamron on test that lacks
a weather-seal ring on its mount.

Measuring 79x102mm and
weighing 585g, this is one of
the bigger and heavier lenses
on test, but it’s still manageable
and feels well balanced, even
on lighter weight DSLR bodies.
It certainly goes large on zoom
range, with a telephoto reach
equivalent to 450mm in fullframe terms, although it can’t
match the Tamron 16-300mm
for ultra-wide viewing angles.
Very similar in look and feel
to the Sigma 18-200mm, it also
uses TSC (Thermally Stable
Composite) barrel sections,
made from a high-grade plastic
that’s resistant to expansion and
contraction during temperature
changes. While both lenses have
a 0.33x maximum magnification
rating, Sigma offers an optional
‘close-up lens’ for the 18300mm, which screws into
the filter attachment thread.

not tHe newest design, but boasts decent ReacH

Performance
Typical of the Tamron lenses on
test, the optical stabilizer is very
effective for static shots, but less
beneficial when panning. Wideaperture sharpness is pretty
poor at long zoom settings,
particularly towards the edges
and corners of the frame.
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Sharpness

Softness at long zoom settings between
200mm and 300mm is disappointing.

Fringing
Not bad at 18mm and good at mid-zoom
settings, but noticeable at the long end.

Distortion

The amounts of distortion through the
zoom range are pretty average.

Verdict
Features
Build/handling
Performance
Valueformoney

Overall
The lack of long-zoom sharpness
is something of a letdown.

tHis biggeR sigMa is a MoRe attRactive buy

Performance
Autofocus is a little pedestrian
and it would be nice if the
manual focus ring didn’t rotate
during AF. However, thanks to
the inclusion of top-grade FLD
(Fluorite Low Dispersion)
elements, this lens outguns the
Sigma 18-200mm for sharpness.

Sharpness

Sharpness only drops off in the
220-300mm sector of the zoom range.

Fringing
Well controlled at 18mm and even less
evident at mid to long zoom settings.

Distortion
Considering the extra-large zoom
range, distortions are relatively low.

Verdict
Features
Build/handling
Performance
Valueformoney

Overall
Zoom range and image quality are
impressive, but handling could be better.

www.digitalcameraworld.com
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Tamron 16-300mm f/3.5-6.3
Di ii VC PZD Macro £430/$500

nikon AF-s DX 18-300mm
f/3.5-6.3g eD VR £630/$700

This Tamron has a bigger zoom
range than any other lens
available for Nikon DSLRs, and
delivers a major bonus when it
comes to wide-angle shooting.
It’s the only superzoom that
shrinks to a 16mm rather than
18mm focal length – equivalent
to 24mm rather than 27mm on
a full-frame camera. It can
therefore shoehorn a lot more
of a scene into the image frame.
Unusually for an ultrasonic
motor-based autofocus system,
the focus ring remains
stationery during AF, and
also enables full-time manual
override. Handling is therefore
just as natural as with the Nikon
lenses, and the lens features a
focus distance scale positioned
beneath a viewing panel.

Heavy barrel distortion at 16mm is the
price for the extra-wide viewing angle.

When Nikon launched its first
18-300mm superzoom (also
on test), we criticised it for being
too big and heavy for use as a
travel lens. This newer edition
is narrower, shorter and slashes
nearly 300g off the weight,
making it much more
manageable. The downsizing
is partly down to clever design,
but there’s also a sacrifice in the
widest available aperture at long
zoom settings, which shrinks
from f/5.6 to f/6.3. That’s a third
of a stop ‘slower’ than in the
other Nikon lenses on test, but
no slower than the competing
Sigma and Tamron lenses.
The construction feels pretty
solid and a weather-seal ring is
retained on the mounting plate.
However, there’s no focus
distance scale and, unlike with
all the other lenses in the group,
the hood is sold separately.

Verdict

Performance

Verdict

Features
Build/handling
Performance
Valueformoney

Sharpness is good at wide angles
but tails off dramatically at
200mm, and is disappointing
towards the 300mm mark.
Other attributes of image quality
are uninspiring as well, making
this poor value at the price.

Features
Build/handling
Performance
Valueformoney

it Really puts tHe ‘supeR’ into supeRzooM

Performance
Compared with the Sigma
18-300mm, the Tamron is
slightly less sharp at 100mm,
but sharper at 200mm. Both
lenses deliver similar sharpness
at other focal lengths. The only
downside is that the Tamron
has worse colour fringing, but
this is automatically corrected
in recent Nikon DSLRs anyway.

www.digitalcameraworld.com

Sharpness

Good through most of the range, with
the usual drop-off at the telephoto end.

Fringing
Quite bad at both ends of the range, but
can be auto-corrected in recent DSLRs.

Distortion

Overall
All things considered, it’s the most
appealing superzoom for Nikon DSLRs.

nikon’s neweR 18-300MM is cut down to size

Sharpness

Long-zoom sharpness is lacklustre,
even at the centre of the image frame.

Fringing
Colour fringing is noticeably worse than
in the other two Nikon lenses on test.

Distortion

Barrel distortion is practically as bad as in
the wider-angle Tamron 16-300mm.

Overall
An underachiever compared with less
expensive Sigma and Tamron lenses.
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nikon AF-s DX 18-200mm
f/3.5-5.6g eD VR ii £650/$650

nikon AF-s DX 18-300mm
f/3.5-5.6g eD VR £880/$995

This is actually the Mk II edition
of Nikon’s 18-200mm VR lens.
However, both editions have the
same optical design and secondgeneration VR system, which
includes automatic panning
detection in Normal mode, plus
an additional ‘Active’ mode for
overcoming increased physical
vibrations. The most obvious
update is that the Mk II features
a zoom lock switch.
Build quality feels
reassuringly good and the
ring-type ultrasonic autofocus
system is typically quiet, and
also enables the usual full-time
manual override. Along with the
Tamron 16-300mm and other
Nikon lenses, the focus ring
remains fixed in place during
autofocus. Unlike the cheaper
Nikon 18-300mm f/3.5-6.3, this
has a focus distance scale and
comes complete with a hood.

A big bruiser of a lens, this
83x120mm superzoom is more
than twice the weight of the
Tamron 18-200mm, and feels a
mismatch for lightweight bodies
like the D3400 and D5600. It’s
heavily priced too, costing about
twice as much as the competing
Sigma 18-300mm and Tamron
16-300mm superzooms.
Predating the other Nikon
18-300mm lens, this has the
more usual configuration of VR
II stabilization, with a secondary
Active mode, as well as a focus
distance scale. Both lenses
feature three ED (Extra-low
Dispersion) elements in their
optical paths, but this one has
three additional elements in
total, and a better-rounded
aperture based on nine, rather
than seven, diaphragm blades.

tHe oRiginal and best nikon dX supeRzooM

Performance
Sharpness at 200mm is better
than from the smaller of the
two Nikon 18-300mm lenses,
but barrel distortion at 18mm is
equally poor. There’s less colour
fringing, autofocus performance
is faster, and the addition of
Active VR mode is a bonus.
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Sharpness

Beats the Nikon 18-300mm f/3.5-6.3 for
sharpness throughout its smaller range.

Fringing
Taking the zoom range into account, it’s
the best Nikon at controlling fringing.

Distortion

Heavy barrel distortion at 18mm is as bad
as from the newer Nikon 18-300mm lens.

Verdict
Features
Build/handling
Performance
Valueformoney

Overall
Overall, this is Nikon’s most desirable
superzoom, but it’s not great value.

it’s oveRweigHt in eveRy way

Performance
Along with faster AF and better
stabilization when shooting
from a vibrating platform, this
lens retains better sharpness
than Nikon’s newer 18-300mm
lens at zoom settings of 100mm
and above. The flip side is that
it’s not so sharp for wide-angle
shooting, although distortion at
18mm is slightly less noticeable.

Sharpness

Sharpness isn’t great at 18mm, but
pretty good at mid to long zoom settings.

Fringing
Unusually, colour fringing is worse at
mid-zoom settings than at either end.

Distortion
Least wide-angle distortion of the Nikons,
but greater long-zoom pincushion.

Verdict
Features
Build/handling
Performance
Valueformoney

Overall
Big in price as well as size and weight,
it’s not ideal as a travel lens.
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Comparison
table
Tamron
18-200mm f/3.5-6.3
Di ii VC

Sigma 18-200mm
f/3.5-6.3 DC Macro
OS HSM | C

Tamron 18-270mm
f/3.5-6.3 Di ii VC
PZD

Sigma 18-300mm
f/3.5-6.3 DC Macro
OS HSM | C

Tamron
16-300mm f/3.5-6.3
Di ii VC PZD Macro

www.tamron.com

www.sigma-global.com

www.tamron.com

www.sigma-global.com

www.tamron.com

nikon AF-S DX
18-300mm
f/3.5-6.3G ED VR

nikon AF-S DX
18-200mm
f/3.5-5.6G ED VR ii

nikon AF-S DX
18-300mm
f/3.5-5.6G ED VR

www.nikon.com

Street price (UK, USA)

£190/$200

£290/$400

£300/$450

£370/$500

£430/$500

£630/$700

£650/$650

£880/$995

Effective zoom range (DX)

27-300mm

27-300mm

27-405mm

27-450mm

24-450mm

27-450mm

27-300mm

27-450mm

16/14

16/13

16/13

17/13

16/12

16/12

16/12

19/14

Plastic, weather-sealed

Metal

Metal

Metal

Metal, weather-sealed

Metal, weather-sealed

Metal, weather-sealed

Metal, weather-sealed

7 blades

7 blades

7 blades

7 blades

7 blades

7 blades

7 blades

9 blades

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Electric (motor)

Ultrasonic (motor)

Ultrasonic (motor)

Ultrasonic (motor)

Ultrasonic (motor)

Ultrasonic (ring type)

Ultrasonic (ring type)

Ultrasonic (ring type)

Rotates

Rotates

Rotates

Rotates

Stationary

Stationary

Stationary

Stationary

Fixed

Fixed

Fixed

Fixed

Fixed

Fixed

Fixed

Fixed

0.49-0.77m

0.39m

0.49m

0.39m

0.39m

0.48m

0.5m

0.45m

Max reproduction ratio

0.25x

0.33x

0.26x

0.33x

0.34x

0.32x

0.22x

0.31x

Filter size

62mm

62mm

62mm

72mm

67mm

67mm

72mm

77mm

Hood

Hood

Hood

Hood

Hood

None

Hood, pouch

Hood, pouch

75x97mm

71x86mm

74x88mm

79x102mm

75x100mm

79x99mm

77x97mm

83x120mm

400g

430g

450g

585g

540g

550g

565g

830g

Elements/groups
Mounting plate
Diaphragm
Optical stabiliser
Focus type
Focus ring during AF
Front element in focusing
Min focus distance

Included accessories
Dimensions (dia x length)
Weight
FEAtURES
BUilD/HANDliNG
PERFORMANCE
VAlUE FOR MONEY
OVERAll

The winner is...

Runners-up

Tamron 16-300mm
f/3.5-6.3 Di ii VC PZD
Macro £430/$500

Sigma 18-300mm f/3.5-6.3 DC
Macro Os hsM | C £370/$500
What’s good: Big zoom range, good
image quality, impressive build quality.
What’s bad: Focus ring rotates during
autofocus, a bit on the heavy side.
Our verdict: Outperforms the Tamron
16-300mm in some respects.

What’s good: Class-leading zoom range, extra
wide-angle perspective, refined handling.
What’s bad: Not especially sharp at some focal
lengths, noticeable distortions and fringing.
Our verdict: It’s the best buy for outright zoom
range with little sacrifice in image quality.

With its reasonably compact and
lightweight yet splash-proof construction,
refined handling and class-leading zoom
range, the Tamron 16-300mm is a very
attractive buy at a competitive price. It
also gives you a wider viewing angle than
any other Nikon-compatible superzoom
lens on the market. Colour fringing is a bit
on the high side, but all Nikon DSLRs from
the D3 and D300 onwards (apart from the
D60 and D3000) automatically correct

www.digitalcameraworld.com

nikon AF-s DX 18-200mm f/3.55.6g eD VR ii £650/$650
this if you shoot in JPEG, or process
your Raw images in Nikon software.
Our second-favourite is the Sigma
18-300mm, which is slightly sharper
up to focal lengths of 145mm, a bit softer
at 200mm, and about equal at 300mm.
The Tamron 18-200mm is unbeatable
value, delivering good performance at a
great price. Of the three Nikon lenses on
test, the 18-200mm VR is the winner,
despite being relatively short on reach.

What’s good: High-spec autofocus and
VR, good overall performance.
What’s bad: Limited zoom range next
to more recently launched superzooms.
Our verdict: It’s a nice lens, but offers
relatively poor value compared with
Sigma and Tamron competitors.

NeXT issUe
Travel Tripods
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Next moNth
on sale
thursday
03 August
2017

Summer
landscapes
Read our ultimate step-by-step
guide to getting more creative
with your Nikon this summer
www.digitalcameraworld.com

A BUG’s LIFE
Nature ace Ross Hoddinott takes us
on a macro photography masterclass
LynsEy AddArIo
Meet the photographer so good Steven
Spielberg is making a movie about her
HAVE TrIPod, WILL TrAVEL
We put eight lightweight and compact
travel tripods through their paces
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Buyer’s guide
Nikon cameras

Not sure which Nikon body will be the one for you? Here’s a rundown of the current range*
TesTed In IssUe 47 PrIce: £370/$500

NikoN 1 J5
A CSC thAt DSLR uSeRS wiLL Love, the J5 has
the highest resolution of any Nikon 1 camera to
date (20.8Mp) and a decent sensitivity range. The
top dial also gives access to semi-automatic and
manual exposure modes, plus you can shoot in
Raw, which is real bonus.

sensor

EXPEED 5A

Viewfinder

N/A

IsO
AF
Lcd
Max burst
Memory card

NikoN 1 CoMPACT SYSTEM CAMERAS

* Current market prices (for body + a kit lens) are checked regularly with reputable stores to serve as a guideline. Different lens bundles are available. Prices correct at time of going to press.

200-12800
171 area-contrast (105 area-phase)
3-inch tilting touchscreen
60fps
microSD/HC/XC

PrIce: APPrOx. £300/$350 (no longer on sale)

NikoN 1 S2
SmALL in Size but big on quALity, the svelte
Nikon 1 S2 is responsive and speedy. With a
14.2Mp image sensor, and the omission of built-in
Wi-Fi or a touchscreen, it’s more basic than the
J5, but still a highly capable camera that you can
slip into your bag as a lightweight backup.

sensor

14.2Mp, CX (4592x3072)

Processor

EXPEED 4A

Viewfinder

N/A

IsO
AF
Lcd
Max burst
Memory card

200-12800
135 area-contrast (73 area-phase)
3-inch
20fps (60fps fixed AF)
microSD/HC/XC

TesTed In IssUe 46 PrIce: £600/$800

NikoN 1 AW1
veRy muCh the ACtion ADventuReR, the
Nikon 1 AW1 is shockproof, waterproof to a depth
of 15 metres, and even freeze-proof down to
-10°C. To keep pace with a truly active lifestyle,
it also has a built-in compass, altimeter, depth
gauge and GPS.

sensor

Sensor 14.2Mp, CX (4608x3072)

Processor

EXPEED 3A

Viewfinder

N/A

IsO
AF
Lcd
Max burst
Memory card

160-6400
135 area-contrast (73 area-phase)
3-inch
15fps (60fps fixed AF)
SD/HC/XC

TesTed In IssUe 46 PrIce: £800/$1200

NikoN 1 V3
the fLAgShip nikon 1 CAmeRA adds a
vari-angle touchscreen to the comfortable
ergonomics of the preceding V2, along with key
upgrades to the image sensor, processor and
autofocus system. It also includes built-in Wi-Fi.
An electronic viewfinder is optional.

sensor

18.4Mp, CX (5232x3488)

Processor

EXPEED 4A

Viewfinder

Electronic

IsO
AF
Lcd
Max burst
Memory card

160-12800
171 area-contrast (105 area-phase)
3-inch vari-angle touchscreen
20fps (60fps fixed AF)
SD/HC/XC

TesTed In IssUe 53 PrIce: £300/$400

NikoN D3200

ENTRY-LEVEL DSLRS

An inStAnt fAvouRite with beginneRS when
launched back in 2012, the D3200 eases you into
creative photography with a built-in Guide mode
that serves up interactive tutorials. This is backed
up by impressive image quality, thanks to its
24.2Mp image sensor and EXPEED 3 processor.

sensor

24.2Mp, DX (6016x4000)

Processor

EXPEED 3

Viewfinder

Pentamirror, 0.8x, 95%

IsO
AF
Lcd
Max burst (buffer)
Memory card

100-6400 (12800 expanded)
11-point (1 cross-type)
3-inch
4fps (18 Raw/80 JPEG)
SD/HC/XC

TesTed In IssUe 53 PrIce: £320/$450

NikoN D3300
the D3300 boAStS A beginneR-fRienDLy
guiDe moDe too, but boosts performance with
a current-generation EXPEED 4 processor, faster
continuous shooting and greater low-light potential
than the D3200. There’s also a user-friendly Effects
shooting mode and handy ‘easy panorama’ mode.

sensor
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24.2Mp, DX (6000x4000)

Processor

EXPEED 4

Viewfinder

Pentamirror, 0.85x, 95%

IsO
AF
Lcd
Max burst (buffer)
Memory card
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20.8Mp, CX (5232x3488)

Processor

100-12800 (25600 expanded)
11-point (1 cross-type)
3-inch, 70-degree viewing angle
5fps (11 Raw/100 JPEG)
SD/HC/XC
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NikoN CAmerAs

TesTed In IssUe 65 PrIce: £400/$500

NikoN D3400
the D3400 mAkeS Room foR new feAtuReS
by DowngRADing otheRS, offering a relatively
minor upgrade to the D3300 that includes
wireless connectivity. While it’s perfectly capable,
the great price of the D3300 means that one is
still our preferred entry-level Nikon DSLR.

sensor

EXPEED 4

Viewfinder

Pentamirror, 0.85x, 95%

IsO
AF
Lcd
Max burst (buffer)
Memory card

100-25600
11-point (1 cross-type)
3-inch, 170-degree viewing angle
5fps (11 Raw/100 JPEG)
SD/SDHC/SDXC

TesTed In IssUe 53 PrIce: £460/$700

NikoN D5300

ENTRY-LEVEL DSLRS

An AffoRDAbLe inteRmeDiAte-LeveL CAmeRA,
this body features a new generation processor,
plus built-in Wi-Fi and GPS, all wrapped up in
a tough carbon-fibre-reinforced shell. Plus the
optical low-pass filter is omitted to maximize the
potential to capture image sharpness.

sensor

24.2Mp, DX (6000x4000)

Processor

EXPEED 4

Viewfinder

Pentamirror, 0.82x, 95%

IsO
AF
Lcd
Max burst (buffer)
Memory card

100-12800 (25600 expanded)
39-point (9 cross-type)
3.2-inch vari-angle
5fps (13 Raw/100 JPEG)
SD/HC/XC

TesTed In IssUe 61 PrIce: £650/$700

NikoN D5500
the SAme pixeL Count AnD pRoCeSSoR AS
the pReCeDing D5300, built into the same style
of monocoque (one-piece) body shell. The most
notable upgrade in the newer D5500 is that its
vari-angle LCD is a touchscreen. However, it loses
the D5300’s built-in GPS.

sensor

24.2Mp, DX (6000x4000)

Processor

EXPEED 4

Viewfinder

Pentamirror, 0.82x, 95%

IsO
AF
Lcd
Max burst (buffer)
Memory card

100-12800 (25600 expanded)
39-point (9 cross-type)
3.2-inch vari-angle touchscreen
5fps (13 Raw/100 JPEG)
SD/HC/XC

TesTed In IssUe 68 PrIce: £730/$800

NikoN D5600
nikon’S LAteSt Dx-foRmAt CAmeRA ADDS
SnApbRiDge image-transfer tech to the same
sensor and processor as the D5500. It features
a built-in sensor-cleaning system and powerful
pop-up flash, plus a neat Time Lapse Movie mode
previously only found in more advanced DSLRs.

sensor

24.2Mp, DX (6000x4000)

Processor

EXPEED 4

Viewfinder

Pentamirror, 0.82x, 95%

IsO
AF
Lcd
Max burst (buffer)
Memory card

100-25600
39-point (9 cross-type)
3.2-inch vari-angle touchscreen
5fps
SD/SDHC/SDXC

TesTed In IssUe 19 PrIce: £900/$1000

NikoN D7100

ENTHUSiAST DSLRS

the D7100 getS A notAbLe hike in pixeL
Count compared with the preceding D7000,
along with the removal of the optical low-pass
filter to maximize sharpness. Its autofocus
system gets a boost too, and a 1.3x crop facility
increases the maximum drive rate to 7fps.

sensor

24.1Mp, DX (6000x4000)

Processor

EXPEED 3

Viewfinder

Pentaprism, 0.94x, 100%

IsO
AF
Lcd
Max burst (buffer)
Memory card

100-6400 (25600 expanded)
51-point (15 cross-type)
3.2-inch
6fps, 7fps crop (6-9 Raw/33 JPEG)
2x SD/HC/XC

TesTed In IssUe 61 PrIce: £1000/$1300

NikoN D7200
buiLDing on the D7100’S SpeCifiCAtionS,
the D7200 boasts better low-light autofocus,
a bigger memory buffer, an updated processor,
built-in Wi-Fi and NFC connectivity, plus trick
modes for doing light-trail photography and
making time-lapse movies in-camera.

sensor

24.2Mp, DX (6000x4000)

Processor

EXPEED 4

Viewfinder

Pentaprism, 0.94x, 100%

IsO
AF
Lcd
Max burst (buffer)
Memory card

100-25600 (102400 expanded, mono only)
51-point (15 cross-type)
3.2-inch
6fps, 7fps crop (18-27 Raw/100 JPEG)
2x SD/HC/XC

TesTed In IssUe 61 PrIce: £1700/$2000

NikoN D610

SEMi-PRo DSLRS

fuLL-fRAme photogRAphy StARtS heRe,
with the most affordable of Nikon’s FX cameras.
It’s no slouch, with a 6fps maximum drive rate
and a quiet (but slower) continuous drive option.
It also features a weather-sealed body and,
compared with the D600, a revised shutter unit.

sensor

24.3Mp, FX (6016x4016)

Processor

EXPEED 3

Viewfinder

Pentaprism, 0.7x, 100%

IsO
AF
Lcd
Max burst (buffer)
Memory card
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24.2Mp, DX (6000x4000)

Processor

100-6400 (50-25600 expanded)
39-point (9 cross-type)
3.2-inch
6fps (14-26 Raw/51 JPEG)
2x SD/HC/XC
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TesTed In IssUe 61 PrIce: £2100/$2400

NikoN D750
the D750 iS eASiLy mAnAgeAbLe foR A
Semi-pRo fuLL-fRAme boDy. A reasonably
priced addition to the lineup, it includes a tilting
LCD screen and built-in Wi-Fi. The pixel count
strikes a happy balance between the 16.2Mp
Df/D4s and the 36.3Mp D810.

sensor

EXPEED 4

Viewfinder

Pentaprism, 0.7x, 100%

IsO
AF
Lcd
Max burst (buffer)
Memory card

100-12800 (50-51200 expanded)
51-point (15 cross-type)
3.2-inch tilt
6.5fps (15-33 Raw/87 JPEG)

2x SD/HC/XC

TesTed In IssUe 61 PrIce: £2480/$2600

NikoN D500

SEMi-PRo DSLRS

nikon’S Semi-pRo Dx-foRmAt DSLR is in many
respects a dream camera. It boasts a blazingly fast,
effective AF system and 10fps continuous shooting
with a huge 200-shot Raw buffer, plus first-rate
metering and white balance. For the money, it might
just be Nikon’s best DX DSLR yet.

sensor
Processor
Viewfinder
IsO
AF

20.9Mp, DX (5568x3712)
EXPEED 5
Pentaprism, 1x, 100%
100-51200 (50-1640000 expanded)
153-point (99 cross-type, 15 sensitive to f/8)

Lcd

3.2-inch tilting touchscreen

Max burst (buffer)

10fps (200 Raw/200 JPEG)

Memory card

1x XQD, 1x SD/HC/XC

TesTed In IssUe 54 PrIce: £2400/$3000

NikoN Df
iConiC DeSign meetS high-teCh exCeLLenCe
in thiS RetRo beAuty. The Df is amazingly
compact for a full-frame body, but direct-access
dials and buttons ensure that shooting controls
are always within easy reach. The lack of a video
shooting capability is a surprise omission, though.

sensor

16.2Mp, FX (4928x3280)

Processor

EXPEED 3

Viewfinder

Pentaprism, 0.7x, 100%

IsO
AF
Lcd
Max burst (buffer)
Memory card

100-12800 (50-204800 expanded)
39-point (9 cross-type)
3.2-inch
5.5fps (25-47 Raw/100 JPEG)
SD/HC/XC

TesTed In IssUe 11 PrIce: £2250/$3300 (no longer on sale)

NikoN D800e
A SpeCiAL eDition of the oRiginAL D800,
this one has a modified optical low-pass filter
that omits an anti-aliasing feature. It’s therefore
better able to capture extraordinary levels of fine
detail, maximising the potential of its ultra-highresolution image sensor.

sensor

36.3Mp, FX (7360x4912)

Processor

EXPEED 3

Viewfinder

Pentaprism, 0.7x, 100%

IsO
AF
Lcd
Max burst (buffer)
Memory card

100-6400 (50-25600 expanded)
51-point (15 cross-type)
3.2-inch
4fps, 5fps DX crop (16-25 Raw/56 JPEG)
1xCF, 1x SD/HC/XC

TesTed In IssUe 54 PrIce: £2400/$2800 (body only)

NikoN D810

PRo DSLRS

the king of the ReSoLution StAkeS, the
D810 boasts 36.3 million pixels and, unlike the
older D800e, has no optical low-pass filter. It has
a later-generation processor and an extended
sensitivity range. A special astrophotography
edition, D810a, is also available (£2700/$3800).

sensor

36.3Mp, FX (7360x4912)

Processor

EXPEED 4

Viewfinder

Pentaprism, 0.7x, 100%

IsO
AF
Lcd
Max burst (buffer)
Memory card

64-12800 (32-51200 expanded)
51-point (15 cross-type)
3.2-inch
5fps, 7fps DX crop (18-58 Raw/100 JPEG)
1xCF, 1x SD/HC/XC

TesTed In IssUe 54 PrIce: £4100/$6000 (no longer on sale)

NikoN D4s
the D4s DeLiveRS 11fpS Shooting, and
image quality is immaculate, even at ultra-high
ISO settings, making it popular with professional
sport and wildlife photographers for years. But it
has been superseded by Nikon’s newer, higherspecced flagship DSLR, the D5.

sensor

16.2Mp, FX (4928x3280)

Processor

EXPEED 4

Viewfinder

Pentaprism, 0.7x, 100%

IsO
AF
Lcd
Max burst (buffer)
Memory card

100-25600 (50-409600 expanded)
51-point (15 cross-type)
3.2-inch
11fps (36-176 Raw/200 JPEG)
1x CF, 1x XQD

TesTed In IssUe 59 PrIce: £5100/$6500 (body only)

NikoN D5
CApAbLe of Shooting 12 fRAmeS peR
SeConD, and with a buffer capacity of 200 Raw
files, Nikon’s flagship DSLR also boasts 153 AF
points – three times more than the D4s. The pixel
count has also gone up, to 20.8Mp, as has the
maximum ISO, to a staggering 3.3 million.

sensor

August 2017

20.8Mp, FX (5568x3712)

Processor

EXPEED 5

Viewfinder

Pentaprism, 0.72x, 100%

IsO
AF
Lcd
Max burst (buffer)
Memory card

126

24.3Mp, FX (6016x4016)

Processor

100-102400 (50-3280000 expanded)
153-point (99 cross-type, 15 sensitive to f/8)
3.2-inch touchscreen
12fps (200 Raw/200 JPEG)
2x XQD (version with 2x CF also available)

www.digitalcameraworld.com

Buyer’s guide
Nikon-fit lenses
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DX

2.4x

No

Ultrasonic

f/3.5-4.5

460g

0.22m

0.2x

77mm

7

62

£980/$1150

DX

2.0x

No

Ultrasonic

f/4

465g

0.3m

0.12x

77mm

7

32

Nikon AF-S 14-24mm f/2.8G ED

£1620/$1900

FX

1.7x

No

Ultrasonic

f/2.8

970g

0.28m

0.15x

None

9

62

Nikon AF-S 16-35mm f/4G ED VR

£1020/$1100

FX

2.2x

Yes

Ultrasonic

f/4

685g

0.28m

0.25x

77mm

9

62

Nikon AF-S 17-35mm f/2.8D IF-ED

£1340/$1950

FX

2.1x

No

Ultrasonic

f/2.8

745g

0.28m

0.22x

77mm

9

Nikon AF-S 18-35mm f/3.5-4.5G ED

£550/$750

FX

1.9x

No

Ultrasonic

f/3.5-4.5

385g

0.28m

0.2x

77mm

7

62

Sigma 8-16mm f/4.5-5.6 DC HSM

£500/$700

DX

2.0x

No

Ultrasonic

f/4.5-5.6

555g

0.24m

0.13x

None

7

47

Sigma 10-20mm f/3.5 EX DC HSM

£330/$450

DX

2.0x

No

Ultrasonic

f/3.5

520g

0.24m

0.15x

82mm

7

62

Sigma 12-24mm f/4.5-5.6 II DG HSM

£530/$950

FX

2.0x

No

Ultrasonic

f/4.5-5.6

670g

0.28m

0.16x

None

6

62

Sigma 12-24mm f/4 DG HSM | A

£1650/$1600

FX

2.0x

No

Ultrasonic

f/4

1151g

0.24m

0.2x

None

9

Sigma 24-35mm f/2 DG HSM | A

£700/$900

FX

1.5x

No

Ultrasonic

f/2

940g

0.28m

0.23x

82mm

9

Tamron SP AF 10-24mm f/3.5-4.5 Di II LD

£410/$500

DX

2.4x

No

Electric

f/3.5-4.5

406g

0.24m

0.2x

77mm

7

62

Tamron SP 15-30mm f/2.8 Di VC USD

£930/$1200

FX

2.0x

Yes

Ultrasonic

f/2.8

1100g

0.28m

0.2x

None

9

62

Tokina 10-17mm f/3.5-4.5 AT-X DX Fisheye

£430/$480

DX

1.7x

No

Electric

f/3.5-4.5

350g

0.14m

0.39x

None

6

Tokina 11-16mm f/2.8 AT-X PRO DX II

£480/$530

DX

1.5x

No

Electric

f/2.8

550g

0.3m

0.09x

77mm

9

32

Tokina 12-28mm f/4 AT-X Pro DX

£450/$450

DX

2.3x

No

Electric

f/4

530g

0.25m

0.2x

77mm

9

32

Tokina 16-28mm f/2.8 AT-X PRO FX

£580/$690

FX

1.8x

No

Electric

f/2.8

950g

0.28m

0.19x

None

9

33

Nikon AF-S DX 16-80mm f/2.8-4E ED VR

£890/$1070

DX

5x

Yes

Ultrasonic

f/2.8-4

480g

0.35m

0.22x

72mm

7

73

Nikon AF-S DX 16-85mm f/3.5-5.6G ED VR

£570/$700

DX

5.3x

Yes

Ultrasonic

f/3.5-5.6

485g

0.38m

0.22x

67mm

7

56

Nikon AF-S DX 17-55mm f/2.8G IF-ED

£1315/$1500

DX

3.2x

No

Ultrasonic

f/2.8

755g

0.36m

0.2x

77mm

9

59

Nikon AF-P DX 18-55mm f/3.5–5.6G VR

£200/$250

DX

3.1x

Yes

Stepping

f/3.5-5.6

205g

0.25m

0.38x

55mm

7

60

Nikon AF-S DX 18-55mm f/3.5–5.6G VR II

£200/$250

DX

3.1x

Yes

Ultrasonic

f/3.5-5.6

195g

0.28m

0.31x

52mm

7

56

Nikon AF-S DX 18-105mm f/3.5-5.6G ED VR

£220/$395

DX

5.8x

Yes

Ultrasonic

f/3.5-5.6

420g

0.45m

0.2x

67mm

7

56

Nikon AF-S 24-70mm f/2.8G ED

£1600/$1800

FX

2.9x

No

Ultrasonic

f/2.8

900g

0.38m

0.27x

77mm

9

57

Nikon AF-S 24-70mm f/2.8E ED VR

£2000/$2400 FX

2.9x

Yes

Ultrasonic

f/2.8

1070g

0.38m

0.27x

82mm

9

73

Nikon AF-S 24-85mm f/3.5-4.5G ED VR

£430/$500

FX

3.5x

Yes

Ultrasonic

f/3.5-4.5

465g

0.38m

0.22x

72mm

7

57

Nikon AF-S 24-120mm f/4G ED VR

£1000/$1100

FX

5.0x

Yes

Ultrasonic

f/4

710g

0.45x

0.24x

77mm

9

73

Sigma 17-50mm f/2.8 EX DC OS HSM

£330/$370

DX

2.9x

Yes

Ultrasonic

f/2.8

565g

0.28m

0.2x

77mm

7

73

Sigma 17-70mm f/2.8-4 DC Macro OS HSM | C

£350/$500

DX

4.1x

Yes

Ultrasonic

f/2.8-4

465g

0.22m

0.36x

72mm

7

73

Sigma 18-35mm f/1.8 DC HSM | A

£550/$800

DX

1.9x

No

Ultrasonic

f/1.8

810g

0.28m

0.23x

72mm

9

Sigma 24-70mm f/2.8 IF EX DG HSM

£530/$750

FX

2.9x

No

Ultrasonic

f/2.8

790g

0.38m

0.19x

82mm

9

57

Sigma 24-105mm f/4 DG OS HSM | A

£600/$900

FX

4.4x

Yes

Ultrasonic

f/4

885g

0.45m

0.22x

82mm

9

73

Tamron SP AF 17-50mm f/2.8 XR Di II VC

£380/$650

DX

2.9x

Yes

Electric

f/2.8

570g

0.29m

0.21x

72mm

7

73

Tamron SP AF 24-70mm f/2.8 Di VC USD

£800/$1300

FX

2.9x

Yes

Ultrasonic

f/2.8

825g

0.38m

0.2x

82mm

9

73

Nikon AF-S DX 55-200mm f/4-5.6G ED VR II

£240/$350

DX

3.6x

Yes

Ultrasonic

f/4-5.6

300g

1.1m

0.23x

52mm

7

60

Nikon AF-S DX 55-300mm f/4.5-5.6G ED VR

£305/$400

DX

5.5x

Yes

Ultrasonic

f/4.5-5.6

530g

1.4m

0.22x

58mm

9

60

Nikon AF-S 70-200mm f/4G ED VR

£1250/$1400

FX

2.9x

Yes

Ultrasonic

f/4

850g

1.0m

0.27x

67mm

9

72

Nikon AF-S 70-200mm f/2.8G ED VR II

£2000/$2100

FX

2.9x

Yes

Ultrasonic

f/2.8

1540g

1.4m

0.12x

77mm

9

72

Nikon AF-S 70-200mm f/2.8E FL ED VR

£2650/$2800 FX

2.9x

Yes

Ultrasonic

f/2.8

1430g

1.1m

0.21x

77mm

9

72

Nikon AF-P DX 70-300mm f/4.5-6.3G

£300/$350

DX

4.3x

No

Stepping

f/4.5-6.3

400g

1.1m

0.22x

58mm

7

Nikon AF-P DX 70-300mm f/4.5-6.3G VR

£350/$400

DX

4.3x

Yes

Stepping

f/4.5-6.3

415g

1.1m

0.22x

58mm

7

Nikon AF-S 70-300mm f/4.5-5.6G IF-ED VR

£500/$500

FX

4.3x

Yes

Ultrasonic

f/4.5-5.6

745g

1.5m

0.25x

67mm

9

45

Nikon AF-S 80-400mm f/4.5-5.6G ED VR

£2100/$2300

FX

5.0x

Yes

Ultrasonic

f/4.5-5.6

1570g

1.5m

0.2x

77mmdrop-in 9

63

Nikon AF-S 200-400mm f/4G ED VR II

£6000/$7000 FX

2.0x

Yes

Ultrasonic

f/4

3360g

1.95m

0.27x

52mm

9

45

Nikon AF-S 200-500mm f/5.6E ED VR

£1180/$1400

FX

2.5x

Yes

Ultrasonic

f/5.6

2300g

2.2m

0.22x

95mm

9

63

Sigma 50-100mm f/1.8 DC HSM | A

£950/$1100

DX

2.0x

No

Ultrasonic

f/1.8

1490g

0.95m

0.15x

82mm

9

72

Sigma 50-500mm f/4.5-6.3 DG OS HSM

£850/$1660

FX

10.0x

Yes

Ultrasonic

f/4.5-6.3

1970g

0.5-1.8m 0.32x

95mm

9

45

Sigma 70-200mm f/2.8 EX DG OS HSM

£900/$1300

FX

2.9x

Yes

Ultrasonic

f/2.8

1430g

1.4m

77mm

9
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£730/$900

Nikon AF-S DX 12-24mm f/4G IF-ED

wide-aNgle zooms

rd

St

Nikon AF-S DX 10-24mm f/3.5-4.5G ED

KEY: ■ GREAT VALUE ■ BEST ON TEST AWARD ■ GOLD AWARD
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Vital statistics – find the right lens at the right price point *
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telepHoto zooms

telepHoto zooms

* Current market prices are checked regularly with reputable stores to serve as a guideline. Prices correct at time of going to press.

staNdard zooms
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Ra

4.3x

No

Electric

f/4-5.6

545g

0.95m

0.5x

58mm

9

35

FX

4.3x

No

Electric

f/4-5.6

550g

0.95m

0.5x

58mm

9

35

Sigma 120-300mm f/2.8 DG OS HSM | S

£2700/$3600 FX

2.5x

Yes

Ultrasonic

f/2.8

3390g

1.5-2.5m 0.12x

105mm

9

72

Sigma 150-600mm f/5-6.3 DG OS HSM | C

£740/$990

FX

4.0x

Yes

Ultrasonic

f/5-6.3

1930g

2.8m

0.2x

95mm

9

63

Sigma 150-600mm f/5-6.3 DG OS HSM | S

£1200/$2000

FX

4.0x

Yes

Ultrasonic

f/5-6.3

2860g

2.6m

0.2x

105mm

9

63

Sigma 300-800mm f/5.6 EX DG HSM

£5500/$6800 FX

2.7x

No

Ultrasonic

f/5.6

5880g

6.0m

0.14x

46mm drop-in 9

45

Tamron SP AF 70-200mm f/2.8 Di LD [IF] Macro

£630/$7700

FX

2.9x

No

Ultrasonic

f/2.8

1320g

0.95m

0.32x

77mm

9

72

Tamron SP AF 70-200mm f/2.8 Di VC USD

£1100/$1100

FX

2.9x

Yes

Ultrasonic

f/2.8

1470g

1.3m

0.13x

77mm

9

72

Tamron AF 70-300mm f/4-5.6 Di LD Macro

£130/$150

FX

4.3x

No

Electric

f/4-5.6

458g

0.95m

0.5x

62mm

9

35

Tamron SP AF 70-300mm f/4-5.6 Di VC USD

£300/$450

FX

4.3x

Yes

Ultrasonic

f/4-5.6

765g

1.5m

0.25x

62mm

9

35

Tamron SP 150-600mm f/5-6.3 Di VC USD

£830/$1000

FX

4.0x

Yes

Ultrasonic

f/5-6.3

1951g

2.7m

0.2x

95mm

9

63
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Tamron SP 150-600mm f/5-6.3 Di VC USD G2

£1350/$1400

FX

4.0x

Yes

Ultrasonic

f/5-6.3

2010g

2.2m

0.26x

95mm

9

Nikon AF-S DX 18-140mm f/3.5-5.6G ED VR

£470/$500

DX

7.8x

Yes

Ultrasonic

f/3.5-5.6

490g

0.45m

0.23x

67mm

7

27

Nikon AF-S DX 18-200mm f/3.5-5.6G ED VR II

£625/$650

DX

11.1x

Yes

Ultrasonic

f/3.5-5.6

565g

0.5m

0.22x

72mm

7

60

Nikon AF-S DX 18-300mm f/3.5-6.3G ED VR

£670/$700

DX

16.7x

Yes

Ultrasonic

f/3.5-6.3

550g

0.48m

0.32x

67mm

7

60

Nikon AF-S DX 18-300mm f/3.5-5.6G ED VR

£850/$1000

DX

16.7x

Yes

Ultrasonic

f/3.5-5.6

830g

0.45m

0.31x

77mm

9

39

Nikon AF-S 28-300mm f/3.5-5.6G ED VR

£830/$950

FX

10.7x

Yes

Ultrasonic

f/3.5-5.6

800g

0.5m

0.32x

77mm

9

21

Sigma 18-200mm f/3.5-6.3 DC Macro OS HSM | C

£250/$400

DX

11.1x

Yes

Ultrasonic

f/3.5-6.3

430g

0.39m

0.33x

62mm

7

60

Sigma 18-250mm f/3.5-6.3 DC Macro OS HSM

£280/$350

DX

13.9x

Yes

Ultrasonic

f/3.5-6.3

470g

0.35m

0.34x

62mm

7

39

Sigma 18-300mm f/3.5-6.3 DC Macro OS HSM | C

£350/$500

DX

16.7x

Yes

Ultrasonic

f/3.5-6.3

585g

0.39m

0.33x

72mm

7

60

Tamron 16-300mm f/3.5-6.3 Di II VC PZD Macro

£390/$500

DX

18.8x

Yes

Ultrasonic

f/3.5-6.3

540g

0.39m

0.34x

67mm

7

60

Tamron AF 18-200mm f/3.5-6.3 Di II VC

£200/$200

DX

11.1x

Yes

Electric

f/3.5-6.3

400g

0.49m

0.25x

62mm

7

Tamron AF 18-270mm f/3.5-6.3 Di II VC PZD

£300/$450

DX

15.0x

Yes

Ultrasonic

f/3.5-6.3

450g

0.49m

0.26x

62mm

7

39

Tamron 28-300mm f/3.5-6.3 Di VC PZD

£600/$850

FX

10.7x

Yes

Ultrasonic

f/3.5-6.3

540g

0.49m

0.29x

67mm

7

16

Irix 15mm f/2.4 Blackstone

£600/$600

FX

None

No

None

f/2.4

653g

0.28m

0.1x

95mm

9

70

Nikon AF DX 10.5mm f/2.8G ED Diagonal Fisheye

£585/$775

DX

None

No

Body-driven

f/2.8

305g

0.14m

0.2x

None

7

12

Nikon AF 14mm f/2.8D ED

£1390/$1890

FX

None

No

Body-driven

f/2.8

670g

0.2m

0.15x

None

7

Nikon AF 16mm f/2.8D Diagonal Fisheye

£665/$1000

FX

None

No

Body-driven

f/2.8

290g

0.25m

0.1x

None

7

Nikon PC 19mm f/4E ED (tilt & shift)

£3300/$3400 FX

None

No

None

f/4

885g

0.25m

0.18x

None

9

Nikon AF 20mm f/2.8D

£500/$625

FX

None

No

Body-driven

f/2.8

270g

0.25m

0.12x

62mm

7

Nikon AF-S 20mm f/1.8G ED

£650/$800

FX

None

No

Ultrasonic

f/1.8

355g

0.2m

0.23x

77mm

7

Nikon AF 24mm f/2.8D

£370/$395

FX

None

No

None

f/2.8

270g

0.3m

0.11x

52mm

7

Nikon AF-S 24mm f/1.8G ED

£630/$750

FX

None

No

Ultrasonic

f/1.8

355g

0.23m

0.2x

72mm

Nikon AF-S 24mm f/1.4G ED

£1790/$2000

FX

None

No

Ultrasonic

f/1.4

620g

0.25m

0.18x

77mm

Nikon PC-E 24mm f/3.5D ED (tilt & shift)

£1570/$2200

FX

None

No

None

f/3.5

730g

0.21m

0.37x

Nikon AF 28mm f/2.8D

£245/$290

FX

None

No

Body-driven

f/2.8

205g

0.25m

0.18x

Nikon AF-S 28mm f/1.8G

£495/$700

FX

None

No

Ultrasonic

f/1.8

330g

0.25m

Nikon AF 35mm f/2D

£350/$390

FX

None

No

None

f/2

205g

0.25m

Nikon AF-S 35mm f/1.8G ED

£440/$530

FX

None

No

Ultrasonic

f/1.8

305g

Nikon AF-S 35mm f/1.4G

£1580/$1700

FX

None

No

Ultrasonic

f/1.4

600g

Samyang 8mm f/3.5 IF MC CSII Dh Circular Fisheye

£260/$250

FX

None

No

None

f/3.5

Samyang 10mm f/2.8 ED AS NCS CS

£380/$420

DX

None

No

None

Samyang 12mm f/2.8 ED AS NCS Diagonal Fisheye

£380/$420

FX

None

No

None

Samyang 14mm f/2.8 IF ED UMC

£330/$370

FX

None

No

Samyang 20mm f/1.8 ED AS UMC

£460/$570

FX

None

Samyang 24mm f/1.4 ED AS UMC

£500/$600

FX

Samyang T-S 24mm f/3.5 ED AS UMC (tilt & shift)

£685/$800

FX

Samyang 35mm f/1.4 AS UMC AE

£420/$440

Sigma 4.5mm f/2.8 EX DC HSM Circular Fisheye
Sigma 8mm f/3.5 EX DG Circular Fisheye
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FX

£150/$200
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£100/$140

Sigma APO 70-300mm f/4-5.6 DG Macro
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7

70

9

59

77mm

9

25
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72mm

7

0.22x

67mm

7

25

●●●●

0.24x

52mm

7

0.25m

0.24x

58mm

7

0.3m

0.2x

67mm

9

25

435g

0.3m

N/S

None

6

12

●●●●
●●●●

f/2.8

600g

0.25m

N/S

None

6

f/2.8

530g

0.2m

N/S

None

7

None

f/2.8

560g

0.28m

N/S

None

6

70

No

None

f/1.8

488g

0.2m

N/S

None

7

70

None

No

None

f/1.4

680g

0.25m

N/S

77mm

8

None

No

None

f/3.5

680g

0.2m

N/S

82mm

8

25

FX

None

No

None

f/1.4

660g

0.3m

0.2x

77mm

8

40

£600/$900

DX

None

No

Ultrasonic

f/2.8

470g

0.14m

0.17x

None

6

12

£600/$900

FX

None

No

Electric

f/3.5

400g

0.14m

0.22x

None

6

12

Sigma 10mm f/2.8 EX DC HSM Diagonal Fisheye

£500/$520

DX

None

No

Ultrasonic

f/2.8

475g

0.14m

0.11x

None

7

12

Sigma 15mm f/2.8 EX DG Diagonal Fisheye

£500/$610

FX

None

No

Electric

f/2.8

370g

0.15m

0.26x

None

7

12

Sigma 20mm f/1.4 DG HSM | A

£630/$900

FX

None

No

Ultrasonic

f/1.4

950g

0.28m

0.14x

77mm

9

70

Sigma 24mm f/1.4 DG HSM | A

£600/$900

FX

None

No

Ultrasonic

f/1.4

665g

0.25m

0.19x

77mm

9

70

Sigma 35mm f/1.4 DG HSM | A

£600/$900

FX

None

No

Ultrasonic

f/1.4

665g

0.3m

0.19x

67mm

9

40

Tamron SP 35mm f/1.8 VC USD

£600/$600

FX

None

Yes

Ultrasonic

f/1.8

480g

0.2m

0.4x

67mm

9

Zeiss Milvus 15mm f/2.8 ZF.2

£2330/$2700

FX

None

No

None

f/2.8

880g

0.25m

0.11x

95mm

9

Zeiss Distagon T* 18mm f/3.5 ZF.2

£1090/$1400

FX

None

No

None

f/3.5

470g

0.3m

0.08x

82mm

9

Zeiss Milvus 18mm f/2.8 ZF.2

£2000/$2300 FX

None

No

None

f/2.8

675g

0.25m

0.1x

77mm

9
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f/2.8

735g

0.22m

0.2x

82mm

9

None

f/2.8

600g

0.22m

0.2x

82mm

9

Zeiss Distagon T* 25mm f/2 ZF.2

£1270/$1700

FX

None

No

None

f/2

570g

0.25m

0.17x

67mm

9

Zeiss Distagon T* 28mm f/2 ZF.2

£980/$1285

FX

None

No

None

f/2

500g

0.24m

0.21x

58mm

9

Zeiss Otus 28mm f/1.4 ZF.2

£3630/$5000 FX

None

No

None

f/1.4

1350g

0.3m

0.2x

95mm

9

Zeiss Milvus 35mm f/2 ZF.2

£830/$1120

FX

None

No

None

f/2

650g

0.3m

0.19x

58mm

9

£160/$200
£1460/$2050
£110/$135
£190/$220
£250/$280
£260/$300
£385/$450
£1350/$1600
£310/$390
£300/$500
£570/$950
£600/$600
£950/$1200
£2700/$3990

DX
FX
FX
FX
FX
FX
FX
FX
FX
DX
FX
FX
FX
FX

None
None
None
None
None
None
None
None
None
None
None
None
None
None

No
No
No
No
No
No
No
No
No
No
No
Yes
No
No

Ultrasonic
None
Body-driven
Ultrasonic
Ultrasonic
Body-driven
Ultrasonic
Ultrasonic
None
Ultrasonic
Ultrasonic
Ultrasonic
None
None

f/1.8
f/2.8
f/1.8
f/1.8
f/1.8
f/1.4
f/1.4
f/1.4
f/1.4
f/1.4
f/1.4
f/1.8
f/1.4
f/1.4

200g
740g
155g
185g
190g
230g
280g
385g
575g
435g
815g
540g
875g
970g

0.3m
0.25m
0.45m
0.45m
0.45m
0.45m
0.45m
0.58m
0.45m
0.3m
0.4m
0.29m
0.45m
0.5m

0.16x
0.5x
0.15x
0.15x
0.15x
0.15x
0.15x
0.13x
N/S
0.15x
0.18x
0.29x
0.15x
0.15x

52mm
77mm
52mm
58mm
58mm
52mm
58mm
72mm
77mm
62mm
77mm
67mm
67mm
77mm

7
9
7
7
7
7
9
9
8
9
9
9
9
9
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7
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●●●
●●●●
●●●●
●●●●

69
40

●●●●
●●●●

Nikon AF-S 85mm f/1.8G

£400/$480

FX

None

No

Ultrasonic

f/1.8

350g

0.8m

0.12x

67mm

7

69

Nikon AF-S 85mm f/1.4G

£1350/$1600

FX

None

No

Ultrasonic

f/1.4

595g

0.85m

0.12x

77mm

9

69

Nikon PC-E Micro 85mm f/2.8D (tilt & shift)

£1350/$1980

FX

None

No

None

f/2.8

635g

0.39m

0.5x

77mm

9

25

Nikon AF-S 105mm f/1.4E ED

£2050/$2200 FX

None

No

Ultrasonic

f/1.4

985g

1m

0.13x

82mm

9

Nikon AF DC 105mm f/2D (defocus control)

£900/$1200

FX

None

No

Body-driven

f/2

640g

0.9m

0.13x

72mm

9

Nikon AF DC 135mm f/2D (defocus control)

£1100/$1390

FX

None

No

Body-driven

f/2

815g

1.1m

0.14x

72mm

9

14

Nikon AF-S 200mm f/2G ED VR II

£4970/$5700

FX

None

Yes

Ultrasonic

f/2

2930g

1.9m

0.12x

52mm drop-in 9

29

Nikon AF-S 300mm f/4D IF-ED

£1100/$950

FX

None

No

Ultrasonic

f/4

1440g

1.45m

0.27x

77mm

Nikon AF-S 300mm f/4E PF ED VR

£1490/$2000

FX

None

Yes

Ultrasonic

f/4

755g

1.4m

0.24x

77mm

9

63

Nikon AF-S 300mm f/2.8G ED VR II

£4250/$5500

FX

None

Yes

Ultrasonic

f/2.8

2900g

2.3m

0.16x

52mmdrop-in

9

14

Nikon AF-S 400mm f/2.8E FL ED VR

£10400/$11200

FX

None

Yes

Ultrasonic

f/2.8

3800g

2.6m

0.14x

40.5mmdrop-in 9

Nikon AF-S 500mm f/4E FL ED VR

£8450/$10300 FX

None

Yes

Ultrasonic

f/4

3090g

3.6m

0.15x

40.5mmdrop-in 9

50

Nikon AF-S 600mm f/4E FL ED VR

£9730/$12300 FX

None

Yes

Ultrasonic

f/4

3810g

4.4m

0.14x

40.5mmdrop-in 9

50

Nikon AF-S 800mm f/5.6E FL ED VR

£15000/$16300 FX

None

Yes

Ultrasonic

f/5.6

4590g

5.9m

0.15x

52mmdrop-in 9

Samyang 85mm f/1.4 IF MC

£290/$330

FX

None

No

None

f/1.4

539g

1.0m

0.11x

72mm

8

Samyang 135mm f/2 ED UMC

£390/$550

FX

None

No

None

f/2

830g

0.8m

N/S

77mm

9

Sigma 85mm f/1.4 EX DG HSM

£620/$800

FX

None

No

Ultrasonic

f/1.4

725g

0.85m

0.12x

77mm

Sigma 85mm f/1.4 DG HSM | A

£1200/$1200

FX

None

No

Ultrasonic

f/1.4

TBA

0.85m

0.12x

86mm

Sigma APO 300mm f/2.8 EX DG HSM

£2200/$3400 FX

None

No

Ultrasonic

f/2.8

2400g

2.5m

0.13x

46mmdrop-in 9

Sigma APO 500mm f/4.5 EX DG HSM

£3600/$5000 FX

None

No

Ultrasonic

f/4.5

3150g

4.0m

0.13x

46mmdrop-in 9

Sigma 500mm f/4 DG OS HSM | S

£6000/$6000 FX

None

Yes

Ultrasonic

f/4

TBA

3.5m

0.15x

46mmdrop-in 9

Sigma APO 800mm f/5.6 EX DG HSM

£4300/$6600 FX

None

No

Ultrasonic

f/5.6

4900g

7.0m

0.11x

46mmdrop-in 9

Tamron SP 85mm f/1.8 VC USD

£750/$750

FX

None

Yes

Ultrasonic

f/1.8

700g

0.8m

0.14x

67mm

9

Zeiss Planar T* 85mm f/1.4 ZF.2

£990/$1285

FX

None

No

None

f/1.4

570g

1.0m

0.1x

72mm

9

Zeiss Milvus 85mm f/1.4 ZF.2

£1380/$1800

FX

None

No

None

f/1.4

1210g

0.8m

0.13x

77mm

9

Zeiss Otus 85mm f/1.4 ZF.2

£3250/$4390

FX

None

No

None

f/1.4

1140g

0.8m

0.13x

86mm

9

Zeiss Milvus 135mm f/2 ZF.2

£1550/$2200

FX

None

No

None

f/2

1060g

0.8m

0.28x

77mm

9

Zeiss Apo Sonnar T* 135mm f/2 ZF.2

£1600/$2125

FX

None

No

None

f/2

920g

0.8m

0.25x

77mm

9

Nikon AF-S DX 40mm f/2.8G Micro

£240/$280

DX

None

No

Ultrasonic

f/2.8

235g

0.16m

1.0x

52mm

7

Nikon AF 60mm f/2.8D Micro

£400/$520

FX

None

No

Body-driven

f/2.8

440g

0.22m

1.0x

62mm

7

Nikon AF-S 60mm f/2.8G ED Micro

£500/$600

FX

None

No

Ultrasonic

f/2.8

425g

0.19m

1.0x

62mm

Nikon AF-S DX 85mm f/3.5G ED VR Micro

£440/$530

DX

None

Yes

Ultrasonic

f/3.5

355g

0.29m

1.0x

52mm

Nikon AF-S 105mm f/2.8G IF-ED VR Micro

£750/$900

FX

None

Yes

Ultrasonic

f/2.8

750g

0.31m

1.0x

Nikon AF 200mm f/4D IF-ED Micro

£1250/$1790

FX

None

No

Body-driven

f/4

1190g

0.5m

1.0x

Sigma 105mm f/2.8 EX DG OS HSM Macro

£320/$620

FX

None

Yes

Ultrasonic

f/2.8

725g

0.31m

Sigma APO 150mm f/2.8 EX DG OS HSM Macro

£650/$1100

FX

None

Yes

Ultrasonic

f/2.8

1150g

0.38m

Sigma APO 180mm f/2.8 EX DG OS HSM Macro

£1100/$1700

FX

None

Yes

Ultrasonic

f/2.8

1640g

Tamron SP AF 60mm f/2 Di II LD (IF) Macro

£350/$525

DX

None

No

Electric

f/2

350g

Tamron SP AF 90mm f/2.8 Di Macro

£300/$500

FX

None

No

Electric

f/2.8

Tamron SP AF 90mm f/2.8 Di VC USD Macro

£580/$750

FX

None

Yes

Ultrasonic

Tamron SP AF 180mm f/3.5 Di Macro

£730/$740

FX

None

No

Tokina AT-X AF 100mm f/2.8 PRO D Macro

£330/$380

FX

None

Zeiss Makro Planar T* 50mm f/2 ZF.2

£940/$1450

FX

None

Pr

staNdard primes
Nikon AF-S DX 35mm f/1.8G
Nikon PC-E Micro 45mm f/2.8D ED (tilt & shift)
Nikon AF 50mm f/1.8D

staNdard primes

Nikon AF-S 50mm f/1.8G
Nikon AF-S 50mm f/1.8 NIKKOR (retro)
Nikon AF 50mm f/1.4D
Nikon AF-S 50mm f/1.4G
Nikon AF-S 58mm f/1.4G
Samyang 50mm f/1.4 AS UMC
Sigma 30mm f/1.4 DC HSM | A
Sigma 50mm f/1.4 DG HSM | A
Tamron SP 45mm f/1.8 VC USD
Zeiss Milvus 50mm f/1.4 ZF.2
Zeiss Otus 55mm f/1.4
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£1300/$1850

Zeiss Distagon T* 21mm f/2.8 ZF.2
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64
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64

62mm

9

59
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62mm

9

1.0x

62mm

9

64

1.0x

72mm

9

20

0.47m

1.0x

86mm

9

14

0.23m

1.0x

55mm

7

34

405g

0.29m

1.0x

55mm

9

34

f/2.8

550g

0.3m

1.0x

58mm

9

64

Electric

f/3.5

985g

0.47m

1.0x

72mm

7

14

No

Body-driven

f/2.8

540g

0.3m

1.0x

55mm

9

64

No

None

f/2

500g

0.24m

0.5x

67mm

9
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The final word

Joe McNally
WWW.JOEMCNALLY.COM

Group shots needn’t be a nightmare –
the trick, says Joe, is to make them fun

T
Images: Joe McNally

here might some photogs
for whom photographing
groups is enjoyable, even
fun. I suspect they are in
the minority. A group shot
usually invokes nightmares
about lighting, composition, and making a
shot under a ridiculous time gun.

For my Creative Live class, above, I
followed my basic rule of groups: make it
fast, make it fun. I had a wonderful assist
right behind me: an enormous window of
frosted glass. Beautiful main light. But I was
worried about how long that light would
stay with me. It was late afternoon, and it
was, after all, Seattle, the city where clouds
strangle the sun on a routine basis.

See the small flashes in front of me,
bounced into white sheets on the ground?
At first, they were my only lights. Just a pair
of Speedlights, sparking the wash of soft
daylight piling through the gigantic window
behind me. I controlled these SB-5000 units
with a WRR-10 radio transceiver ten-pinned
into my D5. I sent them a signal to produce a
blip of light, a splash.
But the light was still a bit blah, and in the
process of getting blah-er, so I added a main
light, off to camera left. It took the form of
a five-foot Octa wrapped around a Profoto
B-1, and also three SB-5000 units, mounted
on a Lastolite tri-flash, and firing through
a 4-in-1 umbrella. The effect on the group
was pretty close in terms of feel, and both

the main sources were deadbang easy
to control. The Profoto light responded
to the air remote, while the Speedlights
I controlled with my WRR-10. In both
instances, I could adjust ratios accordingly,
seamlessly, without ever leaving my camera.
But the main element was not the light.
It was the fun of it. I tried my best to keep to
my mantra I mentioned above. Oddly, one of
the most important pieces of equipment that
helps the fun factor is a tripod. I was on a
heavy duty Gitzo here, so the camera was
stable and my lines straight. This enabled
me to be a bit of a gadabout, and just reach
and hit the shutter release during a laugh.
It’s helpful, for sure. I can make pictures
without my eye in the camera.

More WorDS oF NIKoN WISDoM FroM Joe NeXT ISSUe
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